


Thank you for purchasing the screen edit software ZM-71SE for Control Terminal ZM-300/42/43/52/72/

82 series. This manual leads you to understand the outline and the functions and to master it effectly, by

making each example of each chapter. Read this manual thoroughly to completely familiarize yourself

with the operation according to the examples.

Therefore, about the operation of ZM-71SE, see “ZM-71SE Instruction Manual (operation version)”.

About software version

This manual is describes the version 2.0.0.0 of ZM-71SE.

- In this manual, the module name of Control Terminal is expressed as follows.

Notes

Expression in this manual
(Series name)

ZM-42

ZM-43

ZM-52

ZM-82

ZM-70

ZM-41

ZM-30

ZM-62

ZM-72

ZM-350

ZM-360

ZM-370

ZM-380

Model name of LCD control terminal

ZM-352D

ZM-362S, ZM-362SA

ZM-371T, ZM-371TA, ZM-371S, ZM-371SA

ZM-372T, ZM-372TA, ZM-372S, ZM-372SA

ZM-381S, ZM-381SA

ZM-382S, ZM-382SA

ZM-42D, ZM-42L

ZM-43T, ZM-43D, ZM-43L
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ZM-62E
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ZM-72D/DC
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ZM-41D, ZM-41L

ZM-30E, ZM-30L, ZM-61E, ZM-61T, ZM-40D, ZM-40L

ZM-300

• This module is made in accordance with Japanese domestic specifications. Its
guarantee clauses are described in a separate guarantee card (packed together
with the module). When this module is used outside Japan, these guarantee
clauses are not applicable. In addition, the guarantee should be understood as a
guarantee of the delivered product as a single unit and every other damages or
losses due to damage or malfunction of the product will not be included in this
guarantee.

• Should you have any questions and inquiries, please feel free to contact our
dealers.

• The whole or partial photocopy of this booklet is prohibited.
• We are not held responsible for any damages created as the result of using this

software, nor damages claimed by the third party as the result of using this software.
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♦ About the composition of this Manual

This manual consists of the following chapters for your thorough understanding of the ZM-71SE 
editor.

Chapter 1 Basic Operation This chapter explains the basic operation 
procedure, structure and menu items of the editor.

Chapter 2 Screen Composition This chapter explains the structure of “screen,” its 
holding capacity, limitations and methods of placing 
parts on the screen.

Chapter 3 Drawing Tools This chapter explains the drawing commands and 
how to use these commands.

Chapter 4 Registration Item This chapter explains the editing procedure of 
registration items.

Chapter 5 Transfer This chapter explains the data transfer procedure 
from the editor.

Chapter 6 Print This chapter explains the printing procedure from 
the editor.

Chapter 7 Useful Techniques This chapter explains useful techniques in editor 
operation, such as [Tool] menu or file management 
function.

Chapter 8 Applications for ZM-71SE Editor This chapter explains applications attached to the 
editor, such as Simulator.

Chapter 9 Wizard This chapter explains screen creation using the 
wizard function.

Appendix 1 Fonts The setting and editing procedures of font available 
with the ZM series are explained.

Appendix 2 3D Parts The placement and editing procedure as well as 
notes for 3D parts are explained.

Appendix 3 Part Editing The part structure and editing procedure are 
explained.
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Chapter 1  Basic Operation

1

Starting and Q
uitting
Starting and Quitting

This section describes how to start and quit the ZM-71SE editor.  For the 
ZM-71SE installation procedure, see “Installation” attached to the ZM-71SE 
editor.

Starting

Start your computer and check that Windows runs correctly.

1. Click the [Start] button of Windows, and click [Programs], [Zm-71se] then 
[ZM-71S].

2. The ZM-71SE initial screen is displayed.

It  is possible to start from the ZM-71SE shortcut icon.
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Opening a File

Opening a New File
1. Click the [New] icon in the tool bar or select [New] from the [File] menu.

2. The [Edit Model] dialog is displayed.  Select the model name and click [OK].

3. The [Select PLC Type] dialog is displayed.  Select the PLC model and click 
[OK].

or

For the edit models, see “Chapter 1 System Setting” in the ZM-71SE Instruction Manual 
(Function).

For compatible PLC models,  see each ZM User’s Manual.
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4. When a PLC other than [Mitsubishi: A series link] is selected in step 3, the 
[Comm. Parameter] dialog is displayed.

Click [OK].  The [Screen [0] Edit] window is displayed.

For the sett ing items in the [Comm. Parameter] dialog, see “Chapter 1 System Sett ing” in 
the ZM-71SE Instruct ion Manual (Funct ion).

For more information on the menu items, see page 1-7.
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Opening an Existing File
1. Click the [Open] icon in the tool bar or select [Open] from the [File] menu.

2. The [Open a Screen Data File] dialog is displayed.  Select the desired 
screen data file and click the [Open] button.

3. The selected screen data file is opened.

or

For more information on the menu items, see page 1-7.
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Quitting

1. Click [Quit Application] in the [File] menu or the [Close] button.

2. The screen is closed.

If the file has not been saved after changes, the following dialog appears and 
asks whether or not to save the data.  Click either [Yes] or [No] to quit the 
editor.

or
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Basic Operation of the Editor

This section explains names and operations of bars and menus that are 
displayed when a screen data file is opened on the ZM-71SE editor.

Names of Components

The following bars are displayed when the screen edit window is opened.

Title Bar
The title bar contains the following information.

To minimize the indication on the title bar, click [Property] in the [File] menu and 
put a check mark ( ) to [  Shorten the Title Display] on the [Environment] tab 
window.  The title bar shows the minimum information as shown below.

Title bar
Menu bar

Icon bar
Tool bar

Status bar

Product name File name Model name
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Menu bar
Clicking each menu brings up a drop-down menu.  Operations and edit items 
available with the ZM-71SE editor are indicated.

Icon Bar
The icon bar contains the following icons.

Division Number

The current division number is indicated.  This number should be used for 
identifying the division when placing parts or items.

For more information on the menu items, see page 1-11.

New File
Open
Save
Transfer
Start Simulator
Print
Select
Detail/Prop. Change

Version 
information

Screen List
Next
Preview

Skip
Switch/Lamp Display
On-line Run

For more information on the division number, see “Chapter 2 Screens.”
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Tool Bar
The tool bar contains icons that are equivalent to some menu items in the menu 
bar.  There are three tool bars.

Parts Tool Bar

Edit Tool Bar

Each icon has the function shown below.  For more information on use and setting items, 
see the relevant chapter in the ZM-71SE Instruction Manual (Function).

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35

1 Overlap 13 Bar Graph 25 Alarm Display
2 Switch 14 Pie Graph 26 Time Display
3 Lamp 15 Panel Meter 27 Calendar Display
4 Num. Data Display 16 Stat. Graph 28 Memo Pad
5 Char. Display 17 Trend Graph 29 Macro Mode
6 Message Display 18 Closed Area Graph 30 Interval Timer
7 Table Data Display 19 Graphic Mode 31 Memory Card Mode
8 Relay Mode 20 Graphic Relay Mode 32 Animation (ZM-300 series only)
9 Relay Sub Mode 21 Trend Sampling 33 Video (ZM-300 series only)

10 Message Mode 22 Data Sampling 34 JPEG Display (ZM-300 series only)
11 Entry Mode 23 Bit Sampling 35 Sound (ZM-300 series only)
12 Data Block Area 24 Relay Sampling

Each icon has the function shown below.  For more information, see “[Edit ] Menu” (page 
1-12).

Cut
Copy
Paste
Multi Copy
Move to Front
Move to Back
Group

Point Search
Redo
Undo
Change the Setting of a Part Placed
Flip
Rotate Graphic
Ungroup
1-8
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Draw Tool Bar

Moving and Transforming the Tool Bar

The tool bar can be moved to a desired position or be altered to a different 
shape.  To move the tool bar, click any position (except icons) on a bar and drag.  
Release the mouse button in the desired position.  The tool bar is moved to the 
position.

To alter the shape, move the tool bar out on the screen and drag the tool bar 
edge.

Each icon has the function shown below.  For more information, see “Chapter 3 Drawing 
Tools.”

Line
Box
Circle
Text
Pattern
Paint
Graphic Call

Screen Library
Mult i-Text
Trend Graph Scale
Pie Graph Scale
Bar Graph Scale
Dot

Drag.
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Hiding the Tool Bar

Tool bars are shown as default.  To hide the tool bar, uncheck the tool bar name 
in the [Tool Bar] sub-menu of the [Display] menu.  To show again, check the tool 
bar name.

Status Bar
The status bar contains the following information.

Hiding the Status Bar

The status bar is shown as default.  To hide the status bar, uncheck [Status Bar] 
in the [Tool Bar] sub-menu of the [Display] menu.  To show again, check the tool 
bar name.

Mouse coordinates Zoom
Memory use per screen

Editing layer
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Menu Bar

[File] Menu
[New]

Opens a new file, and brings up the screen for editing.

[Open]
Opens an existing file for screen editing.  A screen data file for the ZM-30/61 
series can be opened and converted into a file for the ZM-300/ZM-42 to 82 
series.

[Save]
Saves the current file.  (If it is a new file, you must give a name to the file.)

[Save As]
Saves the current file under a new or different name.

[Property]
Allows you to check the information on the current file.  For more information 
on the menu items, see page 1-42.

[Transfer]
Transfers data between the computer ↔ ZM or a memory card.
For more information, see “Chapter 5 Transfer.”

[Send AT Command]
Used for transferring a screen data file using a modem.  For more 
information, see “Chapter 5 Transfer.”

[On-line Editing]
Used for on-line editing.

[On-line Run]
This command becomes active in on-line editing.  When it is clicked, only the 
screen data that has not been transferred yet is transferred to ZM.

[Printer Setting]
Used for printing a screen.  Editing of margins, headers or footers, etc. is 
available.  For more information, see “Chapter 6 Print.”

[Print]
Prints out the created screen data file from the computer.  For more 
information, see “Chapter 6 Print.”

[Present Window Printing]
Prints out the window currently opened.  Set necessary data by clicking 
[Printer Setting] in advance.

[CF Card Manager]
Becomes active for the ZM series (ZM-300 series and ZM-52HD (handy 
type)) that is compatible with CF cards.  For more information, see “Chapter 
23 CF Card” in the ZM-71SE Instruction Manual (Function).
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[Start Simulator]
Starts the ZM-71SE simulation software “Simulator.”  For more information, 
see “Chapter 8 Applications for ZM-71SE Editor.”

[File Managing]
Used for copying screens, graphics, etc. between different screen data files.  
For more information, see “Chapter 7 Useful Techniques.”

[Parts Edit]
Used for setting, modifying, or registering parts.  For more information, see 
“Appendix 3 Part Editing.”

[Edit] Menu
[Undo]

Cancels actions that you performed.  (Up to 7 times)

[Redo]
Becomes active when [Undo] is performed.  Reverts the state before 
undoing.  (Up to 7 times)

[Undo Wizard]
Cancels wizard operation that you performed.

[Cut]
Cuts the selected item and moves it to the clipboard.

[Copy]
Copies the selected item to the clipboard.

[Paste]
Pastes the item in the clipboard to the screen.

[Copy to Selected Screen]
Pastes the copied item to multiple screens.  For more information, see page 
1-37.

[Undo Paste to Selected Screen]
Cancels the [Copy to Selected Screen] operation that you performed.

[Delete]
Deletes the selected item.  Select a part or a graphic (or parts or graphics) to 
be deleted, and click this menu.

[Multi Copy]
Pastes the selected item multiple times.  For more information, see page 
1-35.

[Move to Front]
Moves the selected item to the front.  When two or more parts or graphics 
are overlapping, select the item that you would like to move to the front, and 
click this menu.

[Move to Back]
Moves a part or graphic to the back when two or more parts or graphics are 
overlapping.
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[Group]
Groups the selected items.  Select multiple items at the same time, and click 
this menu.

[Ungroup]
Ungroups the selected group.  Select the grouped item, and click this menu.

[Rotate Graphic]
For more information, see “Rotate Graphic” (page 1-38).

[Flip]
For more information, see “Flip” (page 1-39).

[Align]
For more information, see “Align” (page 1-39).

[Table Data Display Editing]
Brings up the menu for table data display editing while a cell/cells in a table 
data display part is/are selected.  For more information, see “Chapter 2 
Screens.”

[Modify Part]
Brings up the [Modify Part] window.  Select a part placed on the screen, and 
click this menu.  Modify the part as desired.  For more information, see 
“Appendix 3 Part Editing.”

[Detail Setting]
Used for property modification.  Select an item placed on the screen, and 
click this menu.  The [Prop. Change] dialog is displayed.

[Select Environment]
For more information, see “Select Environment” (page 1-41).

[Division No. Setting]
Changes the division number indicated in the upper right corner.

[Screen Setting]
Used for specifying the screen background color, etc.  For more information, 
see “Chapter 2 Screens.”

[Edit OPEN Macro] [Edit CLOSE Macro] [Edit CYCLE Macro]
Used for setting the macro for the currently open screen.  For more 
information, see “Chapter 2 Screens.”

[Local Function Switch Setting]
Used for setting function switches for each screen.  For more information, 
see “Chapter 1 System Setting” in the ZM-71SE Instruction Manual 
(Function).

[Select All]
Selects all items placed on the screen.

[Delete All]
Deletes all items from the screen.  Clicking this 
menu brings up the dialog shown on the right.  
When [Yes] is clicked, all the items are deleted from 
the screen.
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[Display] Menu
[Tool Bar]

Shows or hide the tool bars.  Clicking this menu brings up the [Tool Bar] 
dialog.  When the box is unchecked, the corresponding tool bar disappears 
from the screen.  Check the box to show the tool bar.

[Status Bar]
This menu is checked as default.  The status bar is shown at the bottom of 
the editor screen.  Uncheck the menu when the status bar is not necessary.

[Jump]
Used for screen calling.

[Preview]
Brings up the previous screen.

[Next]
Moves to the next screen.

[Skip]
Skips screens that are not registered when scrolling screens.

[Screen List]
Brings up currently editing screens or graphics in the graphic library in a list 
form.  For more information, see page 1-23.

[Item List]
Brings up the switches, lamps and graphic items placed on the screen in a 
list form.  For more information, see page 1-27.

[Switch/Lamp Display]
Allows you to choose the status of a switch or lamp on the screen.  The 
[OFF]/[ON]/[P3] to [P8] options can be selected when this menu is clicked.  
Clicking each option changes the switch/lamp display.

[Grid Display]
Shows grids when this menu is checked.  Unchecking this menu clears grids 
from the screen.

[ON Grid]
Selects the “on-grid” screen environment when this menu is checked.  
Unchecking this menu cancels the “on-grid” screen environment.

[Grid Offset Position]
Becomes valid when [Free] is chosen for [Grid Type] in the [Grid] tab 
window.  Click this menu and then click the desired position on the screen.  
The grid offset position is determined.

[Zoom]
Brings up the sub-menu containing [400%], [200%], [100%] and [75%].  
Choose the desired option to change the zoom.

[Display Environment]
For more information, see “Chapter 2 Screens.”
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[Change All Display Environment] 
Changes the display environment for screens at one time.  The set 
environment becomes valid for all the screens.

[Redraw]
Refreshes the screen display.

[Draw] Menu
For more information, see “Chapter 3 Drawing Tools.”

[Part] Menu
For more information on the menu items, see respective chapters.

[Item] Menu
For more information on editing of each item, see “Chapter 4 Registration 
Items.”

[Screen]
Allows you to perform screen editing.

[Graphic Library]
Allows you to perform graphic library editing.

[Multi-Overlap]
Allows you to perform multi-overlap editing.

[Data Block]
Allows you to perform data block editing.

[Message]
Allows you to perform message editing.

[Pattern]
Allows you to perform pattern editing.

[Macro Block]
Allows you to perform macro block editing.

[Page Block]
Allows you to perform page block editing.

[Direct Block]
Allows you to perform direct block editing.

[Screen Block]
Allows you to perform screen block editing.

[Tile]
Allows you to perform tile editing.

[Data Sheet]
Allows you to perform data sheet editing.
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[Screen Library]
Allows you to perform screen library editing.

[Multi-Languages]
Used for the language selection function.

[Animation]
Used for the animation function.

[System Setting] Menu
The menu contains commands required for system setting.  For more 
information, see “Chapter 1 System Setting” in the ZM-71SE Instruction Manual 
(Function).

[Tool] Menu
This menu contains useful commands for screen creation.  For more 
information, see “Chapter 7 Useful Techniques.”

[Window] Menu
[Cascade]

Aligns and overlaps multiple windows.

[Tile]
Aligns multiple windows like tiles.

[Arrange Icons]
Aligns the minimized windows.

Window titles
When multiple windows are opened, their titles are indicated in the [Window] 
menu.  Clicking the title of a window brings it to the top.

[Help] Menu
[Topic Search]

Brings up the [Help] window.  The usage of the [Help] menu is the same as 
that in Windows.

[Version Information]
Indicates the editor version information.
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Dialog

Setting and Operating Technique in Dialogs

1. Change-over tab
Click on a tab with the mouse.  The corresponding tab window of the dialog 
is displayed.

2. Numerical data field
When setting or modifying numerical data, click the upward/downward arrow 
buttons.  Some data fields allow direct numeral entry through the keyboard.

3. Option button
Select one option by clicking.  When the button changes to , the option is 
selected.

4. Arrow to show the drop-down list
Clicking this arrow shows the drop-down list.  Select the desired option.

5. Check box
Click on the check box for the desired option.  The check box changes from 

 to  (checked).  When a box is checked, it means that it is selected or 
“yes.”

6. Command button
Command buttons include [OK], [Yes], [No], [Cancel], etc.  Clicking a button 
triggers the specified action.

7. Text field
When the cursor is shown in a text field, characters can be entered.

The dialog can be moved by pointing to the title section and dragging.

1
2

3

4

5

6

7
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Setting up Memory Addresses
When specifying a memory address in a dialog, click the calculator button on the 
right of the entry field.  The [Memory Input] dialog is displayed.  The contents in 
the dialog vary depending on the PLC model and the selected type.  Common 
setting items are explained.

1. When [PLC Memory] is selected:
Select this option when using the PLC memory.

A Device selection field
This field becomes active when [PLC Memory], [Internal Mem.], [I/O 
Memory], [Temp. Mem.], [PLC2 Memory] or [Common Memory].  Clicking 
this box brings up the drop-down list.  Select the desired device by 
clicking.

B Entry field
Specify a memory address.  Use the keypad in the dialog or the keyboard 
of the computer.

C Keypad
The keypad allows direct entry to the above field in the allowable range 
for each memory type.

A

B

C
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[Station No.]
This option becomes active when [1 : n] is chosen for [Connection] in the 
[Detail] tab window of the [Comm. Parameter] dialog.  For Ethernet 
communications, set the network table number here.

[CPU No.]
This field becomes active when [YOKOGAWA: FA-M3], etc. is selected.

[CPU No.]
This field becomes active when [Mitsubishi: Net10] or [OMRON: 
SYSMAC CS1 DNA], etc. is selected.  It is possible to see the data on the 
network table.
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2. When [Internal Mem.] is selected:
Select this option when using the internal memory of LCD control terminal.  
For more information, see “Appendix 1 Internal Memory” in the ZM-71SE 
Instruction Manual (Function).

[  Indirect]
This option is available with memory setting when macro commands are 
used.  For more information, see “Chapter 13 Macro” in the ZM-71SE 
Instruction Manual (Function).

3. When [Memory Card] is selected:
Select this option when using the memory card as the memory.  For more 
information, see “Chapter 25 Memory Card Mode” in the ZM-71SE 
Instruction Manual (Function).

[File No.]/[Record No.]
Set these numbers when [Memory Card] is selected.  For more 
information on the memory card, see “Chapter 25 Memory Card Mode” in 
the ZM-71SE Instruction Manual (Function).
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4. When [Constant] is selected:
Select this option when specifying a constant instead of a memory address.  
Depending on the item, this option may not be selected.

[DEC−/DEC/OCT/HEX/FLOAT]
These options become active when [Constant] is chosen.

DEC− =  decimal, with sign
DEC =  decimal, without sign
OCT =  octal
HEX =  hexadecimal
FLOAT =  floating point (when real numbers are used)

5. [I/O Memory]
Select this option when using I/O communications, such as Ethernet.  For 
more information, see the ZM-80NU/80NU2 User’s Manual.

6. [Temp. Mem.]/[PLC2 Memory]
Select this option when using the temperature control network or PLC2Way 
function.  For more information, see each ZM User's Manual.

• [Refer] button
When comments for memory addresses are listed in a file, it is possible 
to set the memory address while referring to the contents of the file.  The 
list file must have the file extension “∗.lst.”  When setting the temperature 
control network or PLC2Way function, the list file is automatically read.
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Edit Window

When the editor is started and a file is opened, the [Screen Edit] window is 
displayed.  This section explains operations on the edit window.

Window Structure
The [Screen Edit] window is taken as an example for explanation.

Calling up the Window
[Preview]/[Next] Icons

Clicking the [Preview] or [Next] icon in the icon bar brings up the previous or next 
window.

[Jump] in the [Display] Menu

Click the [Display] menu and select [Jump].  The dialog for specifying a screen 
number is displayed.  Enter the desired screen number and press [OK].  The 
[Screen Edit] window of the specified screen number is displayed.
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Double-clicking on the [Screen List] Window

Click the [Screen List] icon in the icon bar.  (Or, click [Screen List] from the 
[Display] menu.)  The [Screen List] window is displayed.

Bring up the screen to be displayed on the list, and double-click on the screen.  
The [Screen Edit] window of the selected screen is displayed.

or

Note that the previous [Screen Edit] window and the [Screen List] window 
remain open.  To check the edit windows currently opened on the editor, click the 
[Window] menu.  Clicking the edit window name moves the window to the front.
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Dragging on the [Screen List] Window

Align the previous [Screen Edit] window and the [Screen List] window in tiles or 
cascades.

Select the screen to be called on the [Screen List] window, and drag the screen 
to the previous [Screen Edit] window.  Releasing the mouse brings up the 
[Screen Edit] window of the dragged screen.

Drag.
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Calling from the [Item] Menu

Screens can be called from the [Item] menu.  Select [Screen] from the [Item] 
menu.  The [Screen] dialog is displayed.  Specify the desired number and click 
[OK].  The [Screen Edit] window of the specified screen number is displayed.

Operations on the [Screen List] Window
Screens can be moved, copied or deleted easily on the [Screen List] window.  
Clicking the desired screen on the [Screen List] window highlights the screen 
number.

Note that the previous [Screen Edit] window remains open.  To check the edit 
windows currently opened on the editor, click the [Window] menu.  Clicking the 
edit window name moves the window to the front.

The multiple [Screen Edit]  windows or [Multi-overlap Edit] windows can be displayed on 
the editor.
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Right-clicking brings up the drop-down menu including [Copy], [Paste], [Delete], 
etc.  Selecting a command performs the selection action.

To select multiple screens, click the top screen, hold down the [SHIFT] key and 
click the last screen.  The selected screen numbers are highlighted.

Click.

Hold down the [Shift]  key and click.
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It is possible to copy the desired screen by dragging it to an empty screen 
position.

When the desired screen is not included on the [Screen List] window, show the 
vertical scroll bar, or click [Jump] from the [Display] menu and specify the 
desired screen number.

Item List

Items on the edit window can be checked on the item list.

Calling up the Item List
Select [Item] list from the [Tool] menu.  The [Item List] window is displayed.

Drag.
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Utilizing the Item List
Tile the item list and the edit window.  When the desired item is clicked on the 
item list, handles are shown around the item indicating that the item is selected.

If an item cannot be found visually on the screen when you would like to change 
the setting, use this method.  This is useful in selecting a hard-to-find item.

Selected on the screen

Click here.

A maximum of 512 items can be displayed on one window.  When an item is selected, the 
total number of the items placed on the screen and the line number of the selected item 
are displayed on the status bar.

When the number exceeds 512, click [Next] in the [Display] menu or the right-click menu.  
The hidden items come into view.  The current page number is indicated on the title bar of 
the window.
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Changing the Display Format
1. Click the [Display] menu.  The menu as shown on the right is 

displayed.

2. The following display formats are available.

[By Registration]
The items are displayed in the order in which items are 
placed.

[By Division]
The items are displayed in ascending order of division numbers.

[By Graphic]
Only graphic items are displayed.

[By Function]
The following dialog is displayed.

Only the items of the selected function are displayed.

[By Selection]
The items selected by enclosing with the mouse are displayed.  Check 
the menu and keep the [Item List] window open.  Then, enclose the 
desired item(s) with the mouse for selection.  (The mouse cursor on the 
screen changes to a mark with “sel” as shown below.)  Click the [Item 
List] window to make the window active.  Only the selected items are 
displayed.
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Hint
[By Selection] can also be selected from the right-click menu.

 

3. Click the desired display format.

Closing the Item List
Click the extreme left icon in the menu bar, and click [Close].  It is also possible 
to close the window by clicking the [×] button at the top right corner of the 
window.

Useful Operations

Useful operations in placing or editing parts and graphics are explained.

Copy & Paste
Copy & paste operation can be performed by using [Copy] and [Paste] in the 
[Edit] menu or the [Copy] and [Paste] icons in the icon bar.  Also, the following 
operations can perform copy & paste operation.

1. Click the original item to be copied.

2. Hold down the [Ctrl] key on the keyboard and drag the item to the desired 
position.

3. The copied item is placed.

Hold down the [Ctrl] key and drag. The same effect as copy & paste operation
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Zooming In/Out
The edit window is displayed at 100% zoom as default.  The display size can be 
changed by selecting [Zoom] from the [Display] menu.  Hold down the [Ctrl] key 
on the keyboard and right-drag the mouse on the screen.  A red dotted-line box 
is displayed.  When the mouse is released, the area in the red dotted-line box is 
zoomed in.

Pressing the [Home] key on the keyboard resets the zoom to 100%.

Hold down the [Ctrl] key and right-drag.  
(A red dotted-line box is displayed.)

Releasing the mouse zooms 
in the enclosed area.  (The 
zoom % varies depending 
on the enclosed area size.)

In addition:
[Ctrl] key + [Page Up] → Zoom Out
[Ctrl] key + [Page Down] → Zoom In
The above shortcut keys can also be used for zooming.
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Right-clicking Menu
Right-clicking a mouse brings up a menu that contains some commands.  The 
commands included in the menu vary depending on the screen condition.

When No Items are Selected:

Right-clicking a mouse brings up the following menu.

1. [Undo]

2. [Redo]
Same as [Undo]/[Redo] in the [Edit] menu

3. [ON Grid]
When this command is clicked once, a check mark is added to the 
command.  The screen becomes the “on-grid” status.  Clicking the command 
again clears the check mark.  The “on-grid” status is canceled.

4. [Grid Display]
When this command is clicked once, it is checked.  Grids are displayed on 
the screen.  Clicking the command again clears the check mark and the 
grids.

5. [Grid Type]
Select the grid type from [1-Byte], [Switch], [Mode] and [Free].

6. [Hide overlaps with Base checked]
When this command is clicked once, it is checked.  When a normal overlap is 
placed on a screen, it can be hidden by changing the editing layer from 
[Overlap] to [Base].  When [Overlap] is checked again, the overlap is shown.  
Clicking the [Hide overlaps with Base checked] again clears the check mark 
and shows the overlap.

7. [On-line Editing]
This command is valid when LCD control terminal is connected to a personal 
computer using a screen data transfer cable.  When this command is clicked 
once, a check mark is added to the command and on-line editing becomes 
possible.  [On-line Run] becomes active.  Clicking the command again clears 
the check mark.  On-line editing is canceled.  For more information on 
on-line editing, see “Chapter 5 Transfer.”

1
2
9

10
11
12
3
4
5

6
13
7
8
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8. [On-line Run]
This command becomes valid in on-line editing.  When it is clicked, only the 
screen data that has not been transferred yet is transferred to ZM.

When an Item is Selected:

9. [Cut]
Same as [Cut] in the [Edit] menu

10. [Copy]
Same as [Copy] in the [Edit] menu When it is clicked, [Paste] becomes 
active.

11. [Paste]
Same as [Paste] in the [Edit] menu

12. [Delete]
Same as [Delete] in the [Edit] menu

13. [Change All]
This command is used to change division numbers or processing cycles of 
the parts placed on the screen at one time.  Select the desired part, and click 
this command.  The [Change All] dialog is displayed.

[Change All Division No.]
When this item is checked, the division number can be specified.  Specify 
the division number to be changed for the selected part.

[Change All Process Cycle]
When this item is checked, the processing cycle can be selected.  Select 
the desired processing cycle.  Clicking [OK] changes the processing 
cycle of the selected part at one time.
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When a Normal Overlap is Placed:

14. [Base] [Overlap 0] [Overlap 1] [Overlap 2] (for changing over the editing 
layer)
When clicked, it is checked and selected.  The selected one becomes the 
editing layer.

When a Table Data Display Part is Selected:

This menu appears when a cell/cells in a table data display part is/are selected 
by right-clicking or right-dragging.

15. [Align Width]
All cells are adjusted to the width of the top left cell in the selected cells.

16. [Align Height]
All cells are adjusted to the height of the top left cell in the selected cells.

17. [Align Character]
The cells in a table are adjusted so that the largest data item fits into a cell.

14

15
16
17
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Useful Editing Commands

This section explains useful editing commands included in the [Edit] menu of the 
menu bar or the tool bar.

Multi Copy
A part or a graphic (parts or graphics) can be copied multiple times at one time.

Select a part or a graphic (or parts or graphics), and click this menu.  The 
[Multiple Copy] dialog is displayed.

The following setting items are included.

[Dot]/[Line/Column]
Choose either option for placing copied parts on the screen, by dots or by 
lines/columns.  For more information on the line and column, see “Chapter 2 
Screens” (page 2-6).

[Direction]
When the check box of [Memory INC] or [Order INC] is turned on ( ), it 
determines the direction of placing copied parts.  When changing the 
direction, click [Change Direction].  The [Select Direction] dialog is displayed.  
Choose the desired direction and click [OK].  The selected direction 
becomes valid.

[Interval]/[Pitch]
Choose either option for placing copied parts on the screen, by pitch or at 
intervals.  For more information, see the next page.

[X Distance]/[Y Distance]
Specify distances along the X and Y directions for placing copied parts.  The 
unit for these values is [Dots] or [Line/Column] that is selected.
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[Quantity X]/[Quantity Y]
Specify the number of required copies.  The copy source must be included in 
this number.

Ex.:
When a solid box is multiple-copied:
[Interval] X Distance: 20 Y Distance: 10

Quantity X: 2 Quantity Y: 2
Copies are placed as shown below.

[Pitch] X Distance: 60 Y Distance: 20
Quantity X: 2 Quantity Y: 2

Copies are placed as shown below.

[Order INC]
This setting is effective when using a “data display” part as the copy source.  
To increment the selection order number of each copied part, check this 
option ( ).

• [Step]
Specify the increment when increasing the selection order number of each 
copied part.

[Display Order INC]
This setting is effective when using a switch/lamp (function: mode) part as 
the copy source.  To increment the display order number of each copied part, 
check this option ( ).

• [Step]
Specify the increment when increasing the display order number of each 
copied part.

Y: 10 dots

X: 20 dots

(Copy 
source)

Y: 20 dots

X: 60 dots

(Copy 
source)
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[Memory INC]
This setting is effective when using a switch/lamp or data part as the copy 
source.  Specify the top memory address for the copy source.  Memory 
addresses are allocated for the number of copies.  [Memory] and [Step] 
become active.

• [Memory]
Specify the top memory address of the copy source.

• [Step]
Specify the increment (in words or bits) when increasing the memory 
address consecutively.  When “1” is entered, the allocated addresses are 
incremented by one word or bit.  When “2” is entered, the allocated 
addresses are incremented by two words or bits.

Copy to the Selected Screen
The item selected on the edit window or on the [Item List] window can be pasted 
on multiple screens at one time.  Follow the steps described below.

1. Click or drag the desired item on the screen.  (Or, click the item on the [Item 
List] window.)

2. Select [Copy to Selected Screen] from the [Edit] menu.  The following dialog 
is displayed.

[  Not Paste to the Unregistered Screens]
When the selected item should not be pasted on unregistered screens, 
check this box.  To paste the selected item on unregistered screens, 
remove the check mark.

[Range Designation]
Set the range of screens where the selected items should be pasted.

3. Click [OK].  Paste operation is performed.  When paste operation on the last 
screen number specified for [Range Designation] has been completed, this 
last screen is opened.

If paste operation is performed on a layer (such as an overlap) where the 
number of items per screen is limited and the number reaches the limit, the error 
message “Do you cancel paste action to selected screen?” is displayed.

To cancel [Copy to Selected Screen] that you performed, click [Undo Paste to Selected 
Screen] in the [Edit ] menu.
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Rotate Graphic
The following graphic items can be rotated.
Applicable graphic items:

Line, continuous line, box, parallelogram, polygon, circle, arc, sector, ellipse, 
elliptical arc, paint (including frame), scale

Operation Procedure

Select the desired graphic item.  When handles are shown, click [Rotate 
Graphic] (or icon).  The following [Rotate] dialog is displayed.  At the top left 
corner of the graphic item, a [CENT] mark is indicated.

[Angle] (90°/180°/270°)
Select the desired angle for rotation.  The center of rotation is the position 
marked with [CENT].

[Rotate]
Clicking this button rotates the selected graphic item.

[Quit]
Clicking this button brings up the [Rotate] dialog.

[Center]
When the [Rotate] icon is clicked, the rotation center is automatically located 
at the top left corner.  When changing the rotation center, click the [Center] 
button.  The following mouse is displayed on the screen.  Click the mouse on 
the desired position.  The [CENT] mark moves to the clicked position.

Multiple graphic items can be selected and rotated at one time.

CENT

[CENT] mark

When rotating a graphic item, the message, “Item is out of working area.” is 
displayed if it cannot be held in the screen space after rotation.  In such a case, 
move the rotation center, or change the rotation angle.

CENT

CENT

Click this posit ion. The [CENT] mark 
moves.
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Flip
The following graphic items can be flipped on the specified axis.

Applicable graphic items:
Line, continuous line, box, parallelogram, polygon, circle, arc, sector, ellipse, 
elliptical arc, paint (including frame), scale

Operation Procedure

Select the desired graphic item.  When handles are shown, click [Flip] (or icon).  
The following [Flip] dialog is displayed.

[Direction] (Vertical/Horizontal)
Select the axis to flip the graphic item.

[Position] (Left/Right/Up/Down/Center)
Select the position to place the graphic item with respect to the selected 
[Direction].

[  Copy]
When the check box is turned on ( ), the graphic item is copied at the 
flipped position while the original one remains in place.  When this is not 
checked, the graphic item is flipped.

Clicking [OK] performs flip operation.

Align
Items can be aligned on the screen.  Clicking this menu brings up the following 
sub-menu.

Switch/Lamp Centering

This command is valid when there are characters on the switch or lamp.  Select 
the desired switch (lamp), and click this command.  The characters are 
center-aligned.
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Flush Right/Left/Top/Bottom

Select the desired items at the same time, and click the command.  The items 
are aligned as commanded.

Vertical Align

Select the desired items at the same time, and click this command.  The 
selected items are vertically aligned.

Horizontal Align

Select the desired items at the same time, and click this command.  The 
selected items are horizontally aligned.

Align Setting

Clicking this menu brings up the [Align Setting] dialog.

[Pitch] (Equal/Free)
This selection determines the pitch for alignment.  When [Free] is selected, 
specify the distance.

[Selected Area]
When this option is checked ( ), the items in the area enclosed by the 
mouse are all aligned.

For example, when characters are placed on a switch as graphics;  Check 
[Selected Area] and enclose the character graphics in an area (∗) smaller than 
the switch area.  A dotted box is displayed.

Click [Vertical Align] or [Horizontal Align] in the [Align] sub-menu.  The character 
graphics on the switch are center-aligned in the switch area.

Also, characters on the switch (or lamp) can be center-aligned by clicking the 
[Centering] button on the [Character] tab window of the [Switch] dialog.

This command is valid only when characters are entered in the [Switch (Lamp)] 
dialog.  If characters are placed as graphics, use [Align Setting] for centering.

ABCD
Enclose an area along the switch frame to select 
characters.   (* Do not select the switch.)

ABCD
Characters are vertically aligned to this area.  
([Horizontal Align] also works in the same manner.)

When the switch itself is enclosed together with characters, it is also aligned.  
When you want to align characters only, do not select the switch.
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Select Environment
This command is used for editing screens or multi-overlaps.  Items to be 
selected can be limited.  Clicking [Select Environment] brings up the following 
dialog.

[Select Option]
[All] is chosen as default.  Clicking the [Select] button brings up the [Select 
Option] dialog.  Choose a desired option.  It is displayed in the [Select 
Option] field in the [Select Environment] dialog.

[Only in the Current Division]
A division number can be specified for selecting parts.  When this option is 
checked, the selection is valid for parts having the same division number as 
the current division.

[Point Search] Icon
A graphic item can be snapped to a different graphic item with ease during 
drawing or screen editing.  This icon is useful in creating screens containing 
complicated graphics.

Ex.:
Connecting a continuous line to a straight line on a screen

1. Click the [Point Search] icon (depressed).

2. Click a part of the continuous line closest to the straight line, and drag.  
The handle closest to the straight line turns green.

3. While dragging the continuous line to the straight line, the green handle 
is snapped to the straight line automatically.

Drag around this point . The closest handle turns green.

Line Continuous line

Snapped automatically
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Clicking [Property] in the [File] menu brings up the following dialog.

[File Information] Tab Window
[PLC Type]

The PLC model set for the screen data file is displayed.

[File Name]
The screen data file name is displayed.

[File Comment]
The comment for the current screen data file can be entered.  A maximum of 
16 1-byte characters (eight 2-byte characters) can be entered.  The 
comment entered here is transferred to ZM as well when screen data is 
transferred.

[Change Password]
Use this button when setting a password for the screen data file or when 
changing the existing password.  A maximum of six alphanumeric characters 
can be set.  The password should be entered when opening the screen data 
file or downloading the transferred data on ZM.  A password ensures security 
against unauthorized access.

Manage the password on your own.  Note that Sharp Manufacturing Systems is 
not liable for any damages resulting from unknown password.
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[Memory Use] Tab Window
Some information that is displayed by selecting [Memory Use] from the [Tool] 
menu is displayed in this tab window.

[Environment] Tab Window

 Shorten the Title Display
Check this box when you prefer short window titles that are displayed on top 
of the editor.  For more information on the title indication, see page 1-6.

 Create Backup File
A backup file (with extension “∗.bak”) is always created when saving a 
screen data file.  If not necessary, remove the check mark.

 Auto-save
Check this box to save the screen data automatically.  When the box is 
checked, the time period for auto-saving can be set.  Set the desired time 
interval for auto-saving in minutes.  (Setting range: 10 to 60 minutes)  For a 
new file, a name should be given when the file is auto-saved for the first time.

Auto-save operation is not performed when the macro edit window (example: 
switch ON macro editing, screen OPEN macro editing, etc.) is open.  Please 
take note of this.
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Please use this page freely.
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Screen Composition

Each display of the LCD control terminal is called a screen.  A maximum of 
1,024 screens can be registered in a screen data file.  This chapter explains 
screen composition and elements containing parts and graphics to be displayed 
on screens.

Screen Outline

One screen is composed of a base screen with a maximum of three overlaps.  
Each of the base screen and the overlaps (layers) is composed of 256 divisions.  
These 256 divisions are overlaid on a layer like invisible sheets.

Screen

Base

A maximum of 1,024 screens can be registered.

Overlap

Divisions 0 -  255

Overlap

Overlap

Overlap
Divisions 0 -  255

Base
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Divisions will contain parts (page 2-17 for details).  These parts are given 
numbers identical to their respective division numbers.  Graphics will be directly 
placed on the base and overlaps.  These graphics are not given division 
numbers.

What Is a Division?
• A division is an invisible area.  It is assigned to every part that functions on 

the screen.  Whether one division can contain multiple parts or only one part 
depends on the types of parts.  (For more information on the limit on the 
number of parts, see page 2-18.)

• When placing parts on a division, the division number is shown on the icon 
bar.

Temperature
No. 0         °C
No. 1         °C
No. 2         °C

Trend Graph 123
123
123

Menu

Trend 2

Change

System

Error

123
123
123

Menu

Trend 2

Change

System

Error

Temperature
No. 0         °C
No. 1         °C
No. 2         °C

Trend Graph 1

Base

On a division area
Directly placed

on the base

Switches, numerical data displays, display areas, etc. Graphics  (texts, boxes, scales, etc.)
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• The ZM-71SE automatically performs division number allocation while 
judging the maximum permissible number of parts per division for each part 
to be placed.  You do not need to worry about allocation of division numbers 
generally.

A part that executes its function singly, such as a switch, lamp, numerical 
data display, or bar graph, has no limit on the number of parts per division 
(page 2-18).  It is not necessary to worry about division numbers for placing 
these types of parts.

Only one piece can be placed on one division, depending on the type of part as 
described below.

Combination of Parts

Different parts may be combined to execute one function.  Such parts must 
share the same division number.

• Error message display (relay mode)
• Numerical data input on the ZM (entry mode) 

If the parts are given different division numbers, they may not work correctly.  
Correct their division numbers.

Multiple switch parts can be 
placed on one division.

Temperature
No. 0          ßC
No. 1          ßC
No. 2          ßC

Trend Graph 1 123
123
123

Menu

Trend 2

Change

System

Error

Error

Trend1ChangeSystemMenu Trend2

Same division number

Allocate the same division number to 
the display area and the scroll switches.
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When Using Screen Library:

With the use of an editing area called screen library, the same part can be 
placed repeatedly on multiple screens.  Before using the function, check that the 
division number registered in a screen library is different from the division 
numbers of parts already placed on screens.  In the case of parts limited in 
number, using the same division number may prevent these parts from working 
normally.

For more information on screen library, see “Chapter 4 Registration Items.”

Division Number Check
To check the division number of a part placed on the screen, follow the steps 
below.  Select [Display Environment] from the [Display] menu.  In the [Detail] tab 
window, check [  DIV No.] for [Detail].

Or, select [Item List] from the [Display] menu to open the item list.  All division 
numbers used on the screen are listed.

For more information on [Display Environment] setting, see page 2-10.  For 
more information on the item list, see “Chapter 1 Basic Operation.”

Error

Trend1ChangeSystemMenu Trend2

SLIB
YY/MM/DD  hh:mm:ss

The t ime display in a screen library must 
have a division number other than “0.”

If the alarm display (relay mode) has division No. 0:
2-4



Chapter 2  Screens

2

S
creen C

om
position
Screen Structure

Screen Resolution
Screen resolution varies with models of LCD control terminal.  There are three 
kinds as shown below.

0 319 639 799
0

239

479

599

ZM-42/43

ZM-352D/37∗T, ZM-52/72

ZM-36∗S/37∗S/38∗S, ZM-72S/82

X axis (dots)

Y axis (dots)
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Lines and Columns

Lines and columns are used as units to designate coordinates of overlaps or 
sizes of character displays.

Screen Capacity
Available memory on a screen is limited to 256 KB for the ZM-300 series, and to 
128 KB for the ZM-42 to 82 series.  One screen data file is capable of storing 
1,024 screens.  The memory capacity of one screen data file differs, depending 
on the model of LCD control terminal as well as the font type in use.

Make sure to check the use environment and available memory when 
registering screens.

0 1 2

0

1

2

0 8 16 24

0

10

20

30

40

Column

Line

dots

dots

1 column = 8 dots
1 line = 20 dots

Model Column Line
ZM-42/43 40 12

ZM-352D/37∗T, ZM-52/72 80 24
ZM-36∗S/37∗S/38∗S, ZM-72S/82 100 30

For more information on the memory capacity of one screen data file, see “Appendix 1 
Fonts.”

If a screen data file stores a screen exceeding the maximum permissible 
memory, the screen may not work normally after the file is transferred to the 
LCD control terminal.  Make sure to create every screen within the capacity.

If a screen data file exceeds the maximum permissible memory, an attempt to 
transfer the file causes an alarm message “The size is too large to 
communicate” and results in transmission failure.
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Operation Environment Setting

This chapter explains the environment setting procedure for screen editing.

Background Color Setting

Follow the procedure below to set a screen background color.

Select [Screen Setting] from the [Edit] menu.  The [Screen Setting] dialog is 
displayed.

Options [F] (foreground color), [B] (background color), and [T] (tile) under [Back 
Color] are provided to set the screen background.

For more information on the color setting procedure, see page 2-57.

Other Screen Setting Items
The [Screen Setting] dialog has the following items as well.

[P1] Tab Window

[Switch Output]
This option is active only when the LCD control terminal switch type is the 
matrix type.  For more information, see “Chapter 3 Switch” in the ZM-71SE 
Instruction Manual (Function).

[  Item Select Memory]
This option is active when numerical data display or character display parts 
with [Display Function: Entry Target] setting are placed in the entry mode on 
the base screen.  For more information, see “Chapter 7 Entry Mode” in the 
ZM-71SE Instruction Manual (Function).
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[Receive Slice Level]
Specify the word count of PLC data that the LCD control terminal reads one 
time.  Depending on the PLC that is used, the maximum number of words 
that can be read one time varies.  If your setting exceeds that limit, the value 
reverts to the maximum that can be read one time for that PLC.  The default 
is 40 words.  As for the speed of data display, it is recommended that the 
receive slice level be lowered for a PLC with a fast scan time, and raised for 
a PLC with a slow scan time.

[P2] Tab Window

[PLC Mem. of Source] [Internal Mem. of Target]
When you mainly use PLC memory for the macro and also directly use PLC 
memory for macro commands, a read to PLC memory occurs and as a 
result, the display speed is slowed.  To avoid this, copy memory necessary 
for each cycle to the internal memory and execute macro commands in the 
internal memory.  Through this process, speed down can be decreased.  
Using these options, specify the copy source and the copy target for each 
screen.

[Superimpose Setting] Tab Window (For the ZM-300 series only)

This tab window is provided for the use of the superimpose function on overlaps.  
For more information, see “Chapter 2 Overlap” in the ZM-71SE Instruction 
Manual (Function).

[Animation] Tab Window (For the ZM-300 series only)

This tab window is provided for the use of the animation function.  For more 
information, see “Chapter 17 Animation” in the ZM-71SE Instruction Manual 
(Function).

For more information on the processing speed, etc. , see “Appendix 2 Process Cycle” in 
the ZM-71SE Instruction Manual (Function).

This tab window is not valid when universal serial is selected as the PLC type.
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[Wallpaper Setting] Tab Window (For the ZM-300 series only)

It is possible to use a bitmap file or a JPEG file as screen wallpaper.

[  Use Wallpaper]
Check this option when setting wallpaper.  The following options become 
active.

[File Type]
Select either [Pattern] or [JPEG].

• When [Pattern] is selected:
[Pattern No.] (0 - 1023)

When using a bitmap file as wallpaper, import a bitmap file as a 
pattern (patterns).  This option is provided for specifying a pattern 
(patterns).  By specifying the same number for both start and end 
numbers, one pattern is used as wallpaper.  When importing a 
bitmap file that has been registered as multiple patterns, two or 
more patterns can be specified.

• When [JPEG] is selected:
[File name]

Select a JPEG file name (within eight one-byte alphanumerics) to 
be used as wallpaper.

[Specify Position]

[  Enlarge]
This option is active for patterns.  A selected file can be enlarged 
under equal magnification, and placed with respect to the upper left 
corner of the screen.

[Display Center]
Select this option when placing the selected file at the center of the 
screen.

[Tile]
Select this option when tiling multiple pieces of the selected file with 
respect to the upper left corner of the screen.

[Display Corner]
Select this option when placing the selected file at a corner of the 
screen.
[Top Left], [Top Right], [Bottom Left], [Bottom Right]

JPEG files are made available by storing them in the [\ZM-71S\JPEG] folder and 
written to a CF card.

For how to write JPEG f iles to a CF card or other information on JPEG files, see “Chapter 
19, JPEG Display” in the ZM-71SE Instruct ion Manual (Funct ion).
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Display Environment Setting

Grids or area lines can be displayed as a screen editing guide.

[Display Environment] Dialog
Select [Display Environment] or [Change All Display Environment] from the 
[Display] menu.  The [Display Environment] dialog is displayed.

[Detail] Tab Window

[Edit Layer]
This option is active for a screen with overlaps (normal).  Select [Base] or 
[Overlap 0 - 2] for the layer you are going to edit.  For more information on 
overlaps, see “Chapter 2 Overlap” in the ZM-71SE Instruction Manual 
(Function).

[Switch/Lamp]
Select from [ON], [OFF], and [P3] - [P8] for the status of the switches or 
lamps displayed on the screen.  The current status is indicated on the icon 
bar as well as the status bar.  For more information on switches and lamps, 
see “Chapter 3 Switch” in the ZM-71SE Instruction Manual (Function).

[Language]
Use this option to select the language used on the screen.  For more 
information, see “Chapter 29 Language Selection” in the ZM-71SE 
Instruction Manual (Function).

Select [Display Environment] when making display environment settings for 
one certain screen.  Select [Change All Display Environment] when making 
display environment settings for all screens in a screen data file.
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[Overlap]
This option is active when normal overlaps are placed on the screen.  Select 
whether or not to display the overlaps.  Check the box ( ) of the desired 
overlap number.  Uncheck the box when it is not displayed.  For more 
information on overlaps, see “Chapter 2 Overlap” in the ZM-71SE Instruction 
Manual (Function).

[Detail]
By checking the desired option, its detailed information is displayed.
[DIV No.] Displays the division numbers of parts.
[Memory] Displays the memory addresses assigned to parts.
[Area] Displays the area of each part by dotted lines.

[  Paint Dsp.]
When there is a graphic drawn with the [Paint] icon on the draw tool bar, it is 
displayed as painted.  When this option is unchecked, only “×” appears to 
indicate the paint start point.  For more information on paint, see “Chapter 3 
Drawing Tools.”

[  Graphic Relay Dsp.]
This option is active only when the graphic relay mode is set.  The ON/OFF 
status in the graphic relay mode can be checked.  For more information on 
the graphic relay mode, see “Chapter 9 Graphic Display” in the ZM-71SE 
Instruction Manual (Function).

[  Message Dsp.]
This option is active when the relay mode or message mode is set.  
Messages specified in these modes can be displayed in the display area (or 
on switches/lamps) on the screen.  For more information on the relay and 
message modes, see “Chapter 6 Message Display” in the ZM-71SE 
Instruction Manual (Function).

[  Graphic Library]
This option is active when the entry mode or graphic mode is set.  For the 
entry mode, graphics registered in graphic library can be displayed on the 
character entry keys provided that [Use Graphic] is checked.  For the graphic 
mode, graphics can be displayed provided that [Internal] is chosen for 
[Command].  See “Chapter 7 Entry Mode” for more information on the entry 
mode, and to “Chapter 9 Graphic Display” for the graphic mode in the 
ZM-71SE Instruction Manual (Function).

[  Data Block Dsp.]
This option is active when the data block area is set on the screen.  The 
initial block number is indicated on the screen provided that [Internal] is 
chosen for [Command].  For more information on the data block area, see 
“Chapter 7 Entry Mode” in the ZM-71SE Instruction Manual (Function).

[DIV No.] [Memory] [Area]
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[  Display Path of Animation]
This option is active when animation setting is made.  When the path of 
animated graphics should be depicted, check this box.  For more information 
on animation, see “Chapter 17 Animation” in the ZM-71SE Instruction 
Manual (Function).

[  Base Screen Dsp.]
This option is active during editing of graphic library, multi-overlap, or data 
block.  When a screen or multi-overlap should be displayed in editing, check 
this box.

[Menu Dsp.] Tab Window

[  Offset Mark Dsp.]
This option is active during editing of graphic library or data block.  Choose 
whether or not to show the offset mark on the screen.

[  MLIB Mark Dsp.]
This option is active when setting a call-overlap or multi-overlap.  Choose 
whether or not to show the MLIB mark on the screen to position the overlap.

[Handle Color]
Choose the color of handles shown around clicked items.
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[Grid] Tab Window

[  Grid Dsp.]
When this option is checked, grids are displayed.

[  ON Grid]
When this option is checked, “on-grid” editing is enabled.  (This “on-grid” 
editing is not valid for items on overlaps.)

[Grid Color]
Select the desired grid color.  (as well as the color of the dotted lines that 
denote the available screen area of ZM.)

[Grid Type]
A grid type can be selected from the following four.

[1-Byte]:
The grids are based on the unit: 8 × 20 (the unit of one-byte character: 8 
× 16 dots plus four Y-axis dots).  The reference point is placed at 
coordinates (0, −3).  The maximum number of one-byte characters, 
which can be displayed on the one-byte character grids, depends on the 
ZM model.  Refer to the following table when placing messages or texts 
on the screen.

[Switch]:
When matrix switch (ZM-72/82) is used, the switch operating area is 
determined based on the switch grids.  The grids are based on the unit: 
16 × 20 dots (the unit of switch: 14 × 18 dots plus spaces: 2 × 2 dots).  
The reference point is placed at the coordinates (1, 1).
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[Mode]:
The mode grids are equivalent to the one-byte character grids, but their 
reference points differ.  The mode grids are based on the unit: 8 × 20 
dots.  The reference point is placed at (0, 0).  Lines and columns are 
used to indicate item positions (as the figure on the left).  When 
specifying overlap positions, etc. by external signals, indicate their 
column and line numbers.

[Free]:
Your desired grids can be set by specifying the following options:
[X Offset] [Y Offset] [X Pitch] [Y Pitch]

0

0

1

1 2 3 (Column)

(Line)

Relationship between Offset and Pitch
Grids are placed from the offset point at intervals specified by X and Y pitches.

Ex. 1:  Ex. 2:
X Offset: 0 X Offset: 10
Y Offset: 0 Y Offset: 10
X Pitch: 20 X Pitch: 20
Y Pitch: 20 Y Pitch: 20

(20, 0)

(0, 20)

(0, 40)

(0, 0)
(40, 0) (30, 10)

(10, 30)

(1, 0)

Offset point Offset point
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[  Place Switches on Switch Grids]
When this option is checked, switches are placed based on the switch grids, 
irrespective of the set grid type.

When the [Point Search] icon is used during switch placing, the function of the icon takes 
priority over the switch grid setting.

About the right-click menu
The [ON Grid], [Grid Dsp.] , and [Grid Type] options in the [Grid] tab window are also 
included in the right-click menu.  Right-clicking the mouse on the screen shows the 
following menu.

When [ON Grid] and [Grid Display] are checked (or unchecked), these commands are 
active (or inactive).  For [Grid Type], select the desired type from the displayed menu on 
the right.  When [ON Grid]  or [Grid Display] is selected, the grid type selected from this 
menu becomes valid.

Make other grid settings such as color or offset in the [Display Environment]  dialog.
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[Others] Tab Window

[Zoom] (75%/100%/200%/400%)
The screen display can be zoomed out or zoomed in.

[  Monochrome 8-grade Display]
When this option is checked, the colors on the screen change into the 
monochrome 8-gradation colors.

[  Interlock Text in the Switch]
When a switch, lamp, or calendar part is enlarged/reduced while this option 
is checked, the text on the switch or the lamp or “YY MM DD hh mm ss SUN” 
of the calendar part is also enlarged/reduced.  When this option is 
unchecked, the text or the “YY MM DD hh mm ss SUN” is not changed in 
size

[  Limit of Edit Model Area]
When this option is checked, items can be moved within the available screen 
area of ZM.  When it is unchecked, items can be moved beyond the area.

[  Enlarge Items including Circles in the Opposite Angle]
When this option is checked, the selected item can be enlarged/reduced only 
in the diagonal directions.  Dragging handle A or B results in dragging handle 
1.  Likewise, dragging handle C or D results in dragging handle 2.  When 
enlarging/reducing a graphic consisting of circles and lines (boxes), the 
graphic shape is not changed with this option.

[  Not Display Overlaps when Base is Selected]
The function of this option is the same as [Hide Overlaps with Base 
Checked] included in the right-click menu.  For more information, see 
“Chapter 1 Basic Operation.”

[Windows 2000/NT4.0 Paint Processing]
When Windows 2000 or Windows NT4.0 is used, painting may not be 
performed normally.  Check this option in such a case.

This function is available only when 16-/24-/32-bit full color is selected for 
Windows screen setting, and invalid when 256-color is selected.

A

B

C

D

1

2
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Part Types and Placement

This section explains the functions and types of available parts as well as notes 
on their placement on the screen.

Part Types

There are the following types of parts.
* The display area and keypad parts are not included in this table.  These parts are 

available with “MP” parts, and do not function independently.

Type Name Remarks

SP Overlap Call- or mult i-overlap or video: type I
SP Switch

SP Lamp
SP Numerical data display

SP Character display
SP Message display

SP Table data display
MP Relay

MP Relay-sub
MP Message

MP Entry
MP Data block

SP Bar graph
SP Pie graph

SP Panel meter
SP Statistic bar graph

SP Statistic pie graph
SP Trend graph

SP Closed area graph
MP Graphic

MP Graphic relay
MP Trend sampling

MP Data sampling
MP Bit sampling

MP Relay sampling
MP Alarm display

I Time display
SP Calendar display

MP Memo pad
I Macro

I Interval timer
MP Memory card
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SP: Single part (funct ioning singly selected from a parts file)
MP: Combined parts (functioning in combination with other parts)
I: Item (functioning as per dialog setting)

* Screen library is not a part.   It is used to place a screen library element including 
registered parts, etc. on screens.  Before placing a screen library element, check its 
registered items.  For more information on the screen library, see “Chapter 4 
Registration Items.”

Notes on Parts Placement

When placing parts on the screen, check available memory per screen (ZM-300: 
256 KB; ZM-42 to 82: 128 KB) and the limited number of parts that can be 
registered on one division, one layer (base, overlap 0 - 2), and one screen (four 
layers).  The limitation and the maximum number of the parts are listed below.

MP Animation Not available with ZM-42 to 82 and 
ZM-352D

MP Video display Available with ZM-300 only
MP JPEG display Available with ZM-300 only

I Sound Available with ZM-300 only
I Screen library *

Type Name Remarks

For more information on divisions, see page 2-2.

Parts Limit per 
division

Limit per 
layer

Limit  per screen
ZM-300 series ZM-52/72/82/52HD ZM-42/43/62E

Overlap − − 3
Switch None None 768 192

Lamp None None 768 192
Numerical data display None None Setting memory

Character display None None Setting memory
Message display None None Setting memory

Table data display 1 256 Setting memory
Relay 1 256 Setting memory

Relay-sub 1 256 Setting memory
Message 1 256 Setting memory

Entry 1 1 4
Data block 1 4 4

Bar graph None None Setting memory
Pie graph None None Setting memory

Panel meter None None Setting memory
Statistic bar graph 1 256 Setting memory

Statistic pie graph 1 256 Setting memory
Trend graph 1 256 Setting memory

Closed area graph None None Setting memory
Graphic 1 256 Setting memory
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*1 A maximum of four memory card modes can be set on one screen (four layers) 
though there is a limitat ion.  For instance, two layers of one screen cannot contain 
one list display each.  But it is possible that one layer contains one list display, and a 
different layer of the same screen contains one format screen.

*2 When placing a screen library on the screen, the parts registered in the screen 
library are subject to the same limit items in the chart above.  When placing a screen 
library that has a mode registered in it,  it  is necessary to select division numbers that 
have no mode registered.

*3 These functions may not be available even with the ZM-300 series, depending on 
the models.  For more information on available models, see the ZM-71SE Instruction 
Manual (Function).

Graphic relay 1 256 Sett ing memory
Trend sampling 1 256 Sett ing memory

Data sampling 1 256 Sett ing memory
Bit sampling 1 256 Sett ing memory

Relay sampling 1 256 Sett ing memory
Alarm display 1 256 Sett ing memory

Time display None None Sett ing memory
Calendar display 1 256 Sett ing memory

Memo pad 1 1 1 (* Not available with ZM-72/82 matrix type)
Macro 1 256 Sett ing memory

Interval timer 1 256 Sett ing memory
Memory card 1 1 4 (*1)

Animation (*3) 1 256 Setting memory −

Video display (*3) 1 4 4 −

JPEG display (*3) 1 256 Setting memory −

Sound (*3) 1 256 Setting memory −

Screen library None None (*2)

Parts Limit  per 
division

Limit per 
layer

Limit per screen
ZM-300 series ZM-52/72/82/52HD ZM-42/43/62E
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Setting Memory
“Setting memory” in the previous chart means the number of memory locations, 
which is read on one screen.  This does not mean the number of words used on 
a screen.  Screen resolution varies with models of LCD control terminal.

The read area under [System Setting] is counted as one memory location.  (The 
write area is not the target to count.)  Therefore, to determine the maximum 
number of memory locations for a part, subtract one from the number indicated 
in the above table.  The way of counting for setting memory is unique, but these 
values should be enough to create screens.

Examples:
• One memory location is counted even when 10 words are used in the relay 

mode.
• Switch output memory is not counted as setting memory.  For lamp memory, 

however, one is counted for each lamp memory location used.
• Each data display is counted as one memory location.  If maximum and 

minimum values are set, one memory location each is counted.

Model No. of memory locat ions per screen
ZM-300 series 1024

ZM-82 1024
ZM-72 1024

ZM-52/52HD 1024
ZM-42/43/62E 256
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Parts File

Parts such as switches, lamps, or data displays (“SP” parts mentioned on page 
2-17) are registered in parts files.  Desired parts will be selected from these 
parts files and placed on the screen.  A placed part can be replaced as desired.

Kinds of Parts Files
Three different extensions are provided to parts files.

• [*.Z3P] ZM-300 series parts file
• [*.Z7P] ZM-42/43/52/62/72/82 series parts file
• [*.ZMP] ZM-41/70 series parts file

The following parts files are provided from Sharp Corporation.

Parts f ile name Type Remarks

ZM-300

Std.z3p 32,000-color
Parts_j.z3p 32,000-color

3DStd.z3p 32,000-color

3D parts for 
ZM-300

3Dnow_p2.z3p 32,000-color

3Dnow_p3.z3p 32,000-color
3Dnow_p4.z3p 32,000-color

3Dnow_p5.z3p 32,000-color
3Dnow_p6.z3p 32,000-color

3Dnow_p7.z3p 32,000-color
3Dnow_p8.z3p 32,000-color

3Dfront.z3p 32,000-color 3D parts for 
ZM-42/43/52/62/
72/82

3Dside.z3p 32,000-color

Std_128.z3p 128-color

For ZM-352D
Parts_j_128.z3p 128-color
3Dfront_128.z3p 128-color

3Dside_128.z3p 128-color

ZM-42/43/52/
62/72/82

Std.z7p 128-color

Parts_j.z7p 128-color
3Dfront.z7p 128-color

3Dside.z7p 128-color
Parts_mono.z7p 128-color

ZM-41/70
Std.zmp 16-color
Parts_j.zmp 16-color
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3D Parts
The ZM-300 series and the ZM-42 to 82 series are provided with parts using 3D 
graphics.  Extra care should be taken in handling these 3D parts.  For the 
description of setting and placing the parts, see “Appendix2 3D Parts.”

This section explains how to set parts other than 3D parts.

Parts File (Ex.: Switch)
Clicking the [Switch] icon brings up the [Switch] dialog.
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Click the [Parts Select] button.  The [Switch List] window is displayed.

1. [Parts File]
Use this button to call up a different parts file.  The [Std.z3p] file is chosen as 
default.  Click the [Parts File] button.  The [Select Parts File] dialog is 
displayed.  Choose the desired file and click [Open].

The file is opened.

2. [Select]
By clicking a part in the [Switch List], its number is highlighted in red.  Click 
the [Select] button.  The part is shown in the [Switch] dialog.

3. [Cancel]
Clicking the [Cancel] button closes the parts file and brings up the [Switch] 
dialog.

4. [JUMP]
Clicking this button brings up the dialog to specify a part number.  Specify the 
desired part number and click [OK].  The part is selected.

8

4 5

1
2
3

7

6

For opening a 3D parts list or placing 3D parts, see “Appendix2 3D Parts.”
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5. [<] [>]
Click either button to scroll up/down the [Switch List] window.

6. [  Save Setting]
When this box is checked, part change is possible while the dialog data is 
saved.  Thus, dialog settings such as memory address or display type do not 
revert to the default.  When this box is unchecked, the dialog data reverts to 
the default.

7. [Display Pattern]
This setting is active only when a switch or lamp part is selected.  The 
displays of the OFF, ON, and P3 to P8 patterns can be shown.

8. Comment field
This field indicates the comment on the part.  Comment can be entered only 
during part editing.  Open the [Switch List] window during part editing, and 
click this field.  It becomes active for comment entry.

If a switch or lamp part is changed from 2-notch (OFF/ON) type to 3-notch 
(OFF/ON/P3 to P8), make sure to uncheck [  Save Setting] before selecting the 
3-notch type.
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Parts Placement (Ex.: Switch)
1. Click the [Switch] icon.  The [Switch] dialog is displayed.

2. When selecting a different part, click [Parts Select] and select the desired 
switch part.

3. Click the [Place] button in the [Switch] dialog.  A dotted box and a mover tool 
(cross cursor) appear in the screen edit window.

4. Click the mouse in the desired position.  The switch is displayed.
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Parts Change (Ex.: Lamp)
Follow the procedure below to replace a placed part with another.

1. Double-click a part to be replaced.  (Or, click the part and the [Detail/Prop. 
Change] icon.)

2. Click the [Parts Select] button.  The [Lamp List] window is displayed.

3. When opening a different parts file, click the [Parts File] button and select the 
desired parts file.

4. Select the desired part and click the [Select] button.

5. The [Lamp] dialog is displayed.  Click [OK].  The lamp has been replaced 
with the selected one.

Double-click a part.

Or

Click a part and the [Detail/Prop. Change] icon.

When [  Save Setting] is checked, part change is possible while the current 
lamp data (memory address, draw mode, etc.) is saved.  When this box is 
unchecked, the data reverts to the default.
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Parts Enlargement/Reduction
When a part is clicked, handles are shown all around, denoting that the part is 
selected.  By dragging handles, the part can be enlarged or reduced.

Parts Selection
• When selecting multiple parts, drag the mouse enclosing all the desired parts 

from the top left to the bottom right.

• When selecting multiple parts individually, hold down the Shift key and click 
the desired parts.

Clicking shows handles.

Enlarged vertically

Enlarged horizontally

Enlarged diagonally
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Parts Movement
• While handles are shown around a selected part, drag the part (avoid 

dragging the handles).  A cross cursor appears and functions as a tool to 
move the part.

Parts Placement from Tool Bars

When an icon for the entry, relay, or sampling mode is clicked, its own tool bar is 
displayed.  It is possible to make settings including the [Detail] dialog for the 
corresponding part from the displayed tool bar.  This section explains the 
procedure for placing and setting parts from tool bars.

Setting Procedure (Ex.: Relay)
Click the [Relay Mode] icon on the tool bar.  The relay mode tool bar is displayed 
at the upper right.

Drag with a cross cursor.

While a cross cursor is displayed, pressing an arrow key ([→] [←]  [↓]  [↑]) on the 
keyboard moves a part or graphic dot by dot.

If the tool bar is hidden from view, drag it so that it comes into view entirely.
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The relay mode tool bar consists of the following icons.

[Detail] Icon

In the case of a tool bar containing a [Detail] icon, its setting must be made to 
make the part operable.  Start setting from the [Detail] icon.

1. Click the [Detail] icon on the relay mode tool bar.

2. The [Relay] dialog is displayed.  When the dialog setting is concluded, click 
[OK].

The [Relay Mode] icon is registered in the [Part] auxiliary tool box in the 
lower left corner of the screen.

Display area
Switch
Lamp

Up/down switch

Quit
Delete
Detail

For more information on the tool box, refer to the following.
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• About the [Part] auxiliary tool box − Modification
When the [Relay] dialog (from the [Detail] icon) setting is concluded and you 
click [OK], the [Relay Mode] icon is registered in the [Part] auxiliary tool box 
in the lower left corner of the screen.  The icon in the box indicates the 
division number specified in the dialog.  When checking or modifying the 
data of the dialog, click the icon in the [Part] auxiliary tool box.  Its tool bar or 
dialog is displayed.

• Deletion

1) Click the icon to be deleted from the [Part] auxiliary tool box.

2) When its tool bar is displayed, click the [Delete] icon.  When its dialog is 
displayed, click the [Delete] button.

3) The confirmation message appears.  Click [Yes] when deleting the icon.  
The icon is deleted from the [Part] auxiliary tool box.

• Copy
When copying the function registered in the [Part] auxiliary tool box, bring up 
the item list.

1) Select [Item List] from the [Display] menu.

Or
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2) The [Item List] window is displayed.  Items containing no mouse 
coordinates correspond to icons in the [Part] auxiliary tool box.

3) Click the item to be copied.  It is highlighted.

4) Select [Copy] from the [Edit] menu or click the [Copy] icon.

5) Pasting can be executed on either [Item List] or screen.  Select [Paste] 
from the [Edit] menu or click the [Paste] icon.  The copy icon appears in 
the [Part] auxiliary tool box.

Deletion of icons from the tool box is also executable on the [ Item List] window.
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• Arrow buttons in the [Part] auxiliary tool box
When more than 16 icons are stored in a [Part] auxiliary tool box, extra icons 
are hidden from view.  Bring up the hidden icons using the arrow buttons.

Tool Bar for Each Part

The relay mode tool bar contains icons in addition to [Detail].  Clicking an icon 
brings up the dialog for the relay mode part.

When the part already selected is OK, click the [Place] button.  When selecting a 
different part, bring up the parts list using the [Parts Select] button and select the 
desired part.

Click the [Display Area] icon (for example).

It is recommended that [  Save Sett ing] be checked when selecting a part.  When a part 
is selected with this box unchecked, the relay mode settings revert to the default.
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There is an icon, like the [Up/down switch] icon, that brings up a pull-down menu 
when it is clicked.  Select the desired option from the menu.  The corresponding 
dialog is displayed.  Place a part from the dialog.

Redisplay of Tool Bar

Click a registered icon in the [Part] auxiliary tool box.  When the [Detail] icon is 
clicked, the [Relay] dialog containing the previously set data appears.  The 
remaining icons are the same as those used for placement.

Select the desired part f rom the menu.

Click it to check the previous settings.

Click them for new placement.
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Parts Placement and Setting

Overlap

Click the [Overlap] icon.  The [Overlap Setting] dialog is displayed.

Check a box as desired.  The associated buttons become active.

Normal Overlap
This section explains placing a normal overlap.  It is possible to create an 
overlap to be displayed on one specific screen.  Click the [Normal] button.  The 
[Overlap (Normal)] dialog is displayed.

Clicking the [Parts Select] button brings up the [Overlap List] window.  Select the 
desired part and click [Select].  The previous [Overlap (Normal)] dialog is 
displayed.  When placing the selected part on the screen, click the [Place] 
button.

Overlap coordinates
X, Y (0, 0) is the reference point.  X and Y coordinates are at intervals of 4 dots 
and 1 dot respectively.

For the description of setting the dialog, see “Chapter 2 Overlap” in the ZM-71SE 
Instruction Manual (Function).
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Editing in Overlap

When placing items such as switch parts or graphics, change over the editing 
layer from the base to an overlap.

1. Right-click the mouse.  The menu is displayed.  Select [Overlap 0 (or 1 or 2)].
The editing layer is now changed from the base to an overlap.  Icons for 
drawing and parts (except for overlap) become active.

2. Place desired parts or graphics on the overlap.
When an overlap is selected as the editing layer, the overlap cannot be moved 
or enlarged/reduced.  To allow these operations, select [Base] from the 
right-click menu.

Editing Layer
When creating a screen, the target to be edited is one of four layers consisting of the 
base screen, overlap No. 0, overlap No. 1, and overlap No. 2.  When start ing, one layer is 
chosen for edit ing.  The editing layer denotes the one that is currently chosen.

Editing layer (one of them)

Base screen Overlap
No. 0

Overlap
No. 1

Overlap
No. 2
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Changeover of Editing Layer
Follow either method:
1. Right-click the mouse.  Change the edit ing layer from the pull-down menu.
2. Select [Display Environment] f rom the [Display] menu.  The [Display Environment] 

dialog is displayed.  In the [Detail] tab window, change the setting for [Edit Layer].  
Choose the desired overlap number to select the layer.

Editing layer change must be executed while a normal overlap is placed on the 
screen.

When an overlap is selected as the editing layer, the modes placed on the 
selected overlap are indicated in the [Part] auxiliary tool box in the lower left 
corner of the screen.  When the editing layer is moved to the base screen, the 
modes on the base screen are indicated in the auxiliary tool box.

Display/Non-display by Right-click Menu
It is possible to decide display or non-display of normal overlap on the base screen from 
the right-click menu.  Select [Hide Overlaps with Base Checked] from the right-click 
menu.  When the editing layer has been changed from [Overlap] to [Base], the overlap 
disappears.  When the editing layer has been changed from [Base] to [Overlap] again, 
the overlap appears on the screen.  (The same setting is available in the [Others] tab 
window to be displayed by selecting [Display Environment] from the [Display] menu.)
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Call-/Multi-Overlap
For a call- or multi-overlap, make settings for calling the overlap on the screen.  
Register both call- and multi-overlaps in multi-overlap editing.

Clicking the [Call] button brings up the [Overlap (Call)] dialog.  Clicking the 
[Multi] button brings up the [Overlap (Multi)] dialog.

By clicking [OK], the [Overlap] icon is registered in the [Part] auxiliary tool box in 
the lower left corner of the screen.  To recheck the dialog data, click this icon.

For the overlap registering procedure, see “Chapter 4 Registration Items.”

For the descript ion of setting the dialogs, see “Chapter 2 Overlap” in the ZM-71SE 
Instruction Manual (Function).
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Video Display
Clicking the [Video] button brings up the [Overlap (Video)] dialog.

Note:
The ZM-300 is provided with the [Video] function to show video images.  For 
more information, see “Chapter 18 Video Display” in the ZM-71SE Instruction 
Manual (Function).
 

By clicking [OK], the [Overlap] icon is registered in the [Part] auxiliary tool box in 
the lower left corner of the screen.  To recheck the dialog data, click this icon.

ZM-300 ZM-72/82

For the description of setting the dialog, see “Chapter 2 Overlap” in the ZM-71SE 
Instruction Manual (Function).
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Switch and Lamp

Switches and lamps can be placed in the same manner.  When placing switch 
parts, click the [Switch] icon.  When placing lamp parts, click the [Lamp] icon.  
For more information on placing these parts, see page 2-25.

For the descript ion of setting the dialogs, see “Chapter 3 Switch” or “Chapter 4 Lamp” in 
the ZM-71SE Instruct ion Manual (Funct ion).
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Data Display

Numerical Data and Character Displays
When placing numerical data display parts, click the [Num. Data Display] icon.  
When placing character display parts, click the [Char. Display] icon.

The [Num. Display] or [Char. Display] dialog is displayed.

Clicking the [Parts Select] button in either dialog brings up the [Num. Display 
List] or [Char. Display List] window.  Select a part and click the [Select] button.  
The previous dialog is displayed.

When placing the selected part on the screen, click the [Place] button.

Message Display
Click the [Message Display] icon.  The [Message Disp.] dialog is displayed.

Clicking the [Parts Select] button brings up the [Message Disp. List] window.  
Select a part and click the [Select] button.  The previous dialog is displayed.

For the description of setting the dialogs, see “Chapter 5 Data Display” in the ZM-71SE 
Instruction Manual (Function).

For the description of setting the dialogs, see “Chapter 5 Data Display” in the ZM-71SE 
Instruction Manual (Function).

Message display parts are used to display variable messages.  The parts are 
displayed as “MSG” on the editor screen.
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When placing the selected part on the screen, click the [Place] button.

Table Data Display Part
Table data display parts are not included in parts files.  They are placed by 
setting the corresponding dialog.

Click the [Table Data Display] icon on the tool bar.  The [Table Data Display] 
dialog is displayed.

Clicking [OK] brings up a dotted box and a mover tool (cross cursor).  Click it in 
the desired position.  The table data display part is placed.

Message Display Parts
When placing a graphic such as a frame behind a message display part,  the use of 
[Modify Part] (from the [Edit]  menu) or the [Change the Setting of a Part  Placed] icon is 
recommended.  The background should be sized so that it can display the longest 
message.

For registering a part background, see “Appendix 3 Part Editing.”

MSG MSGAuto operation timeout

For the descript ion of setting the dialogs, see “Chapter 5 Data Display” in the ZM-71SE 
Instruction Manual (Function).

To bring up the [Table Data Display] dialog again, double-click the placed part  or click the 
[Detail/Prop. Change] icon.
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Property Change for One Data Cell

1. Click the table data display part.  Handles are shown all around.

2. Right-click the mouse on a cell for property change.  The cell is highlighted 
and the right-click menu is displayed at the same time.

3. Click [Detail Setting].  The [Table Data Display (Num. Display)] dialog is 
displayed.

4. Set the options in the dialog.  Select a necessary data display type from 
numerical display, character display, message display, or text in drawing.

12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345

12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345
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Property Change for Multiple Data Cells

1. Click the table data display part.  Handles are shown all around.

Memo
It is also possible to bring up the [Table Data Display (xxxx)] dialog by 
double-clicking while the specified cells are highlighted.
 

2. Select two or more desired cells by right-dragging.  The cells are highlighted.  
The right-click menu is displayed at the same time.

3. Select [Detail Setting] from the menu.  The [Table Data Display (Num. 
Display)] dialog is displayed.  When data cells of different types are selected, 
the [Table Data Display (xxxx)] dialog for the top left cell is displayed.

Memo
“(xxxx)” in [Table Data Display (xxxx)] indicates the type of the display part: 
“Num. Display,” “Char. Display,” “Message Disp.,” or “Text in Drawing.”
 

12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345

When the [Table Data Display (xxxx)] dialog has been set and [OK] is clicked, 
the setting is reflected through the remaining selected cells.  (When [  Memory 
Inc.] is not checked, the previous memory address setting is maintained.)
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Change of Cell Height and Cell Width

• When changing the width of the cell, specify a demarcation line in the top line 

as shown below.  The cursor changes into .  Drag it until the cell is 
adjusted to the desired width.

• When changing the height of the cell, specify a demarcation line in the first 

column as shown below.  The cursor changes into .  Drag it until the cell 
is adjusted to the desired height.

Right-Click Menu

When cells are selected by right-clicking or right-dragging, a pop-up menu is 
displayed.  The same menu without [Detail Setting] is displayed when [Table 
Data Display Editing] is selected from the [Edit] menu.  (For the description of 
[Make Browser File] (selected from [Table Data Display Editing] in the [Edit] 
menu), see “Chapter 28 Web Server” in the ZM-71SE Instruction Manual 
(Function).)

12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345

12345
12345
12345
12345
12345

12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345

12345
12345
12345
12345
12345
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• [Align Width]
All cells are adjusted to the width of the top left cell in the selected cells.

• [Align Height]
All cells are adjusted to the height of the top left cell in the selected cells.

• [Align Character]
Cell sizes in a table can be so adjusted that the largest data item fits into a 
cell.  It is not necessary to specify the cell in the following manner.  Specify 
the table data display part (handles are shown), select [Table Data Display 
Editing] from the [Edit] menu, and execute [Align Character].

• [Cut]
This command is used for editing lines or columns.  The function is the same 
as that of [Cut] in the [Edit] menu.

• [Copy]
The function of this command is the same as that of [Copy] in the [Edit] 
menu.  [Paste] becomes active after copy.

• [Paste]
The function of this command is the same as that of [Paste] in the [Edit] 
menu.  When multiple columns or lines are pasted, the cell designated as the 
target is placed at the top of the pasted data.  A data area larger than the 
table cannot be pasted.

12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345

12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345

This width is applied to all cells.

12345 12345 12345

12345 12345 12345

12345 12345 12345
12345 12345 12345
12345 12345 12345

12345 12345 12345

12345 12345 12345

12345 12345 12345

12345 12345 12345

12345 12345 12345

This height is applied to all cells.

12345

No. 12345 12345
1 12345 12345
2 12345
3 12345 12345
4 12345 12345

12345

No. 12345 12345
1 12345 12345

2 12345

3 12345 12345
4 12345 12345
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• [Insert]
This command is used for editing lines or columns.  When lines are copied or 
cut (selected lines are highlighted), they are inserted above the designated 
target.  When columns are copied or cut, they are inserted on the left of the 
designated target.

• [Delete]
This command is used for editing lines or columns.  The function is the same 
as that of [Delete] in the [Edit] menu.

• [Detail Setting]
The dialog for table data display property change is displayed.

Relay, Relay-Sub, and Message Modes

Clicking the [Relay Mode], [Relay-sub Mode], or [Message Mode] icon brings up 
the following corresponding tool bar.

The [Cut] , [Insert] , and [Delete] commands are used for editing lines or columns.
Ex.:  Insert

No.1 No.2
1 12345 12345
2 12345 12345
3 12345 12345
4 12345 12345

No.1 No.2
1 12345 12345
2 12345 12345
3 12345 12345
4 12345 12345

No.1 No.2
1 12345 12345
2 12345 12345
3 12345 12345
4 12345 12345

No.2
12345
12345
12345
12345

Copy Specify the target Finished

Display area
Switch
Lamp

(identical to the relay mode 
tool bar)Quit

Delete
Detail

Up/down switch Up/down switch

Display area

Detail
Delete

Quit

For the setting procedure using the tool bar to be displayed by clicking an icon, see page 
2-28.  For the description of sett ing the dialogs, see “Chapter 6 Message Display” in the 
ZM-71SE Instruction Manual (Function).
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Entry Mode and Data Block Area

Clicking the [Entry Mode] or [Data Block Area] icon brings up the following 
corresponding tool bar.

Keypad
Data block
Entry target
Entry display

Quit
Delete
Detail
Min. display
Max. display

(identical to the relay-sub 
mode tool bar)

For the sett ing procedure using the tool bar to be displayed by clicking an icon, see page 
2-28.  For the description of setting the dialogs, see “Chapter 7 Entry Mode” in the 
ZM-71SE Instruction Manual (Function).
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Bar Graph, Pie Graph, Panel Meter, and Closed Area Graph

Click the desired graph icon.

The graph dialog is displayed.

Clicking the [Parts Select] button brings up the parts list.  Select the desired part 
and click [Select].  The previous dialog is displayed.

When placing the selected part on the screen, click the [Place] button.

For the description of setting the dialogs, see “Chapter 8 Graph Display” in the ZM-71SE 
Instruction Manual (Function).
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Statistic Graph

Clicking the [Stat. Graph] icon brings up the following tool bar.

Click either [Stat. Bar Graph] or [Stat. Pie Graph] icon.  The corresponding dialog 
is displayed.

Clicking the [% Display] icon brings up a numerical data display part dialog.  To 
establish a link between numerical data display part and statistic graph, specify 
the same division number for them.

Clicking the [Parts Select] button brings up the parts list.  Select the desired part 
and click [Select].  The previous dialog is displayed.

When placing the selected part on the screen, click the [Place] button.

Statistic bar graph
Statistic pie graph

% display

Quit

For the descript ion of setting the dialogs, see “Chapter 8 Graph Display” in the ZM-71SE 
Instruction Manual (Function).
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Trend Graph

Clicking the [Trend Graph] icon brings up the [Trend Graph] dialog.

Clicking the [Parts Select] button brings up the parts list.  Select the desired part 
and click [Select].  The previous dialog is displayed.

When placing the selected part on the screen, click the [Place] button.

Graphic Mode and Graphic Relay Mode

Clicking the [Graphic Mode] or [Graphic Relay Mode] icon brings up the 
corresponding tool bar.

For the description of setting the dialogs, see “Chapter 8 Graph Display” in the ZM-71SE 
Instruction Manual (Function).

Display area
Detail

Delete

Quit

(identical to the relay-sub 
mode tool bar)

For the setting procedure using the tool bar to be displayed by clicking an icon, see page 
2-28.  For the description of sett ing the dialogs, see “Chapter 9 Graphic Display” in the 
ZM-71SE Instruction Manual (Function).
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Sampling

Clicking a sampling icon brings up its tool bar as the following.

Clicking the [Trend Sampling] icon allows a trend sampling part placement.  To 
establish a link between a trend sampling part and other parts (like switch or 
data display parts) available with the part, give the same division number to 
them.

For the sampling icons other than trend sampling, their tool bars contain [Detail] 
icons respectively.

1

2

3 4 5

1

2

3 4

5

Count display
Time display

Trend sampling

Up/down 
switch

Quit Quit

Up/down switch

Sampling 
display area
Count display
Time display

Delete
Detail

Display area
Up/down switch
Count display
Time display

(identical to the relay mode 
tool bar)

(ident ical to the relay-sub 
mode tool bar)

Quit
Delete
Detail
Status display

For the sett ing procedure using the tool bar to be displayed by clicking an icon, see page 
2-28.  For the description of setting the dialogs, see “Chapter 10 Sampling” in the 
ZM-71SE Instruction Manual (Function).
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Time Display

Clicking the [Time Display] icon brings up the [Time Display] dialog.

When placing the selected part on the screen, click the [Place] button.

Calendar Display

Clicking the [Calendar Display] icon brings up the [Calendar] dialog.

Clicking the [Parts Select] button brings up the parts list.  Select the desired part 
and click [Select].  The previous dialog is displayed.

When placing the selected part on the screen, click the [Place] button.

For the description of setting the dialog, see “Chapter 11 Time Display/Calendar” in the 
ZM-71SE Instruction Manual (Function).

For the description of setting the dialog, see “Chapter 11 Time Display/Calendar” in the 
ZM-71SE Instruction Manual (Function).
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Note on selecting parts
Calendar parts consist of parts like “hour, minute, and second,” “year, month, 
and day,” and also parts with punctuation marks like “:” and “−.”  If you check [  
Save Setting] in the calendar parts list window and then proceed to select parts, 
there are instances of the selected parts being placed on the screen in a 
disrupted condition.  To avoid disrupting the shape of the parts that are placed 
on the screen, it is recommended that you do not check [  Save Setting] in the 
calendar parts list window.

How to Alter a Calendar Part:
To delete one portion of a calendar part “YY MM DD hh mm ss SUN,” refer to the 
example below.

Ex.: To delete day of the week

1. Go to the [Week] tab window in the [Calendar] dialog and uncheck [Display].
 Display →  Display

Note that if you select “SUN” (day-of-the-week display) (handles are displayed) and 
select [Delete] from the [Edit] menu, the calendar part  is deleted.

2. Even if you delete the day-of-the-week display, its area and punctuation marks will 
remain intact.  Use the [Change the Sett ing of a Part  Placed] icon to standardize the 
areas or delete punctuat ion like “( ).”

How to Enlarge a Calendar Part:
Click a calendar part and drag the handles.  “YY MM DD hh mm ss SUN” are enlarged, 
but the punctuation marks (“:” and “/” for example) are not.  To enlarge punctuat ion 
marks, use the [Change the Setting of a Part Placed] icon.

Not enlarged
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Memo Pad

Clicking the [Memo Pad] icon brings up the following tool bar.

For the setting procedure using the tool bar to be displayed by clicking an icon, 
see page 2-28.  For the description of setting the dialogs, see “Chapter 12 
Memo Pad” in the ZM-71SE Instruction Manual (Function).

Macro and Interval Timer

When the dialog setting is concluded, the dialog icon is shown in the [Part] 
auxiliary tool box in the lower left corner of the screen.  (To bring up the dialog 
again, click the icon.)

(identical to the relay-sub mode tool bar)

Clicking the [Macro Mode] icon brings up the [Macro] dialog.  Clicking the [Interval Timer] 
icon brings up the [Interval Timer] dialog.

For the description of setting the dialogs, see “Chapter 13 Macro” in the ZM-71SE 
Instruction Manual (Function).
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Memory Card

Clicking the [Memory Card Mode] icon brings up the following tool bar.

Animation

Clicking the [Animation] icon brings up the [Animation] dialog.

When the dialog setting is concluded, the dialog icon is shown in 
the [Part] auxiliary tool box in the lower left corner of the screen.  
(To bring up the dialog again, click the icon.)

Display area
Memory card number

Memory card name
Format switch

Memory card file number

Delete
Detail

Quit

Memory card file name

Memory card record name
Memory card record number
Memory card switch

For the sett ing procedure using the tool bar to be displayed by clicking an icon, see page 
2-28.  For the description of setting the dialogs, see “Chapter 25 Memory Card Mode” in 
the ZM-71SE Instruct ion Manual (Funct ion).

For the descript ion of setting the dialog, see “Chapter 17 Animation” in the ZM-71SE 
Instruction Manual (Function).
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Video

Clicking the [Video] icon brings up the following tool bar.

JPEG Display

Clicking the [JPEG Display] icon brings up the following tool bar.

Sound

Clicking the [Sound] icon brings up the [Sound] dialog.

When the dialog setting is concluded, the dialog icon is shown in 
the [Part] auxiliary tool box in the lower left corner of the screen.  
(To bring up the dialog again, click the icon.)

For the setting procedure using the tool bar to be displayed by clicking an icon, see page 
2-28.  For the description of sett ing the dialogs, see “Chapter 18 Video Display” in the 
ZM-71SE Instruction Manual (Function).

For the setting procedure using the tool bar to be displayed by clicking an icon, see page 
2-28.  For the description of sett ing the dialogs, see “Chapter 19 JPEG Display” in the 
ZM-71SE Instruction Manual (Function).

For the description of sett ing the dialogs, see “Chapter 20 Sound Replay” in the ZM-71SE 
Instruction Manual (Function).
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Color Types and Settings

This section explains the color types available with the LCD control terminal 
models and their setting procedure.

Color Types

Available color types differ, depending on the models of ZM series.

Color setting procedure varies with the color types.  Refer to the following pages 
for more information.

Model 32,000-color 128-color 16-color Monochrome (Blinking)

ZM-381SA/382SA − − − 16 colors only
ZM-381S/382S − − − 16 colors only

ZM-371SA/372SA − − − 16 colors only
ZM-371S/372S − − − 16 colors only

ZM-371TA/372TA − − − 16 colors only
ZM-371T/372T − − − 16 colors only

ZM-362SA − − − 16 colors only
ZM-362S − − − 16 colors only

ZM-352D × − − 16 colors only

ZM-82T/82TC/82TV/82TVC × − − 16 colors only

ZM-42TS/72TSC/72TSV/72TSVC × − − 16 colors only

ZM-72T/72TC/72TV/72TVC × − − 16 colors only

ZM-72D × − − 16 colors only

ZM-52D × − − 16 colors only

ZM-42D × × − 16 colors

ZM-42L × × × 8-gradation 8 colors

ZM-43T × × − 16 colors

ZM-43D × × − 16 colors

ZM-43L × × × 8-gradation 8 colors

ZM-42HD × − − 16 colors only

ZM-62E × × × 2 colors 2 colors

: Available ×: Unavailable −: Not applicable
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32,000-color Type

The color pallet shows the basic 16 colors as default.

When selecting a color other than the sixteen, click the far-right button [ ] on 
the pallet.  The following dialog is displayed.

[Pallet 1]
Shows the 128-color pallet for the ZM-52 to 82 series.

[Pallet 2]
Shows the 3D parts color pallet for the ZM-42 to 82 series.

[Pallet 3]
Shows the default color pallet (128-color type only) for the ZM-300 series.

Pallet 1 Pallet 2 Pallet 3
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[Create Color]
Clicking this button brings up the following dialog.

In this dialog, a maximum of 32 colors in addition to the provided three pallets 
can be registered as desired with the steps below.

1. In the dialog displayed by the [Create Color] button, click anywhere within 
the provided color area.  The color of the clicked point appears in the top 
right box.  Repeat clicking or move the scroll bars until the color in the box 
becomes your desired color.

Click around this point. The color of the clicked 
point appears.
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2. When your desired color is shown, click the [Select] button.  The color 
appears in the top left position.

To go back to the previous color pallet, click [OK].

When registering a different color next, select its registration position in the 
pallet by clicking in advance.  If no position is selected, the top left position is 
overwritten by the next color registration.

Notes on Color Creation
• Registered colors as desired (up to 32 colors) are stored in the screen data 

file when the file is saved.  Each time the file is opened, the registered colors 
for the file are displayed.

• In the case of data copy by means of the file management function (Chapter 
7 Useful Techniques) between screen data files containing different 
registered colors, the registered colors in the copy source file is not 
displayed on the color pallet in the target file, but is displayed outside the 
pallet.

Colors in the copy source file that are not registered 
in the copy target file are displayed in the [Prop. 
Change] dialog in the target file.

Not registered in the pallet
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128-color Type

The color pallet shows the basic 16 colors as default.

When selecting a color other than the sixteen, click the far-right button [ ] on 
the pallet.  The following dialog is displayed.

Click the desired color and click [OK].  The line including the clicked color is 
displayed.  The color is marked with [×].
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Monochrome Type

Monochrome display is not available as default.  Select [Display Environment] or 
[Change All Display Environment] from the [Display] menu.  The [Display 
Environment] dialog is displayed.  Open the [Others] tab window.

Check the box of [  Monochrome 8-grade Display] and click [OK].  Now 
monochrome display is valid.

ZM-42/43 ZM-62E

Colors Displayed on the Editor Software and the ZM
In the monochrome type, there may be slight differences between colors shown in 8- or 
2-gradation colors on the editor software and colors displayed on the ZM.  Displayed 
colors will also vary, depending on the option: [Norm.] (default) or [Reversed Image] 
selected for [Display] in the [Backlight] tab window in the [Unit Setting] dialog selected 
from the [System Setting] menu.  Refer to the following table for details.

Model Display place
[System Setting]  →  [Unit Setting]  →  [Backlight] tab window

[Display: Norm.] [Display: Reversed Image]

ZM-42L

Editor

LCD control 
terminal

ZM-43L

Editor

LCD control 
terminal

ZM-62E

Editor

LCD control 
terminal
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Blinking Setting

Colors available for blinking are limited.  For the color display, the basic 16 
colors can be used for blinking.  For the monochrome display, blinking is 
available in 8-graduation or 2-gradation colors.

Blinking Setting Procedure
1. Bring up the color pallet.  The [B] button is placed at the far right of the basic 

16-color or monochrome pallet.

2. Click the [B] button.  It is marked with [×].  Blinking display is now enabled.

Blinking Time Setting
It is possible to change the blinking interval.  Set the items as described below.

1. Select [Unit Setting] from the [System Setting] menu.  The [Unit Setting] 
dialog is displayed.

2. Open the [Blink/Flash] tab window.  Set [OFF Time] and [ON Time].

The specified blinking time is valid as a common setting in the screen data file.  
It is not allowed to specify different times as individual blinking settings.
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Tools
Tools

The tools with the following functions are provided:

Icon Item Contents Ref.

Line Draws straight lines, continuous lines and 
arrows. Page 3-5

Box Draws boxes, parallelograms and polygons. Page 3-7

Circle Draws circles, arcs, sectors,  ellipses, 
elliptical arcs and elliptical sectors. Page 3-12

Text Produces text. Page 3-18

Pattern Places patterns. Page 3-23

Paint Paints the enclosed area. Page 3-26

Graphic call Places graphics registered in the graphic 
library. Page 3-27

Dot Draws dots. Page 3-29

Bar graph scale Draws bar graph scales. Page 3-29

Pie graph scale Draws pie graph scales. Page 3-31

Trend graph scale Draws trend graph scales. Page 3-33

Multi-text Produces text in mult iple lines. Page 3-35

Screen LIB Places a screen LIB mark. Page 3-37
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Basic Operations

Clicking an drawing tool icon brings up the dialog for drawing.  In this section, 
basic operations on the [Screen Drawing] dialog are explained.

[Screen Drawing] Dialog

For example, when you click the [Line] icon, the following [Screen Drawing] 
dialog is displayed.

Erasing the Dialog
The “draw” mode is in effect while the dialog is on the screen.  The mouse turns 
a cross-shaped cursor.  To cancel the draw mode, erase the [Screen Drawing] 
dialog.  To erase the [Screen Drawing] dialog, click the [Select] icon in the icon 
bar or click the [Close] button on the [Screen Drawing] dialog.

or

If you drag the cursor over the dialog during drawing, the dialog is temporarily 
erased and is displayed on completion of mouse dragging.
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Moving the Dialog
Dragging the title of the [Screen Drawing] dialog moves the dialog to the desired 
position.

Selecting Colors

The procedure of color selection is the same as that used for parts.  For more 
information, see “Chapter 2 Screens.”

Selecting Tiles

Tiles can be selected when painting boxes or circles.

A maximum of 16 tiles can be used.  Eight tiles are registered as default.  You 
can register additional eight tiles as required.  For the procedure of registering 
user-defined tiles, see “Chapter 4 Registration Items.”

When tile No. 0 is selected, the area is painted in the color set for [Foreground].  
When a tile other than No. 0 is selected, the area is painted in the colors set for 
[Foreground] and [Background].

Drag around here.

No. 0 Foreground 
color

No. 3
Foreground color

Background color
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Selecting Line Styles

Line styles can be selected for lines, boxes and circles.  There are six line styles 
available.

Limitations on Line Styles
• Line No. 1 (thick line) cannot be used for the following items.

Continuous lines, chamfered boxes, parallelograms, polygons, circles (of all 
kinds)

• Chamfered boxes can only be drawn with solid lines.

No. 0 Solid line

No. 1 Thick line

No. 2 Dotted line

No. 3 Chain line

No. 4 Dashed line

No. 5 Two-dot chain line

No. 0 No. 1 No. 2 No. 3 No. 4 No. 5
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Drawing Methods

Drawing methods of items are explained.

Line

Clicking the [Line] icon brings up the [Screen Drawing] dialog shown below.

Single Line
1. Click the [Single Line] icon in the [Screen Drawing] dialog.  Select the 

desired options for [Color] and [Line Style] as well as the arrow type.

Straight lines can be equipped with arrowheads.  Available arrow types are 
shown below.

No arrow Arrow at 
start point

Arrow at 
end point

Arrow at both ends
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2. Drag the mouse from the start point to the end point.  A line is drawn.

Continuous Line
1. Click the [Continuous Line] icon in the [Screen Drawing] dialog.  Select the 

desired options for [Color] and [Line Style].

2. Click at the start point.  Then click at the first point.  The first line is drawn.

3. In the same manner, move the mouse to the desired point and click.

Start point End point
Drag

When you drag the mouse while holding down the SHIFT key, it is possible to 
draw a horizontal (or vertical) line.

Start point First point
Click.

Start point First point

Click. Second point

To erase the line you have drawn, click the right mouse button.
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4. At the end point, double-click the mouse button.  The continuous line is 
terminated.

Box

Clicking the [Box] icon brings up the [Screen Drawing] dialog shown below.

Rectangle
1. Click the [Rectangle] icon in the [Screen Drawing] dialog.  Select the desired 

options for [  Paint], [Foreground], [Background], [Tile] and [Line Type].

Start  point
First point

Click.

Second point

Third point

Double-click.
End point

When [  Paint] is checked, [  Frame] becomes active.  It is possible to select 
whether or not to draw the frame of the painted box.  When this option is 
checked, [Frame Color] can be selected.

[  Paint] [  Paint]
[  Frame]

[  Paint]
[  Frame]
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2. A rectangle is drawn when dragging from the start point to the end point.

Chamfered Box

Only for rectangles, “chamfered box” can be selected.  [Round Chamfering] or 
[Chamfering] can be selected and [Radius] (in dots) should be specified.

Select either [Round Chamfering] or [Chamfering] before drawing the rectangle.

Start point

End point

Drag
End point

Start point

Drag

A rectangle can be drawn from any corner.

No 
Chamfering

Round 
Chamfering

Chamfering

Radius Radius

When a chamfered box is selected, line type selection is not possible.  All the 
lines are drawn in solid lines.  When [Chamfering] is selected, [  Frame] 
becomes active.  However, when [Round Chamfering] is selected, it is 
automatically framed and the frame setting is not possible.

When [  Paint] is checked for a round-chamfered box, XOR cannot be used.  
(For example, if a round-chamfered box with [  Paint] is brought up in 
graphic-relay mode, the paint is not displayed on the screen.)  For more 
information on XOR effects, see “Chapter 9 Graphic Display” in the ZM-71SE 
Instruction Manual (Function).
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Parallelogram
1. Click the [Parallelogram] icon in the [Screen Drawing] dialog.  Select the 

desired options for [  Paint], [Foreground], [Background], [Tile] and [Line 
Type].

2. Drag the mouse from the start point to the end point of the upper side.

3. Drag from the end point of the upper side to the corresponding point of the 
lower side.

4. Clicking draws the parallelogram.

When [  Paint] is checked, [  Frame] becomes active.  It is possible to select 
whether or not to draw the frame of the painted box.  When this option is 
checked, [Frame Color] can be selected.

[ Paint] [  Paint]
[  Frame]

[  Paint]
[  Frame]

Start point End point
Drag

Drag
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Polygon
1. Click the [Polygon] icon in the [Screen Drawing] dialog.  The following dialog 

is displayed.

Select the draw type.

Select the desired options for [Polygon], [  Paint], [  Frame], [Foreground], 
[Background], [Frame Color], [Tile] and [Line Type].

2. Drag from the start point to the end point.  The specified polygon is drawn.

Drag from the center to a 
corner.

Drag from the start point to 
the end point of one side.

:  Start point
:  End point
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[  Special Edit ]
This opt ion cannot be selected as default.   When a polygon has been placed, 
double-click it , or click it and then click the [Detail/Prop. Change] icon.  The [Prop. 
Change] dialog is displayed.  [  Special Edit] becomes active then.

When [  Special Edit]  is unchecked (ex. regular pentagon)
The [Prop. Change] dialog is set as the following:

By clicking the pentagon, handles are shown around it.

Only enlarging or reducing is executable for the polygons.

When [  Special Edit]  is checked (ex. regular pentagon)
The [Prop. Change] dialog is set as the following:

By clicking the pentagon, handles are shown at its corners.

When the drawing method icon on the right is clicked, dragging one handle allows the 
pentagon to rotate.  At this time, the corner on the right of the dragged handle becomes 
the base for rotation.

Drag this.
Rotating is possible.
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Circle

Clicking the [Circle] icon brings up the [Screen Drawing] dialog shown below.

Circle
1. Click the [Circle] icon in the [Screen Drawing] dialog.  Select the draw type.

Select the desired options for [  Paint], [  Frame], [Foreground], 
[Background], [Frame Color], [Tile] and [Line Type].

2. Drag from the start point to the end point.  A circle is drawn.

Drag from the center for the radius.

 : Start point
 : End point

Drag from one side to the other for the diameter.

 : Start point
 : End point

Drag from the start point  to the end point of the box where an inscribed circle 
is drawn.

 : Start point
 : End point
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Arc and Sector
Click the [Arc] or [Sector] icon in the [Screen Drawing] dialog.  The following 
dialog is displayed.

Select the draw type.

Drawing from the Center

1. Select the left icon for the draw type.

2. Select the desired options for [Foreground] and [Line Type].  For sectors, 
select the desired options for [  Paint], [  Frame], [Background], [Frame 
Color] and [Tile].

3. Drag from the center to the desired radius.

4. When you stop dragging, a line is displayed.  Click the mouse at the start 
point of the arc or sector.

 : Start point
 : End point
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5. Move the cursor along the arc to the end point of the arc.  The section drawn 
counter-clockwise remains as an arc.

6. Clicking the mouse draws the arc or sector.

Drawing from the Line End Position

1. Select the right icon for the draw type.

2. Select the desired options for [Foreground] and [Line Type].  For sectors, 
select the desired options for [  Paint], [  Frame], [Background], [Frame 
Color] and [Tile].

3. Drag the mouse from the start point to the end point.

4. When the mouse is released, the arc or sector is displayed.

5. Clicking the mouse to the desired position draws the arc or sector.

 : Start point
 : End point

Clockwise

Counter-clockwise

 : Start point
 : End point
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Ellipse
1. Click the [Ellipse] icon in the [Screen Drawing] dialog.  The following dialog is 

displayed.

Select the draw type.

Select the desired options for [  Paint], [  Frame], [Foreground], 
[Background], [Frame Color], [Tile] and [Line Type].

2. Drag from the start point to the end point.  An ellipse is drawn.

Elliptical Arc and Elliptical Sector
Click the [Elliptical Arc] or [Elliptical Sector] icon in the [Screen Drawing] dialog.  
The following dialog is displayed.

Select the draw type.

Drag from the start point  to the 
end point of the box where an 
inscribed ellipse is drawn.

 : Start point
 : End point

Drag from the center for 
the major radius.
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Drawing from the Diagonal Line

1. Select the left icon for the draw type.

2. Select the desired options for [Foreground] and [Line Type].

3. Drag from the start point until the desired circle or ellipse is drawn.

4. When you stop dragging, a line is displayed.  Click the mouse at the start 
point of the elliptical arc or sector.

5. Move the cursor clockwise (portion to be erased) or counter-clockwise 
(portion to be drawn) along the elliptical arc or sector, and click on the end 
point.

6. Clicking the mouse draws the elliptical arc or sector.

 : Start point
 : End point

Clockwise

Counter-clockwise
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Drawing from the Center

1. Select the right icon for the draw type.

2. Select the desired options for [Foreground] and [Line Type].

3. Drag from the center to the desired radius.

4. When you stop dragging, a line is displayed.  Click the mouse at the start 
point of the elliptical arc or sector.

5. Move the cursor clockwise (portion to be erased) or counter-clockwise 
(portion to be drawn) along the elliptical arc or sector, and click on the end 
point.

6. Clicking the mouse draws the elliptical arc or sector.

 : Start point
 : End point

Clockwise

Counter-clockwise
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Text

Clicking the [Text] icon brings up the [Screen Drawing] dialog shown below.

Text Field
Text can be entered when the cursor is flashing in the text field.  If the cursor is 
not flashing in the text field, click the mouse on the text field.

Number of Characters Available

The maximum permissible number of characters per line depends on the 
number of displayed dots.

Text Entry

Check that the cursor is flashing in the text field, and enter characters using the 
keyboard.

No. of  displayed dots Max. number of characters (1-byte)
800 × 600 100

640 × 480 80
320 × 240 40

If you would like to enter two-byte characters, switch IME of your computer and 
operate as appropriate.
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Selecting Colors
Foreground and background colors can be set.  For the color setting procedure, 
see “Chapter 2 Screens.”

Text Properties
[Enlarge X] [Enlarge Y]

This option is valid when the screen data contains fonts except the Gothic, 
English/Western Europe (HK Gothic), or English/Western Europe (HK 
Times) font data.  The setting range for [Enlarge] is “1” to “8.”  The character 
size at each value for [Enlarge] is shown below.

[Rotate]
Depending on the selected option, the text can be rotated as shown below.

[Direction]
Depending on the selected option, the text can be directed as shown below.

Value for 
[Enlarge] 1 2 3 4 5 6 7 8

1-byte
(W × H dots) 8 × 16 16 × 32 24 × 48 32 × 64 40 × 80 48 × 96 56 × 112 64 × 128

2-byte
(W × H dots) 16 × 16 32 × 32 48 × 48 64 × 64 80 × 80 96 × 96 112 × 112 128 × 128

For the Gothic, English/Western Europe (HK Gothic) and English/Western Europe (HK 
Times) font types, this option changes to [Point].   For more information, see “Appendix 1 
Fonts.”

Rotate Text

Normal ABCD

Left  90

180

R90

Direct ion RGT DW LFT UP

Text ABCD

A
B
C
D

DCBA

D
C
B
A

A B C D

ABCD

DCBA
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[ Transparent]
Depending on whether [  Transparent] or [  Transparent] is selected, the 
foreground and background colors are displayed differently.

[ Italic]
When [  Italic] is checked, the text is italicized.

[Normal] [1/4] [Bold] [Shadow]
The text is displayed as shown below.

Normal

1/4

Bold

Shadow

ABCD ABCD

Foreground color

Background color

Foreground color only
[ Transparent] [ Transparent]

ABCD ABCD

[  Italic] [  Italic]

ABCD
ABCD

ABCDABCD
ABCDABCD

Foreground color
Background color

[1/4] is valid only for 1-byte characters.  [Bold] is valid only when “1” is set for 
[Enlarge X].
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[Text File]
It is possible to import data in a text file.  Follow the procedure below.

1. Click the [Text File] button in the [Text] tab window.  The [Open] dialog is 
displayed.

2. Choose the desired text file and click [Open].  The [Text Read] dialog is 
displayed.  Here you can confirm the text in the text file.  

3. If the text that is displayed is not necessary, click on the pull-down menu.  
The following lines of text can be reviewed this way so that you can search 
for the necessary text.
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4. Once you have selected the text to import, click [OK].  Text is imported into 
the text field in the [Text] tab window.

Placing Text
1. Enter the desired text in the text field and set text properties, enlargement, 

etc.

2. Dragging the mouse on the screen draws a dotted frame of the same size as 
the text to be placed.

3. Release the mouse being dragged in the desired position.  The text is shown 
in the position.

Only one line of text can be imported.  A paragraph delimited with a return (a line 
break) in the text file is regarded as one text on the editor.

Drag

ABCD
Release the mouse.

Text is shown in the released position.

Clicking or dragging the mouse again places the same text on the screen.  To 
cancel text placement, close the [Screen Drawing] dialog or click the [Select] 
icon.
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Pattern

This command is used when placing a pattern registered in the pattern edit area 
on the screen.

Clicking the [Pattern] icon brings up the following pattern list window.

Placing Patterns
1. In the [Pattern List] window, click the desired pattern.

For pattern registration and pattern edit area, see “Chapter 4 Registrat ion I tems.”

To call the pattern, click the [JUMP] button.
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2. Click [Place].  A dotted line box as large as a pattern is displayed with the 
cursor.

3. Click the mouse in the desired position.  The pattern is placed.

Placing Multiple Patterns Continuously
This is useful when placing split-registered patterns in alignment.

1. In the [Pattern List] window, click the [M. Place] button.  The [Multiple 
Pattern] dialog shown below is displayed.  The following options are included 
in the dialog.

[Start No.]
Specify the top pattern number to be placed.

[Q’ty X/Y]
Specify the quantity of patterns along the X axis and the Y axis.

[Direction RGT/BTM] 
Choose either direction of aligning patterns in multi-placement.

[No. INC]
Check this box ([  No. INC]) when placing patterns increasing the 
number by one.  When this is not checked ([  No. INC]), the same 
patterns are copied for multi-placement.

Clicking the mouse again places the same pattern on the screen.  To cancel 
pattern placement, click the [Select] icon.
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2. Click [OK].  A dotted line box as large as the pattern is displayed with the 
cursor.

3. Click the mouse in the desired position.  Multiple patterns are placed in 
alignment.

Pattern No. 5

Pattern No. 6

Pattern No. 7

Pattern No. 8

Clicking the mouse again places the same pattern on the screen.  To cancel 
pattern placement, click the [Select] icon.
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Paint

An enclosed area can be painted.  Clicking the [Paint] icon brings up the [Screen 
Drawing] dialog shown below.

[  Boundary Color for Foreground]
Select the boundary color to be used when painting.

When [  Boundary Color for Foreground] is checked, the enclosed area is 
painted in the same color as the one selected for [Foreground].

When [  Boundary Color for Foreground] is not checked, the enclosed area 
can be painted in a color different from the one selected for [Foreground].

Ex.: If you draw an elliptical sector on the line and paint the enclosed area, it is 
painted as shown below.

Painting is possible in the same color as the boundary color.

Painting is possible even if the foreground color is different from the boundary color.

Paint the graphic drawn as below.

1. Line (red)

2. Ellipt ical 
sector (green)

In the [Paint] tab window:
[  Boundary Color for Foreground]
[Foreground: Green]

In the [Paint] tab window:
[  Boundary Color for Foreground]
[Foreground: Green]

Painted area

(Paint color (green) runs through red 
area, and stops at the green area.)

(Paint color (green) stops 
at the red (or green) area.)
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Graphic Call

This command is used when placing a graphic registered in the graphic library 
on the screen.

Clicking the [Graphic Call] icon brings up the [Graphic Library List] window.

Placing Graphics
1. In the [Graphic Library List] window, click the desired graphic.

To cancel the paint or to check the painted area, select [Display Environment] 
from the [Display] menu, and remove the check mark from [  Paint Dsp.].  

For graphic registrat ion and graphic library, see “Chapter 4 Registration Items.”

To call the graphic, click the [JUMP] button.
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2. Click [Place].  A dotted line box is displayed with the cursor.

3. Click the mouse in the desired position.  The graphic is placed with the 
[GLIB] mark at the clicked position.

GLIB

Immediately after placement, the [LIB] mark is attached to the cursor.  Clicking 
the mouse again places the same graphic on the screen as long as the [LIB] 
mark is displayed.  To cancel graphic placement, click the [Select] icon.  The 
[LIB] mark disappears.

The reference position of placing a graphic is the “offset” position on the 
graphic library.  For more information on the “offset,” see “Chapter 4 
Registration Items.”

GLIB

OFF

“GLIB” position on the screen “OFF” position in the graphic library=

To call a graphic that is called with the graphic call command using another 
graphic call command (nesting), a maximum of eight nests is possible.
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Dot

Clicking the [Dot] icon brings up the [Screen Drawing] dialog shown below.

[Color]
For color selection, see “Chapter 2 Screens.”

[Pen]
Select the dot size.

Clicking the mouse on the screen draws a dot of the selected size in the 
selected color.

Bar Graph Scale

Clicking the [Bar Graph Scale] icon brings up the [Screen Drawing] dialog shown 
below.

[Length] (1 - 16)
Set the length of short gradation marks.  Enter the numerical value in the 
data field, or set the desired value using the Up/Down button.

Clicking the mouse again draws the same dot on the screen.  To cancel dot 
drawing, close the [Screen Drawing] dialog or click the [Select] icon.
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[  Line]
When this box is checked ( ), the scale is drawn with lines.  When this box 
is not checked ( ), the scale is drawn without lines.

[Split No.] (1 - 255)
Set the number of divisions of the scale.  Enter the numerical value in the 
data field, or set the desired value using the Up/Down button.

[  Long Line]
When this box is checked ( ), long gradation marks are attached to the 
scale at the specified pitch.  When this box is not checked ( ), long 
gradation marks are not attached.

[Pitch] (1 - 16)
This option is active when [  Long Line] is checked.  Set the pitch for long 
gradation marks.  Enter the numerical value in the data field, or set the 
desired value using the Up/Down button.

Drawing Method
1. Select the desired style from the [Shape] icons.

2. Make the required setting on the dialog beforehand.

3. Drag the mouse from the start point to the end point.  The bar graph scale is 
drawn.

Shape No. 0

[  Line]

[  Long Line]

Pitch

Long gradation mark

Line

Short gradation mark
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Pie Graph Scale

Clicking the [Pie Graph Scale] icon brings up the [Screen Drawing] dialog shown 
below.

[Length] (1 - 16)
Set the length of short gradation marks.  Enter the numerical value in the 
data field, or set the desired value using the Up/Down button.

[  Complete Round Circle]
This option is not active as default.  This option becomes active once a pie 
graph scale has been drawn.  Double-click the pie graph scale or click the 
pie graph scale and click the [Prop. Change] icon.  When [  Complete 
Round Circle] becomes active, check the box.

[  Line]
When this box is checked ( ), the scale is drawn with lines.  When this box 
is not checked ( ), the scale is drawn without lines.

[Split No.] (1 - 255)
Set the number of divisions of the scale.  Enter the numerical value in the 
data field, or set the desired value using the Up/Down button.

[  Long Line]
When this box is checked ( ), long gradation marks are attached to the 
scale at the specified pitch.  When this box is not checked ( ), long 
gradation marks are not attached.

[Pitch] (1 - 16)
This option becomes active when [  Long Line] is checked.  Set the pitch for 
long gradation marks.  Enter the numerical value in the data field, or set the 
desired value using the Up/Down button.

Pitch

Long gradation mark

Short  gradation mark

Line
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Drawing Method
Depending on the selected draw type, the drawing method varies.

Drawing from the Center

1. Select the left icon for the draw type.

2. Make the required setting on the dialog beforehand.

3. Drag from the center to the desired radius.

4. When you stop dragging, a line is displayed.  Click the mouse at the start 
point of the arc.

5. Move the cursor clockwise (portion to be erased) or counter-clockwise 
(portion to be drawn) along the arc, and click on the end point.

6. Clicking the mouse draws the pie graph scale.

 : Start point
 : End point

Clockwise

Counter-clockwise
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Drawing from the Line End Position

1. Select the right icon for the draw type.

2. Make the required setting on the dialog beforehand.

3. Drag the mouse from the start point to the end point.

4. When the mouse is released, the arc is displayed.

5. Clicking the mouse to the desired position draws the arc.

Trend Graph Scale

Clicking the [Trend Graph Scale] icon brings up the [Screen Drawing] dialog 
shown below.

[Length] (1 - 16)
Set the length of short gradation marks.  Enter the numerical value in the 
data field, or set the desired value using the Up/Down button.  This setting is 
used for both X and Y axes.

[  Line]
When this box is checked ( ), the scale is drawn with lines.  When this box 
is not checked ( ), the scale is drawn without lines.

 : Start point
 : End point
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[Split No.] (1 - 255)
Set the number of divisions of the scale.  Enter the numerical value in the 
data field, or set the desired value using the Up/Down button.  Separate 
settings for the X and Y axes are required.

[  Long Line]
When this box is checked ( ), long gradation marks are attached to the 
scale at the specified pitch.  When this box is not checked ( ), long 
gradation marks are not attached.

[Pitch] (1 - 16)
[This option becomes active when [  Long Line] is checked.  Set the pitch 
for long gradation marks.  Enter the numerical value in the data field, or set 
the desired value using the Up/Down button.  Separate settings for the X and 
Y axes are required.

Drawing Method
1. Select the desired style from the [Shape] icons.

2. Make the required setting on the dialog beforehand.

3. Drag the mouse from the start point to the end point in the same way as 
drawing a rectangle.  The trend graph scale is drawn.

Pitch

Y axis (vert ical axis)

Line

Long gradat ion mark Short gradation mark

X axis (horizontal)

Start point End point

End point Start point

Drag Drag
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Multi-text

This command is used when placing multiple lines of text at one time.  Clicking 
the [Multi-Text] icon brings up the [Screen Drawing] dialog shown below.

Text Field
Text can be entered when the cursor is flashing in the text field.  If the cursor is 
not flashing in the text field, click the mouse on the text field.

Number of Characters Available

The maximum permissible number of characters per line depends on the 
number of displayed dots.

Text Entry

Check that the cursor is flashing in the text field, and enter characters using the 
keyboard.

No. of displayed dots
Maximum (1-byte)

Characters Lines

800 × 600 100 30

640 × 480 80 24

320 × 240 40 12

The above figures are based on the line spacing of “4.”

To enter multiple lines, press the return key on the keyboard and insert a hard 
return.
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Selecting Colors
Foreground and background colors can be set.  For the color setting procedure, 
see “Chapter 2 Screens.”

Text Properties
Click the [Char. Prop.] button.  The [Char. Prop.] dialog is displayed.

For other setting items not described below, see page 3-19.

[Left]/ [Center]/ [Right]
Select text alignment.

[Pitch] (0 - 32)
Specify the desired line spacing.  The maximum available number varies 
depending on this setting.

Placing Multi-text
Multi-text can be placed in the same manner as ordinary text.  For more 
information, see page 3-22.
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Screen LIB

This command is used when placing a screen registered in the screen library.

Clicking the [Screen LIB] icon brings up the dialog shown below.

Placing Screen Library Element
1. In the [Screen Library List] window, click the desired screen.

For more information on screen library, see “Chapter 4 Registrat ion Items.”

To call the screen, click the [JUMP] button.
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2. Click [Place].  A dotted line box is displayed with the cursor.

3. Click the mouse in the desired position.  The screen is placed with the [SLIB] 
mark at the clicked position.

SLIB

Immediately after placement, the [LIB] mark is attached to the cursor.  Clicking 
the mouse again places the same screen as long as the [LIB] mark is displayed.  
To cancel screen placement, click the [Select] icon.  The [LIB] mark disappears.

The reference position of placing a screen is the “offset” position on the screen 
library.  For more information on the “offset,” see “Chapter 4 Registration 
Items.”

OFF

SLIB

SLIB position on the screen “OFF” position in screen library=
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Outline of Registration Items

ZM series screen data files consist of areas called screens.  Parts and graphics 
can be placed on screens.  Meanwhile, data items or graphics, the contents of 
which will vary according to circumstances, cannot be placed on screens.  Thus, 
these items are registered in different areas.

These areas are called registration items.  When editing these items, start from 
selection from the [Item] menu.

Memory error
Power supply error
Cyli nder error
Cycle ti me-over
Timeout
Tank error
Data mismatch
Communi cation fai lure

Parts such as switches or lamps that permanently exist  on a screen 
are placed directly on the screen.

Items that will vary according to the circumstances 
are registered in different areas.

Screen

Message

Graphic library

Pattern
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Contents of Registration Items

The following table indicates the contents of the registration items and their 
uses.

Registration Item Uses Ref.

Screen − Page 4-3

Graphic library Used for graphic call (drawing tool), graphic mode, 
graphic relay mode (parts), etc. Page 4-4

Multi-overlap Used for multi-overlaps (parts) Page 4-20

Data block Used for data block areas (parts) Page 4-25

Message Used for relay mode, message mode, bit  sampling, 
alarm displays (parts) Page 4-28

Pattern Used for patterns (drawing tool) Page 4-37

Macro block Used by CALL commands in macro programs or 
macro mode (parts) Page 4-55

Page block Used for relay-sub mode or message mode (parts) Page 4-61

Direct block Used for relay-sub mode or message mode (parts) Page 4-65

Screen block Used for relay mode (parts) Page 4-69

Tile Used for drawing Page 4-72

Data sheet Used for data sheets Page 4-75

Screen library Used for screens and overlaps Page 4-80

Multi-language Used for changing the language used on the screen Page 4-84

Animation Used for animation (only for the ZM-300 series 
except for ZM-352D) Page 4-85
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Screen

A screen is an editing window to be opened at start-up of the editor software.

Calling a Screen

To go to a different screen from the current screen or while a different 
registration item window is opened, select [Screen] from the [Item] menu.

The [Screen] dialog is displayed.  Specify the screen number to be opened and 
click [OK].

Screen Editing

Refer to each individual chapter in this manual for editing a screen.  For limitations on 
screen editing such as a limited number of parts, see “Chapter 2 Screens.”
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Graphic Library

Graphics or numerical data displays that will be displayed by bit setting (ON) are 
registered in the graphic library.

Graphic Library Structure

A graphic library screen and a screen are the same in size.  A total of 2,560 
graphic library screens are divided into 10 groups for registration.  Therefore, 
one graphic library group is capable of storing 256 screens.

Calling the Graphic Library

1. Select [Graphic Library] from the [Item] menu.  The [Graphic Library] dialog 
is displayed.

2. Specify the graphic library group number to be opened and the desired 
graphic number.

3. Click [OK].

Group No. 0 Group No. 1 Group No. 2 Group No. 9
Gr aphic No.  0

Grap hic No. 1

Grap hic No. 2

Graph ic No. 253

Grap hic No. 25 4

Gr aphic No.  255

Graph ic No. 0

Gr aphic No.  1

Gr aphic No.  2

Gra phic No. 2 53

Gr aphic No. 254

Graph ic No. 255

Grap hic No. 0

Gr aphic No . 1

Gr aphic No . 2

Gr aphic No. 253

Gr aphic No.  254

Grap hic No. 25 5

Gr aphic No. 0

Grap hic No. 1

Grap hic No. 2

G raph ic No . 253

Graph ic No. 254

Gr aphic No . 255
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Graphic Library Editing

Use this drawing tool bar for graphic library.

Except for the points below, the editing procedure using the drawing tool bar is 
the same as the procedure for screens.

Offset Position Setting
Outline of Offset Position

Every graphic library screen in the graphic library has a reference position called 
an offset.  When a registered graphic is called to the screen, it is placed based 
on the offset position.  The offset position in the graphic library is equivalent to 
the graphic call (GLIB) position in drawing as well as the top left corner in a 
display area.

An offset position in the graphic library is shown with an “OFF” mark.

Only graphics can be registered in the graphic library (parts cannot be 
registered).

For more information, see “Chapter 3 Drawing Tools.”

GLIB

OFF

Ex.:  
Placement by [Graphic Call]  on the drawing tool bar Offset position in the graphic library=
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Changing an Offset Position

Every graphic library screen in the graphic library has an offset position at 
coordinates X, Y (0, 0) as default.  To change the position, follow the procedure 
below.

1. Click the [Offset] icon on the drawing tool bar.

2. A cross cursor marked with “OFF” appears.

3. Click the mouse in the desired position.  The offset mark is displayed at that 
location.

Parameter Setting
Outline of Parameter

Graphics registered in the graphic library may be moved or transformed on the 
screen.  If data displays (to be explained later) are registered, they also may be 
moved, transformed, or changed in displayed value.  These graphics or data 
displays require memory, and consequently require parameter setting for 
memory allocation.

OFF

Click The “OFF” mark is displayed.

Changing the offset position prior to registering a graphic is not valid.  Set an 
offset position after registering a graphic.

Setting parameters only in the graphic library is not sufficient for moving, 
transforming, or changing graphics.  Make sure to set parameters for each part 
on the screen.
4-6



Chapter 4  Registration Items

4

G
raphic Library
Parameter Setting Procedure

1. Click on a graphic in the graphic library to select it.

2. Click the [Parameter] icon on the drawing tool bar.  The [Parameter Setting] 
dialog is displayed.

For the description of setting the dialog, refer to the following.

3. When the dialog setting is concluded, click [OK].

The options in the [Parameter Setting] dialog vary with the selected graphic.  For 
more information, see page 4-12.
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[Parameter Setting] Dialog

[Action]
When moving, transforming, or changing graphics, the new one is placed 
over the previous one, or the previous one is cleared before the new one is 
placed on the screen.  Select either manner.

[Replace]
The new graphic is placed over the previous one.  Therefore, the 
previous one remains on the screen.

[Animate]
Only the new graphic is placed on the screen.

When you go to a setting item and click its [Set] button, the [Parameter] 
dialog is displayed.

[No Setting]
No memory is allocated.
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[Absolute Input]
When changing a graphic, specify the value for change in absolute 
coordinates.

• Specifying coordinates:
With respect to coordinates (0, 0) at the top left corner of the screen and 
(639, 479) at the bottom right corner (or (319, 239) or (799, 599)), specify 
the coordinates for moving a graphic in memory.

• Specifying a number: (Valid for patterns and graphic call)
Specify a registered pattern number or a graphic number in the graphic 
library directly.

[0, 0]

[639, 479]

[300, 200]

When (300, 200) is specified under [Absolute Input] , 
the graphic is moved to the posit ion below.

No. 3 No. 4 No. 5 No. 6 No. 7 No. 8

When “3” is specified under 
[Absolute Input], pattern 
No. 3 is displayed.

Pattern
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[Incremental + Input]
When changing a graphic, specify incremental coordinates in the plus 
direction.

• Specifying coordinates:
Based on a graphic position regarded as (0, 0), specifying a positive 
coordinate value in memory moves it in the plus direction and specifying 
a negative coordinate value moves it in the minus direction.

• Specifying a number: (Valid for patterns and graphic call)
Based on a placed pattern or graphic number regarded as “0,” specifying 
a positive value in memory calls a pattern or a graphic of a greater 
number, and specifying a negative value calls a pattern or a graphic of a 
smaller number.

300

200

When (300, 200) is specified under 
[Incremental + Input],  the graphic is moved 
as shown below from the initial posit ion.

Initial position

Plus direction

Pl
us

 d
ire

ct
io

n

No. 3 No. 4 No. 5 No. 6 No. 7 No. 8

+3

Pattern

When “3” is specified under 
[Incremental + Input] with 
pattern No. 3 placed on the 
screen, pattern No. 6 is 
called.
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[Incremental − Input]
When changing a graphic, specify incremental coordinates in the minus 
direction.

• Specifying coordinates:
Based on a placed graphic position regarded as (0, 0), specifying a 
positive coordinate value in memory moves it in the minus direction and 
specifying a negative coordinate value moves it in the plus direction.

• Specifying a number: (Valid for patterns and graphic call)
Based on a placed pattern or graphic number regarded as “0,” specifying 
a positive value calls a pattern or a graphic of a smaller number, and 
specifying a negative value calls a pattern or a graphic of a greater 
number.

[No.]
Enter a number in this parameter field when [Absolute Input], [Incremental + 
Input], or [Incremental − Input] is selected.  This number designates the 
order of the allocated memory address.

200

200

When (200, 200) is specified under 
[Incremental − Input], the graphic is moved 
as shown below from the init ial position.

Initial posit ion

Minus direction

M
in

us
 d

ire
ct

io
n

No. 3 No. 4 No. 5 No. 6 No. 7 No. 8

−3

Pattern

When “3” is specified under 
[ Incremental − Input] with 
pattern No. 8 placed on the 
screen, pattern No. 5 is 
called.
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Parameter Setting Items

The following table indicates parameter items valid for each graphic.

*1 Paint is not depicted normally when [Action: Animate] is selected in the [Parameter 
Setting] dialog.

*2 For information on data display parameters, see page 4-16.

1. Continuous line (points 0 - n coordinates)
When continuous lines are drawn like this, parameters can be set for seven 
points.

Graphic Parameters Ref.

Line Start point,  end point

Cont inuous line Point 0 (- n) coordinates 1

Box Start point,  end point

Parallelogram Start point,  PX2, PY2, PX3, PY3 2

Polygon Center coordinates, radius, start  angle, number of angles

Circle Center coordinates, radius

Arc/sector Center coordinates, radius, start  angle, end angle

Ellipse, elliptical arc, 
elliptical sector

Center coordinates, X radius, Y radius

Text Start point (coordinates of the first character:  bottom left)

Pattern Start point (top left coordinates),  pattern number 3

Paint Start point 4*1

Graphic call Start point,  library number

Dot Start point

Data display Start point (bottom left  coordinates of the first numeral) *2

0

1

2

3

4

5

6
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2. Parallelogram

3. Pattern

• Start point
The top left corner of the pattern becomes the start point.

• (Pattern) No.
When a parameter for pattern number has been set, commanding the 
pattern number brings up the corresponding graphic.

• PX2

• PY2

• PX3

• PY3

Parameter No. 1

Parameter No. 2

Wine Beer Soda Water Vodka

No. 0 No. 1 No. 2 No. 3 No. 4

Wine

No. 0

Soda

No. 2

Water

No. 3PatternPattern
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4. Paint (start point)
The start point coordinates can be changed by a command from memory 
specified with a parameter.  In this case, only REP is available; therefore, the 
previous paint (ex.: circle) remains.

Data Display
Outline of Data Display in Graphic Library

In the graphic library, it is possible to use a function similar to data display parts 
as used on the screen.  The usage is as follows:

• Showing/deleting a data display through bit setting (ON)/resetting (OFF)

• Moving a data display on the screen

3426

Bit  OFF Bit  ON

34263426 6243
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Data Display Setting Procedure

1. Go to the drawing tool bar and click the [Data Display] icon.  The [Graphic 
Library Drawing] dialog is displayed.

2. When the dialog setting is concluded, drag the mouse on the screen.  A 
dotted line box as large as the data display is displayed with a cross cursor.

3. Release the mouse being dragged in the desired position.  The data display 
is shown in the position.

For the descript ion of the [Data (Main)] tab window, see the following page.  For the [Data 
(Char. Prop)] tab window, see page 4-16.

Drag

1234
Release the mouse.

Data display is shown in the released position.
4-15



Chapter 4  Registration Items
[Data (Main)] Tab Window

Parameter Setting for Data Display

Two kinds of parameters are provided for data display.

• For value change
Specify a value for [Parameter].  This number designates the order of 
memory address allocated for value change on the data display.

• For movement
Click a data display placed in the graphic library.  Click the [Parameter] icon 
on the drawing tool bar.  The [Parameter Setting] dialog is displayed.  Make 
necessary settings in the dialog.
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[Data (Char. Prop.)] Tab Window

The contents of the window are the same as for the data display on screens.

Graphic Library Environment Setting

Environment setting for the graphic library is also started from [Display 
Environment] in the [Display] menu, as performed for screen editing.  Therefore, 
this section explains the settings that are different from those in screen editing.

Base Screen Display
While editing a graphic in the graphic library, a screen or multi-overlap can be 
placed behind the graphic to check the actual image.

OFF

OFF

Only a graphic Graphic displayed on a base

An offset position can be changed 
with ease.

Monitor Screen
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1. Select [Display Environment] from the [Display] menu.  The [Display 
Environment] dialog is displayed.

2. Check [  Base Screen Dsp.].  Selection from [Screen] and [Multi-Overlap 
LIB] is made possible.

3. Select either one and specify the desired number.

4. Click [OK].  The selected screen is placed behind the graphic.

If no screen is displayed, select [Redraw] from the [Display] menu or press the 
Home key on the keyboard.
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Background Color Setting
It is possible to change the background color in the graphic library.

1. Select [Display Environment] from the [Display] menu.  The [Display 
Environment] dialog is displayed.

2. Open the [Menu Dsp.] tab window.

3. Select the desired background color and click [OK].  The graphic is shown on 
the background colored as specified.

When the graphic library is called, its background setting is ignored and thus 
only the registered graphic is recognized as a target.
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Multi-overlap

Overlaps are registered in multi-overlaps.

Multi-overlap Structure

A maximum of 1,024 multi-overlaps can be registered.  One multi-overlap is 
registered per editing window.

Calling a Multi-overlap

1. Select [Multi-Overlap] from the [Item] menu.  The [Multi-Overlap] dialog is 
displayed.

2. Specify the multi-overlap number to be opened and click [OK].

A maximum of 1,024 
multi-overlaps can be 
registered.

Overlap part

Overlap part

Overlap part

Multi-overlap
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Multi-overlap Editing

Placing an Overlap
1. Click the [Overlap] icon on the tool bar.

2. The [Overlap (Normal)] dialog is displayed.

When the dialog setting is concluded, click [Place].

3. A dotted line box as large as an overlap is displayed with a cross cursor.

4. Click the mouse in the desired position.  The overlap is placed.  If necessary, 
change the position or the size.

For the descript ion of setting the dialog, see “Chapter 2 Overlap” in the ZM-71SE 
Instruction Manual (Function).
4-21



Chapter 4  Registration Items
Editing in Overlap
When placing items such as switch parts or graphics, change over the editing 
layer from the base to an overlap.  The procedure is the same as that in screen 
editing.

1. Place an overlap part in multi-overlap editing.  Check that icons for drawing 
and parts (except for [Overlap]) are inactive.

2. Right-click the mouse.  The menu is displayed.  Select [Overlap 0].

The editing layer is now changed from the base to an overlap.  Icons for 
drawing and parts (except for [Overlap]) become active.

3. Place desired parts or graphics on the overlap.
When an overlap is selected as the editing layer, the overlap cannot be moved 
or enlarged/reduced.  To allow these operations, select [Base] from the 
right-click menu.
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Other Settings

Make the following settings as desired for multi-overlap.

Base Screen Display
During multi-overlap editing, a screen can be placed behind the overlap to check 
the actual image.

1. Select [Display Environment] from the [Display] menu.  The [Display 
Environment] dialog is displayed.

2. Check [  Base Screen Dsp.].  [Screen] becomes active.

3. Click [Screen] and specify the desired number.

4. Click [OK].  The selected screen is placed behind the overlap.

If no screen is displayed, select [Redraw] from the [Display] menu or press the 
Home key on the keyboard.

0 . CLR CR

1 2 3 +-

4 5 6 DW

7 8 9 UP1234

Change set value

data A

1234data B

1234data C

1234data D

1234data E

0 . CLR CR

1 2 3 +-

4 5 6 DW

7 8 9 UP

Only a multi-overlap Multi-overlap displayed on a screen
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Macro Setting
Overlap parts registered in multi-overlap editing can be used with [OPEN Macro] 
or [CLOSE Macro].  These macros can be executed when the registered overlap 
part is displayed (OPEN macro) on or erased (CLOSE macro) from the screen.

Macro Setting Commands

Select [OPEN Macro Edit] or [CLOSE Macro Edit] from the [Edit] menu.  The 
corresponding macro editing window is displayed.

Macro Editing and Deleting

Macro is a function to execute computation processing for user programs using 
the ZM series commands.  For information on macro commands, see “Chapter 
13 Macro” in the ZM-71SE Instruction Manual (Function).

If a registered multi-overlap is set as a call-overlap on the screen, these macro 
settings become invalid.  Set the overlap as a multi-overlap on the screen when 
enabling the macro settings.

If you delete a multi-overlap that is with an OPEN or CLOSE macro setting, be 
sure to delete the macro as well.  Failure to delete the macro will cause an error 
during screen data transfer to the ZM.

The description is provided on page 4-55.
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Data Block

Data blocks (parts) are provided as areas where data displays such as 
numerical data or character display parts or graphics are registered.

Data Block Structure

A maximum of 1,024 data blocks can be registered.

Calling a Data Block

Select [Data Block] from the [Item] menu.  The [Data Block] dialog is displayed.  
Specify the data block number to be opened and click [OK].

Line C setting
Data 1 1234
Data 2 1234
Data 3 1234
Data 4 1234
Data 5 1234

Line B setting
Data 1 1234
Data 2 1234
Data 3 1234
Data 4 1234
Data 5 1234

Data block

A maximum of 1,024 data 
blocks can be registered.

Line A setting

Data 1 1234
Data 2 1234
Data 3 1234
Data 4 1234
Data 5 1234
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Data Block Editing

Parts
Numerical data display, character display and table data display parts can be 
placed in the same manner that they are placed on the screen.

Drawing Tools
Except for the following, the drawing tools can be used in the same manner as 
used on the screen.

Offset Position Setting

Every data block has a reference position called an offset.  A registered data 
block is always placed on the screen with respect to the offset position.

An offset position on the data block is shown with an “OFF” mark.

Every data block has an offset position at coordinates X, Y (0, 0) as default.  To 
change the position, follow the procedure below.

1. Click the [Offset] icon on the drawing tool bar.

2. A cross cursor marked with “OFF” appears.

3. Click the mouse in the desired position.  The offset mark is displayed at that 
location.

For more information, see “Chapter 2 Screen Composition” in the ZM-71SE Instruction 
Manual (Function).

For more information, see “Chapter 3 Drawing Tools.”

OFF

1234

Line A Setting

Data 1

1234Data 2

1234Data 3

1234Data 4

1234Data 5

1234

Line A Setting

Data 1

1234Data 2

Data block display area on the screen Offset position on the data block=

Changing the offset position prior to registering a data block is not valid.  Set an 
offset position after registering a data block.
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Data Block Environment Setting

Environment setting for data block is also started from [Display Environment] in 
the [Display] menu, as performed for screen editing.  Therefore, this section 
explains the display environment settings that are different from those in screen 
editing.

Base Screen Display
While editing a data block, a screen or multi-overlap can be placed behind the 
data block to check the actual image.

1. Select [Display Environment] from the [Display] menu.  The [Display 
Environment] dialog is displayed.

2. Check [  Base Screen Dsp.].  Selection from [Screen] and [Multi-Overlap 
LIB] is made possible.

3. Select either one and specify the desired number.

4. Click [OK].  The selected screen is placed behind the data block.

Background Color Setting
It is possible to change the background color of a data block.

1. Select [Display Environment] from the [Display] menu.  The [Display 
Environment] dialog is displayed.

2. Open the [Menu Dsp.] tab window.

3. Select the desired background color and click [OK].  The data block is shown 
on the background colored as specified.

0 . CLR CR

1 2 3 +-

4 5 6 DW

7 8 9 UP

1234

Line A setting

Data 1

1234Data 2

1234Data 3

1234Data 4

1234Data 5

Change set value

1234

Line A setting

Data 1

1234Data 2

1234Data 3

1234Data 4

1234Data 5

OFF

OFF

Only a data block Data block displayed on a base

An offset position can be changed 
with ease.

When a data block is called, its background setting is ignored and thus only the 
registered data is recognized as a target.
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Message

It is possible to register user’s desired texts in the message editing area.  Texts 
for the relay mode, message mode, bit sampling, alarm display (parts) that will 
vary according to the circumstances are registered in this area and can be 
displayed by the message display function.

Message Structure

The message editing area is divided into 24 groups, each of which can contain 
256 message lines.  Therefore, you can register a maximum of 6,144 lines.

The maximum permissible number of characters per line depends on the 
number of displayed dots specified for the ZM.

No.  0
No.  1

No.255

No.  0
No.  1

No.255

No.  0   AAAAAAAAAAAAA
No.  1   BBBBBBBBBBBBB

No.255   ZZZZZZZZZZZZZZ

No.  0
No.  1

No.255

Message Group No. 0 Group No. 1 Group No. 2 Group No. 23

Message
Message

Message

No. of  displayed dots Max. number of characters (1-byte)

800 × 600 100

640 × 480 80

320 × 240 40
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Each message is given a group address (message group number and line 
number) as well as an absolute address (line number only).

Ordinary addresses (groups) Absolute addresses

Group No. Message No. Group No. Message No.

0 0000 to 0255 (None) 0000 to 0255

1 0000 to 0255 0256 to 0511

2 0000 to 0255 0512 to 0767

3 0000 to 0255 0768 to 1023

4 0000 to 0255 1024 to 1279

5 0000 to 0255 1280 to 1535

6 0000 to 0255 1536 to 1791

7 0000 to 0255 1792 to 2047

8 0000 to 0255 2048 to 2303

9 0000 to 0255 2304 to 2559

10 0000 to 0255 2560 to 2815

11 0000 to 0255 2816 to 3071

12 0000 to 0255 3072 to 3327

13 0000 to 0255 3328 to 3583

14 0000 to 0255 3584 to 3839

15 0000 to 0255 3840 to 4095

16 0000 to 0255 4096 to 4351

17 0000 to 0255 4352 to 4607

18 0000 to 0255 4608 to 4863

19 0000 to 0255 4864 to 5119

20 0000 to 0255 5120 to 5375

21 0000 to 0255 5376 to 5631

22 0000 to 0255 5632 to 5887

23 0000 to 0255 5888 to 6143
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Calling a Message

Select [Message] from the [Item] menu.  The [Message] dialog is displayed.  
Specify the message group number to be opened and click [OK].

Message Edit Window
The following window is displayed.
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Message Editing

Messages are entered in the same way as characters in graphics.

Copying and Pasting Messages
1. Specify messages as the copy source by dragging the mouse.  The 

messages are highlighted.

To shift to the next group, click the [Next] icon on the icon bar.

To select all messages in the group, select [Select All] from the right-click 
menu.
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2. Select [Copy] from the [Edit] menu or the right-click menu, or click the [Copy] 
icon on the edit tool bar.  The messages are copied to the Windows 
clipboard.

3. Move the cursor to the copy target position.  Select [Paste] from the [Edit] 
menu or the right-click menu, or click the [Paste] icon on the edit tool bar.  
The specified messages are copied to the position.

The [Paste] command inserts messages into the specified position so that the 
following lines move down accordingly.
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Deleting Messages
1. Specify messages to be deleted by dragging the mouse.  The messages are 

highlighted.

2. Select [Delete] from the [Edit] menu or the right-click menu.  The specified 
messages are deleted.

When deleting all messages from the group, select [Delete All] from the [Edit] 
menu.  The confirmation message as shown on the right appears.

To delete all messages, click [Yes].
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Message Search and Replacement
Searching for or replacing messages is possible.

Search

1. In the [Message Edit] window, check the position of the mouse cursor.

2. Select [Find] from the [Edit] menu.  The [Find] dialog is displayed.

3. Enter the string to be searched for into the [Find what] field.

4. Select an option from [Direction].  Select [Up] when searching the window 
upward from the cursor position.  Select [Down] when searching the window 
downward from the cursor position.

5. Check [  Match case] to make a distinction between upper-case and 
lower-case letters during searching messages.

6. Clicking [Find Next] starts searching the window in the selected direction.

Replacement

1. In the [Message Edit] window, check the position of the mouse cursor.

2. Select [Replace] from the [Edit] menu.  The [Replace] dialog is displayed.

3. Enter the desired strings respectively into the [Find what] and [Replace with] 
fields.  Check [  Match case] to make a distinction between upper-case and 
lower-case letters during searching messages.
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4. Clicking [Find Next] starts searching the window downward from the cursor 
position.  When [Replace] is clicked, the string for [Find what], if found during 
searching downward from the cursor position, is replaced with the string for 
[Replace with], and search continues.  When [Replace All] is clicked, all the 
strings for [Find what], if found during searching downward from the cursor 
position, are replaced with the string for [Replace with].

Message Display Environment Setting

The [Display] menu contains commands for messages.

[Font Bold]
When this command is selected, message characters are displayed in the 
bold style similar to the [Bold] option available on screens.

[Under line]
This command is checked as default.  Only the registered messages are 
underlined.  For registered messages containing spaces etc., this command 
can be used when counting the number of characters in the messages.

[Display Environment]
Selecting this command bring up the [Display Environment] dialog.  This 
setting is valid only when the language selection function is in use.

When searching the [Message Edit] window entirely, move the cursor to the top 
in advance.

For more information on the function, see “Chapter 29 Language Selection” in the 
ZM-71SE Instruction Manual (Function).
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[Display Change]
This command is valid only when alarm display in the sampling function is in 
use.  Selecting this command switches the display as the following:

The commands below are added to the [Display] menu.

[No.]
When this command is selected, line 
numbers are displayed.

[Relay No.]
When this command is selected, the 
allocation of memory used for alarm 
display is displayed.

[Memorize]
Checked lines are stored in alarm 
message history records.  Unchecked 
lines are not stored in history records.

[WAV]
When this command is selected, the 
column that indicates settings with/without 
sound output is displayed.

[WAV File No.]
When this command is selected, WAV file 
numbers are displayed.

[Sound Priority]
When this command is selected, the order of precedence is displayed.

[E-Mail]
When this command is selected, the column that indicates settings 
with/without e-mail is displayed.

Refer to ZM-71SE Instruct ion Manual (Funct ion) for more information on the following:
For alarm display, see “Chapter 10 Sampling.”  For sound output,  see “Chapter 20 Sound.”  
For e-mail, see “Chapter 27 E-Mail. ”
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Pattern

Patterns are the areas where bitmap files are imported and graphics are drawn 
in dots and then registered.

Pattern Structure

A maximum of 1,024 patterns can be registered.

The maximum capacity per pattern is 128 KB.  The maximum permissible 
number of dots are the same as the number specified for the edit model: 
800 × 600 dots, 640 × 480 dots, or 320 × 240 dots.

Calling a Pattern

Select [Pattern] from the [Item] menu.  The [Pattern] dialog is displayed.  Specify 
the pattern number to be opened and click [OK].

No. 3 No. 4 No. 5 No. 6

Wine Beer Soda

No. 0 No. 1 No. 2 No. 1023Pattern
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Pattern Editing

The following tool bar is provided for pattern drawing.

[Pencil] Icon
Clicking this icon brings up the [Pattern Drawing] dialog.

[Foreground]
Select a color to be displayed by clicking or dragging.

[Background]
Select a color to be displayed by right-clicking or right-dragging.

[Pen]
Select a dot size for the pencil command.

[  Transparent Color]
Check this box when transparent color setting is necessary.  For more 
information on transparent color setting, see “Chapter 9 Graphic Display” in 
the ZM-71SE Instruction Manual (Function).

Pencil Command Usage

1. Select a foreground color, background color, and dot size ([Pen]).

2. In the [Pattern Edit] window, draw a graphic by clicking or dragging the 
mouse.  It is drawn with the specified-size pen in the color for [Foreground].

Drag
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3. To draw in the color for [Background], right-click or right-drag the mouse.

[Eraser] Icon
Clicking this icon brings up the [Pattern Drawing] dialog.

[Pen]
Select a dot size for the eraser command.

[  Transparent Color]
Check this box when transparent color setting is necessary.  For more 
information on transparent color setting, see “Chapter 9 Graphic Display” in 
the ZM-71SE Instruction Manual (Function).

Eraser Command Usage

1. Select a dot size ([Pen]).

2. In the [Pattern Edit] window, click or drag the mouse over the graphic.  The 
eraser in the size for [Pen] erases the graphic.

Right-drag

Click or drag

Operation by the eraser command is the same as drawing in dots using black 
color.
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[Line] Icon
Clicking this icon brings up the [Pattern Drawing] dialog.

[Foreground]
Select a color to be displayed by clicking or dragging.

[Background]
Select a color to be displayed by right-clicking or right-dragging.

[Pen]
Select a dot size for the line command.

[  Transparent Color]
Check this box when transparent color setting is necessary.  For more 
information on transparent color setting, see “Chapter 9 Graphic Display” in 
the ZM-71SE Instruction Manual (Function).

Line Command Usage

1. Select a foreground color, background color, and dot size ([Pen]).

2. In the [Pattern Edit] window, drag the mouse.  A line is drawn with the 
specified-size pen in the color for [Foreground].

3. To draw in the color for [Background], right-drag the mouse.

Drag
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[Box] Icon
Clicking this icon brings up the [Pattern Drawing] dialog.

[Foreground]
Select a color to be displayed by dragging.

[Background]
Select a color to be displayed by right-dragging or by dragging with the 
[ Paint] option checked (see the next).

[  Paint]
Check this when painting boxes.  With a check mark, drawn boxes are 
painted in the color for [Background].

[  Frame]
This is active with [  Paint] checked.  With a check mark, the painted box is 
enclosed in a frame.  The frame is in the color for [Foreground].

[  Transparent Color]
Check this box when transparent color setting is necessary.  For more 
information on transparent color setting, see “Chapter 9 Graphic Display” in 
the ZM-71SE Instruction Manual (Function).

Box Command Usage

1. Select a foreground color, background color, and check or uncheck [  Paint] 
and [  Frame].
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2. In the [Pattern Edit] window, drag the mouse.  A box is drawn according to 
the settings.

[Circle] Icon
Clicking this icon brings up the [Pattern Drawing] dialog.

[Foreground]
Select a color to be displayed by dragging.

[Background]
Select a color to be displayed by right-dragging or by dragging with the 
[ Paint] option checked (see the next).

[  Paint]
Check this when painting circles.  With a check mark, drawn circles are 
painted in the color for [Background].

[  Frame]
This is active with [  Paint] checked.  With a check mark, the painted circle 
is enclosed in a frame.  The frame is in the color for [Foreground].

[  Transparent Color]
Check this box when transparent color setting is necessary.  For more 
information on transparent color setting, see “Chapter 9 Graphic Display” in 
the ZM-71SE Instruction Manual (Function).

Drag
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Circle Command Usage

1. Select a foreground color, background color, and check or uncheck [  Paint] 
and [  Frame].

2. In the [Pattern Edit] window, drag the mouse.  A circle is drawn with respect 
to the drag start point as the center.

[Text] Icon
A font available for use under Windows can be imported as a bitmap.  Clicking 
this icon brings up the [Pattern Drawing] dialog.

[Foreground]
Select a character color.

[Background]
Select a character background color.

[Font]
Clicking this brings up the [Font] dialog.

Select the desired options for [Font], [Font Style], and [Size].  To go back to 
the previous dialog, click [OK].
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Text Command Usage

1. Select a foreground color and a background color, and make [Font] settings.

2. In the [Pattern Drawing] window, click the text field.  Check that the cursor is 
blinking inside.

3. Key in a text as desired.

4. In the [Pattern Edit] window, drag the mouse.  A box as large as the text is 
displayed.  Release the mouse being dragged to place the text.

Dragging the mouse 
displays a box.

Releasing the mouse 
places the text.

It is not possible to change the placed text.  When correcting the text, delete it or 
cancel it by the [Undo] icon.
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[Paint] Icon
Clicking this icon brings up the [Pattern Drawing] dialog.

[Foreground]
Select a color to be displayed by clicking.

[Background]
Select a color to be displayed by right-clicking.

[  Transparent Color]
Check this box when transparent color setting is necessary.  For more 
information on transparent color setting, see “Chapter 9 Graphic Display” in 
the ZM-71SE Instruction Manual (Function).

Paint Command Usage

1. Select a foreground color and a background color.

2. In the [Pattern Edit] window, click the mouse.  The enclosed area is painted 
in the color for [Foreground].
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[Square Select Area] Icon
This icon is used when specifying a pattern area.  Dragging the mouse over a 
pattern encloses it.  The enclosed area becomes a target for copy or deletion.

[Square Select Area] Usage

1. Select [Square Select Area] from the [Edit] menu or click the [Square Select 
Area] icon.

2. In the [Pattern Edit] window, drag the mouse from the start point to the end 
point as drawing a box.

3. A box is displayed.  Execute a necessary function such as copy or deletion.  
To move the box, drag it.

Or

Drag and 
release.

Drag the displayed box. Release the mouse to finish the movement.
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Transforming Patterns

This section explains the commands in the [Transform] menu.

[Rotate Graphic]
Clicking this command rotates the registered pattern 90°.

[Mirror Horizontal]
Clicking this command flips the registered pattern horizontally.

[Mirror Vertical]
Clicking this command flips the registered pattern vertically.

90° 90°

Click [Rotate Graphic]  
again.  The rotated 
image is rotated 
further 90 °.

Click [Rotate Graphic].  
The image is rotated 
90°.

Click [Mirror Horizontal.  The 
image is flipped horizontally.

Click [Mirror Vertical].  The 
image is flipped vertically.
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[Change Size]
Use this command when changing the size.  Clicking this command brings 
up the [Size Change] dialog.

The available setting ranges are as follows:
Width (X): 1 - 800 Height (Y): 1 - 600
Color: 8-color/16-color/128-color/32K-color

[Transparent Color Setting]
When a pattern is animated in the graphic relay mode and the screen 
background is set to any color other than black, the pattern is displayed in 
the XORed color.  With this transparent setting, however, the actual pattern 
color can be displayed.  (Set the color that you do not want to display as 
transparent when the pattern is placed on the screen.)  Only one color can 
be set as transparent for each pattern.  When setting a color as transparent, 
the transparent color is reflected even when placement is not animated.  
Take care to draw the pattern so that it falls within the 4,088-dot size limit 
(pattern size = X size × Y size).

Ex.:
When a pattern is created and placed on the screen, it differs in the 
following ways depending on whether or not a color is set as transparent.

If a size change is made during pattern editing or when a pattern has been 
completed, the created pattern data is deleted.

Pattern
Green

Place

Screen

[  Transparent Color: Green]
Screen

[  Transparent Color: None]
Screen
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Bitmap Import and Storage

It is possible to import a bitmap file into pattern editing and to store a pattern as 
a bitmap file.

Importing a Bitmap File
1. Select [Read from Bitmap File] from the [Tool] menu.  The [Open a Bitmap 

File] dialog is displayed.

2. Select the desired file and click [Open].  The following dialog is displayed.

Click [OK].
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3. The following confirmation message is displayed.  Clicking [Yes] imports the 
bitmap file.

4. Clicking [No] brings up the [Specify Bitmap Read No.] dialog.  Enter the top 
pattern number to be imported and click [OK].  The bitmap data is imported.

Dialog for Bitmap Import

[  Dither]
When this option is checked, dithering can be performed to make the colors 
of the bitmap closer to the original.  The option is invalid when [32K] is 
selected for [Color Type for Convert].

[  Pseudo Gradation]
Depiction in pseudo gradation is performed.  With the use of 3-D parts on the 
ZM-42 to 82 series, however, this option and [Dither] cannot be selected.  
Pseudo gradation is to be set automatically.
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[Detail]
This option brings up the detailed menu for [Pseudo Gradation] as the 
following:

[Adaptive Error Diffusion]
Error diffusion adapted to each individual part of the image can be 
performed.  This function places emphasis on smoothness of image 
more than the following [Error Diffusion] does.

[Error Diffusion]
If a color of the source image is not included in the color pallet, two bits in 
similar colors are placed alternately so as to reproduce the color.

[Nothing]
A pallet similar to the source image color is selected.

[Ordered Dithering]
Error diffusion pattern is made closer to regular pattern.

[Diffusion] (0 - 3, standard: 1)
Specify a level of diffusion.

[Color] (0 - 15, standard: 8)
Assign priority to brightness or color for depicting.  When a specified 
number gets smaller, brightness takes priority over color.

[Green] (0 - 15, standard: 8)
Assign priority to blue-green-based color or red-yellow-based color for 
depicting.  When a specified number gets smaller, green-based color 
takes priority over other colors.

[Convert]
Clicking this option (depressed) brings up the preview of the placed image.
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[Redraw]
When any setting [Dither] or [Pseudo Gradation] has been changed, click 
[Convert] (depressed) and [Redraw].  The image according to the change is 
previewed.

Storing in a Bitmap File
The pattern currently being opened can be stored in a bitmap file (extension: 
“.bmp”).

1. Select [Save As Bitmap File] from the [Tool] menu.  The following dialog is 
displayed.

2. Give a name to the file and click [Open].  The pattern is now stored as a 
bitmap.

In the case of the ZM-42 to 82 series:
When the [  Use 3D Parts] (in the [Environment Setting] tab window opened in 
the [Unit Setting] dialog selected from the [System Setting] menu) setting is 
changed, the pallet is also changed and the colors of the placed bitmap vary 
accordingly.  To bring the bitmap to the initial condition, repeat pasting operation 
of the bitmap.
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Pattern Environment Setting

The [Display] menu includes the following commands.

[Display Environment]
The following dialog is displayed.

[Zoom] (100%/200%/400%/800%)
Select a zoom in % for display.  Default is 800%.

[  Grid Display]
Select whether or not to display grids in the background.

[  Blink Display]
It is possible to distinguish the color set to flash on the pattern.  When 
unchecked, the color set to flash is indistinguishable from the normal color.

[  Monochrome]
With ZM-42/43 monochrome type or ZM-62E, checking this option depicts 
patterns in 8- or 2-gradation colors.  Therefore, patterns are made closer to 
images depicted on the ZM.

[Background Color]
When editing a pattern, it is possible to view the actual screen background color.
When you click this command, the [Color] dialog is displayed.  Select the desired 
color and click [OK].  The pattern edit window background color changes.
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Placing a Pattern

Registered patterns can be placed on screens or in the graphic library using the 
[Pattern] icon on the drawing tool bar.

After a pattern placement, the [Pattern No.] can be changed and [Rotate/Mirror] 
operations can be performed.  Double-click the placed pattern (within 4,088-dot 
size), or select it with handles and click [Detail/Prop. Change] icon.  The 
[Pattern] dialog is displayed.

Size of a Placed Pattern
• If a pattern size is 128 KB or less, the maximum permissible size setting is 

800 dots horizontal and 600 dots vertical.  However, if [Rotate/Mirror] 
operation is performed on a pattern placed on the screen or in the graphic 
library, the size is limited to 4,088 dots or less (pattern size = X size × Y size).

• When animation is performed with patterns in the graphic mode or the 
graphic relay mode, patterns that are 4,088 dots or less in size tend to be 
depicted more smoothly.

• Once a pattern is placed, it cannot be reduced but can be enlarged.  If a 
pattern is 4,088 dots or less in size, its size can be multiplied by integers.  
Note that if a pattern that does not exceed 4,088 dots is enlarged on the 
screen or in the graphic library, it may exceed 4,088 dots, and thus be 
subject to the limitations described above in the case of [Rotate/Mirror] 
operation or animation.

For more information, see “Chapter 3 Drawing Tools.”
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Macro Block

Macro programs are registered in macro blocks.  Macro blocks are executed by 
CALL commands in the macro mode or in other macro programs.

Macro Block Structure

A maximum of 1,024 macro blocks can be registered.  A maximum of 1,024 lines 
can be set for one macro block.

Calling a Macro Block

Select [Macro Block] from the [Item] menu.  The [Macro Block] dialog is 
displayed.  Specify the macro block number to be opened and click [OK].
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Macro Block Editing

Opening a macro block brings up the following window.

Follow the procedure below.

1. Click a white line in the window.  The [Line No.] dialog is displayed.

2. Click the [Command] button.  The [Command] dialog is displayed.
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Ex.: Selecting the [MOV] command

1) Click [Transfer] under [Commands Classification].  The associated 
commands are listed under [Command].

2) Click [MOV] under [Command].

[Command] Dialog
[Commands Classification] on the left in the dialog lists the macro command 
groups and [Command] on the right lists the commands.  Clicking [All] under 
[Commands Classification] brings up all commands under [Command].  
Clicking a group name under [Commands Classification] brings up the 
associated commands under [Command].

[Command] lists commands in alphabetical order.

For more information on the command groups and the commands, see “Chapter 13 
Macro” in the ZM-71SE Instruction Manual (Function).
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3) Select the desired number of words from [WORD] (1 word) or [DWORD] 
(2 words).

4) Click [OK].  The [Line No.] dialog is displayed again.

3. Set [F0], [F1], and [F2] as necessary for the selected command.

4. Clicking [Next] brings up the [Line No.] dialog for the next line.  Clicking 
[Preview] brings up the [Line No.] dialog for the previous line.  Clicking 
[Insert] inserts the data setting into the position before the selected line.  The 
corresponding dialog is also displayed.

5. Clicking [Delete] deletes the selected line.

To close the [Line No.] dialog, click the top right [×] button of the dialog or the line 
number.

To bring up the [Line No.] dialog again, click a white line.
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Useful Functions
Copying Lines

Click a line number as the copy source.  The [Copy] icon becomes active.  Click 
the icon.

Click a line number as the copy target.  Click the [Paste] icon.  The source data 
is copied to the target line.

When copying multiple lines at one time, click the top number of the lines, hold 
down the Shift key, and click the bottom number of the lines.

Multiple lines from the specified top to the specified bottom are selected.  Click 
the [Copy] icon.  Click the top number of the copy target lines.  Click the [Paste] 
icon.  The copied lines are displayed from the specified top line.

Hold down the 
Shift key and 
click the bottom 
line number.
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Deleting Lines

Click a line number to be deleted and select [Delete] from the [Edit] menu.  The 
selected line is deleted.

When deleting multiple lines at one time, click the top number of the lines, hold 
down the Shift key, and click the bottom number of the lines.  Selecting [Delete] 
from the [Edit] menu deletes the lines from the specified top to the specified 
bottom.
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Page Block

Registered messages can be divided into groups and registered in page blocks.  
Page blocks are used in the relay-sub mode (parts) or the message mode 
(parts).

Page Block Structure

A maximum of 1,024 page blocks can be registered.  One page block can 
contain 256 lines.

Calling a Page Block

Select [Page Block] from the [Item] menu.  The [Page Block Edit] window is 
displayed.

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8
No. 9
No.10
No.11

Control  box emergency stop

EMERGENCY STOP button is 
pressed on the control  box.
Reset the button.

Message

Message group No. 3

Page block

Block No. 0

Control box emergency stop

EMERGENCY STOP button is 
pressed on the control box.
Reset the button.

Operation box emergency stop

EMERGENCY STOP button is 
pressed on the operation box.
Reset the button.

A maximum of 1 ,024 blocks can be registered.

EMERGENCY STOP button is 
pressed on the operation box.
Reset the button.
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Page Block Editing

The [Page Block Edit] window consists of one window as shown below.

Follow the procedure below.

1. Click the block No. 0 cell under [Group].  (“No Setting” is shown in the cell as 
default.)

2. The dialog now shows as the following.

Specify a group number for [Group] and message line numbers respectively 
for [Start] and [End].  Enter numbers using the arrow buttons or through the 
keyboard.
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3. To check the contents of the messages, click the [Reference] button.  The 
corresponding [Message Edit] window is displayed.

4. Perform the same steps for editing block No. 1 and after.

Copying and Pasting or Deleting Page Blocks
Follow the procedure below to copy and paste or delete page blocks.

1. Click the block number to be copied or deleted.

2. The clicked line is highlighted entirely.  Select [Copy] or [Delete] from the 
[Edit] menu.

These commands can also be selected from the right-click menu.

To select multiple block numbers at one time, hold down the Shift key and click 
top and bottom block numbers.
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One-Time Setting of Multiple Blocks
If consecutive lines are registered in several page blocks by the same number of 
lines, use [Multiple Setting].

1. Select [Multiple Setting] from the [Edit] menu or the right-click menu.

2. The [Multiple Setting] dialog is displayed.

[Start block No.]
Specify a top number of the multiple page blocks for one-time setting.

[Setting Blocks]
Specify the total number of page blocks for one-time setting.

[Start Message]
Specify the first message group number and the first line number in the 
top page block.

[Lines of Message]
Specify the number of lines in one block.

3. When the dialog setting is concluded, click [OK].  Multiple page blocks are 
set as per the above dialog setting.
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Direct Block

Lines selected as desired from the previously registered messages in different 
groups can be re-registered in direct blocks.  Direct blocks are different from 
page blocks in the point that direct blocks ignore the order of messages.  Direct 
blocks are used in the relay-sub mode (parts) or the message mode (parts).

Direct Block Structure

A maximum of 1,024 direct blocks can be registered.  One direct block can 
contain 256 lines.

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8
No. 9

No.21
No.22

No. 1
No. 9
No. 6
No.22
No. 5

Message

Message group No. 2

A maximum of 1,024 blocks 
can be registered.

LCD contro l terminal
General  specifications

Item
Contents

Hardware speci fications
Input power AC 85 - 235
Display co lor 16 colors
Display area 640 × 480 dots
FUNC switch 8 pcs
Swi tch H24 × W40

Prin ter port 1 port
Comm. port RS232C/RS422

Direct block

Block No. 0
Genera l speci fications

Swi tch H24 × W40
Display co lor 16 colors
Comm. port RS232C/RS422
Input power AC 85 - 235
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Calling a Direct Block

Select [Direct Block] from the [Item] menu.  The [Direct Block Block Specify] 
dialog is displayed.

Check the desired block number range and click [OK].  The [Direct Block Edit] 
window is displayed.

Direct Block Editing

Follow the procedure below.

1. Click the block No. 0 line indicating “No Setting.”

Click around this point.
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2. The [Direct Block] setting dialog is displayed.

3. Click the [No. 0] button under [Line].  The following dialog is displayed.

4. Specify numbers for [Message Group] and [Line] (= line number).  Click [OK].

5. The next [No. 1] button becomes active.  Perform the same procedure using 
the button.

Clicking a set number button makes the [Copy], [Insert], and [Delete] buttons 
active.  Use them as necessary.
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6. When the dialog setting is concluded, click [OK].  The previous window is 
displayed.  Perform the same procedure for the next block number.

Copying and Pasting or Deleting Direct Blocks
Follow the procedure below to copy and paste or delete page blocks.

1. Click the block number to be copied or deleted.

2. The clicked line is highlighted entirely.  Select [Copy] or [Delete] from the 
[Edit] menu.

These commands can also be selected from the right-click menu.

To select multiple block numbers at one time, hold down the Shift key and click 
top and bottom block numbers.
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Screen Block

When [Screen Call] (in the [Relay dialog]) is chosen in the relay mode (parts), 
screen blocks must be specified.

Screen Block Structure

A maximum of 1,024 screen blocks can be registered.

Calling a Screen Block

Select [Screen Block] from the [Item] menu.  The [Screen Block Edit] window is 
displayed.

For more information on the screen call function, see “Chapter 6 Message Display” in the 
ZM-71SE Instruction Manual (Function).
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Screen Block Editing

Follow the procedure below.

1. Click the block No. 0 cell under [Block].  The line is highlighted as shown 
below.

2. Select an option from the pull-down menu under [Block].

3. The other columns become active.  Set them using the arrow buttons or 
entering alphanumerics through the keyboard.

4. Perform the same procedure for block No. 1 and after.

Checking [  Same Screen] shows “Same Screen” in the cell under [Screen 
No.].
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[Screen Block Edit] Window Setting
Set each option in the window, referring to the description below.

[Screen No.]
Specify the screen number to be used as a screen block.

[Block]
Select the part type included in the screen that is specified for [Screen No.].

• Page Block/Direct Block
These blocks are available when the message mode is selected.  Select 
either one in accordance with the block used in the message mode on 
the specified screen.

• Graphic LIB
When the graphic mode is used on the specified screen, choose this 
option.

• Data Block
When [Block] is chosen for [Type] in the [Entry] dialog (for the entry 
mode) or a data block area is set on the specified screen, choose this 
option.

• No Designation
When no part (= mode) as the above is used on the specified screen, 
choose this option.

[Division No.]
This option is necessary when something other than [No Designation] is 
selected for [Block].  Specify the same division number as the one where the 
mode selected by [Block] is registered.

[Block No./Library No.]
This option is necessary when something other than [No Designation] is 
selected for [Block].  Specify the block or library number of the contents that 
are applied to the sub-display of the original relay message.

[  Same Screen]
Click ( ) this option when the original relay mode screen and the screen to 
be called as a screen block are the same.

In the case that relay messages are linked to different data blocks 
respectively, it is convenient that only the data block numbers are switched 
on the same screen according to the currently active message.  For this 
operation, in the [Screen Block Edit] window, change only the numbers for 
[Block No.] related to the same screen.  Register several screen blocks of 
the same screen number with [Same Screen] checked ( ).  With these 
settings, a screen call is set where different blocks are displayed depending 
on the activated relay (bit activation).

With this, screen block settings are finished.

Set the previously described [Screen No.] to be the same as the relay mode 
screen number.
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Tile

For painting a graphic such as a box or circle, a paint pattern can be selected 
from eight default types and eight patterns that you register yourself.

Tile Structure

A maximum of 8 tiles can be registered.  The size of one tile is 8 × 8 dots.

White dots specified on a tile are regarded as areas in the foreground color and 
black dots are regarded as areas in the background color.

Calling a Tile

Select [Tile] from the [Item] menu.  The [Tile Edit] window is displayed.

White dots specif ied in tile editing are 
colored in the foreground color and black 
dots are colored in the background color.

Foreground color

Background color
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Tile Editing

Follow the procedure below.

1. Select a tile number to be registered by clicking.

2. Create a tile in the tile editing area.  Draw white dots by clicking or dragging.  
Draw black dots by right-clicking or right-dragging.
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3. When the tile is complete, click the next tile number.  The previous tile 
number shows the registered image.

4. Perform the same procedure for the remaining tile numbers.
4-74



Chapter 4  Registration Items

4

D
ata S

heet
Data Sheet

When data sheet screens have been registered, data in the format of data sheet 
can be printed out from the LCD control terminal by means of the data sheet 
function.

Data Sheet Structure

A maximum of 1,024 data sheets can be registered.  Make settings for a data 
sheet including the size and orientation in the [Data Sheet Page Setting] dialog.  
For information on the dialog, see the next page.

1

2

3

4

5
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9
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1

2

3

4

5

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

6

7

8

9

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

No. 0

No. 1

No. 2

No. 3

No. 1023

Data sheet

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10

Data 10

Data 10

Line A setting

setting

setting

A maximum of 1,024 data 
sheets can be registered.
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Calling a Data Sheet

Select [Data Sheet] from the [Item] menu.  The [Data Sheet] dialog is displayed.  
Specify the data sheet number to be opened and click [OK].

Data Sheet Editing

It is necessary to set the size of a data sheet, the number of characters, etc. in 
the [Data Sheet Page Setting] dialog.  Select [Data Sheet Setting] from the [Edit] 
menu.  The [Data Sheet Page Setting] dialog is displayed.
4-76



Chapter 4  Registration Items

4

D
ata S

heet
Set each option in the dialog, referring to the description below.

[Memory]
This option determines the first page of printing.  The details of memory are 
as follows:

For more information on usage, see “Chapter 14 Data Sheet” in the 
ZM-71SE Instruction Manual (Function).

[Characters/Line] (16 - 152)
Specify the number of characters per line of data sheet.

[Lines/Page] (2 - 152)
Specify the number of lines per page of data sheet.

[Paper]
Clicking this button brings up the sheet size selection dialog.  Select the 
sheet size and the sheet orientation.

[  Use Character Graphic Print]
When this option is checked, charts can be printed out clearly.  The specified 
number of lines also changes.  How this relates to the printout paper is 
shown below.

Address Contents Action

n Beginning print page → ZM

n+1 Number of pages to be printed → ZM

Paper size Characters Lines No. of lines when character graphic 
is used

A4 portrait 80 66 108

A4 landscape 114 40 64

15-inch landscape 136 64 64

Printed out images differ as shown below.

-----------------------------------
  No. 0
-----------------------------------
  No. 1
-----------------------------------
  No. 2
-----------------------------------
  No. 3
-----------------------------------

No. 0

No. 1

No. 2

No. 3

[  Use Character Graphic Print] [  Use Character Graphic Print]

data

data

data

data

data

data

data

data
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Drawing Tools for Data Sheet
[Line] Icon

Straight lines can be drawn by dragging.

[Box] Icon

Only boxes without painting can be drawn.

[Text] Icon

Enter a text as desired into the text field and drag the mouse over the edit 
window.  The text can be placed.  Character enlargement is limited to X: 1 × Y: 1.  
Only when [  Enlarge X] is checked, however, the X size is doubled.

[Data Display] Icon

Clicking this icon brings up the following dialog.

Character enlargement is limited to X: 1 × Y: 1.  Only when [  Enlarge X] is 
checked, however, the X size is doubled.

It is possible to draw lines only horizontally or vertically.  Continuous lines as well 
as diagonal lines are not available.

Calendar Display
A calendar display can be set on a data sheet using a numerical data display.  
The calendar data is stored in system memory addresses $s160 to 166.  By 
placing the calendar data with numerical data display on a data sheet, the 
calendar is also printed out at the time of data sheet printing.
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Data Sheet Environment Setting

Display Environment
On data sheets, graphics, texts, and data display parts can be placed based on 
the fixed grids.  Texts and data displays are placed along grid dots.  Lines and 
boxes are placed on spaces between grid dots.  A grid color and whether or not 
to show grids can be selected in the [Display Environment] dialog.

[  Grid Dsp.]
Check this option to display grids.

[Grid Color]
Select a color of the displayed grids.

[Language Display]
This option is active only when the language selection function is in use.

Memory Display
Use this command when checking the memory addresses allocated to the 
placed numerical data or character displays.  Select [Memory Display] from the 
[Display] menu.  The memory addresses are displayed.

For more information, see “Chapter 29 Language Selection” in the ZM-71SE Instruction 
Manual (Function).
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Screen Library

Parts of switches, lamps, entry mode, etc. that are used in common to multiple 
screens can be registered in screen libraries.  Once screen libraries have been 
registered, screens will be created with ease just by placing the libraries.

Screen Library Structure

A maximum of 1,024 screen libraries can be registered.  The maximum 
permissible memory for one screen library is 128 KB.

Calling a Screen Library

Select [Screen Library] from the [Item] menu.  The [Screen Library] dialog is 
displayed.  Specify the screen library number to be opened and click [OK].

02-01-01  12 : 15 : 15   TUE

No. 0

No. 1

No. 2

No. 1023

Screen library

A maximum of 1,024 screen 
libraries can be registered.
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Screen Library Editing

Most parts valid on screens are valid in screen libraries as well.  Parts and 
graphics can be placed in the same manner as on screens.

Notes on Editing
• The functions below are not valid for screen libraries though they are valid 

for screens.
- Overlap
- OPEN macro
- CLOSE macro
- CYCLE macro
- Local function switch setting
- Screen library

• Place parts in screen library while imagining them placed on the screen.  
Both parts in screen library and on the screen are subject to the limitation on 
screen parts placement.  When placing a screen library on the screen, check 
that parts to be placed do not exceed the limited number.

Ex.: Placing a Calendar Part in Screen Library
In the example below, a calendar part is registered in screen library No. 0 and 
the screen library is placed on three screens.

For more information on the limitation on screen parts placement, see “Chapter 2 
Screens.”

02-01-01  12 : 15 : 15   TUEOFF

02-01-01  12 : 15 : 15   TUESLIB

02-01-01  12 : 15 : 15   TUE

02-01-01  12 : 15 : 15   TUESLIB 02-01-01  12 : 15 : 15   TUESLIB

Screen No. 0 Screen No. 1 Screen No. 2

Screen library No. 0
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• Memory used by a Sharp Manufacturing Systems standard calendar part is 
about 300 bytes.  When the calendar parts are placed on three screens 
directly, 900 bytes are used.

300 × 3 = 900 bytes

• When a 300-byte calendar part is registered in a screen library and the part 
is placed on a screen, 315 bytes and 7 bytes are used respectively.

315 + 7 + 7+ 7 = 336 bytes

• By using screen library, 564 bytes (900 − 336 = 564) are saved.

Screen Parts Management Through Screen Library
Should a part registered in a screen library be replaced after it has been placed 
on screens, replace it in the screen library only.  The parts on the screens are 
also replaced simultaneously.  When the calendar part in screen library No. 0 
has been replaced, the parts on screen Nos. 0 to 2 are also replaced.

Use of screen library saves memory.

02-01-01  12 : 15 : 15   TUE 02-01-01  12 : 15 : 15   TUE02-01-01  12 : 15 : 15   TUE

02-01-01  12 : 15 : 15   TUEOFF

SLIB SLIB SLIB

02-01-01  12 : 15 : 15   TUE

Screen No. 0 Screen No. 1 Screen No. 2

Screen library No. 0

Replace the calendar part in the screen library.

Screen library is available for management of parts on screens.
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Offset Position Setting
Every screen library has a reference position called an offset.  When a 
registered screen library is called to the screen, it is placed based on the offset 
position.

Screen library shows the offset position with an “OFF” mark.  Every screen 
library has an offset position at coordinates X, Y (0, 0) as default.  To change the 
position, follow the procedure below.

1. Click the [Offset] icon on the drawing tool bar.

2. A cross cursor marked with “OFF” appears.

3. Click the mouse in the desired position.  The offset mark is displayed at that 
location.

OFF

SLIB

Offset position in screen library SLIB position on the screen=

Changing the offset position prior to registering a screen library is not valid.  Set 
an offset position after registering a screen library.
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Placing a Screen Library

Registered screen libraries can be placed on screens using the [Screen LIB] 
icon on the drawing tool bar.

Notes on Placing a Screen Library
• Depending on the part type, only one piece can be registered on one 

division.  When placing a screen library containing such a part on screens, 
make sure that the same division number is not used for multiple parts.  Take 
care of division numbers of parts at the time of registering parts in screen 
library.

• To avoid a problem like the one described above, division Nos. 100 and 
higher should be allocated to screen libraries because such numbers may 
not be used generally.  (Also take care not to use one division number 
repeatedly in different screen libraries.)

• There are cases in which only one part (entry mode, memory card) can be 
used on one layer, or only one part (memo pad) can be used on one screen.  
Take the above note into consideration when placing a screen library 
containing such a part on the base screen or overlaps.

Multi-languages

This area is provided for the use of the language selection function.

For more information, see “Chapter 3 Drawing Tools.”

For more information, see “Chapter 29 Language Selection” in the ZM-71SE Instruct ion 
Manual (Function).
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Animation
(For the ZM-300 series except for ZM-352D)

This area is provided for the use of the animation function.  Graphics for 
animation are registered.

Animation Function Structure

There are [Animation] and [Frame] sections in the animation function.  Graphics 
are registered in [Frame] sections and graphics to be used are selected in 
[Animation] sections.

A maximum of 1,024 animation settings from No. 0 to No. 1,023 can be 
registered.  A maximum of 1,023 frames from No. 0 to No. 1022, which are 
defined in [Animation], can be registered.

Calling the Animation Function

Select [Animation] from the [Item] menu.  The [Animation] window is displayed.  
By making necessary settings in the window, [Animation] folders and their 
respective [Frame] folders are displayed.

[Animation] 
(0 - 1,023)

[Frame] 
(0 - 1,022)

Animation No. 0 Animation No. 1

Frame No. 0 Frame No. 1 Frame No. 2 Frame No. 3
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Animation Editing

In the [Animation] dialog, the number of frames and an animation speed are set, 
and the actual animated image can be checked.  Follow the procedure below.

1. Right-click [Animation] and click [Add].

2. The [Animation VIEW] dialog is displayed.  Start setting from animation No. 
0.

[Animation No.] (0 - 1,023)
An animation number currently being edited is displayed.  To go to a 
different animation number for editing, click the arrow buttons or key in 
the desired number directly.

[  Use]
A check mark for this option denotes that the animation number has been 
set.  To cancel the setting, uncheck the box.

[Start Frame No.] and [End Frame No.] (0 - 1,022)
Specify the number (range) of frames to be used for this animation.

[Seconds to Replay] (×100 msec)
Specify a speed to change the frames (specified for [Start Frame No.] 
and [End Frame No.]) during animation.

[TEST]
After frames are selected, their animation can be checked.

3. When the dialog setting is concluded, click the [Close] button.  The 
[Animation] window is displayed again.

For more information, see “Chapter 17 Animation” in the ZM-71SE Instruction Manual 
(Function).
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4. Double-click on the [Animation] folder.  The [Animation] sub-folders as set in 
step 2 are displayed.

To go back to the [Animation VIEW] dialog, right-click the desired folder 
[Animation No. xxxx] and click [Property].

5. Double-clicking a displayed folder [Animation No. xxxx] brings up as many 
[Frame] folders as the number set in step 2.
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Frame Editing

In the [Animation] window, double-click the desired [Frame No. xxxx] under an 
[Animation No. xxxx] folder.  The [Frame Edit] window is displayed.

Frame Structure
A maximum of 1,023 frames from No. 0 to No. 1,022 can be registered.  The 
maximum capacity per frame is 128 kB.  The maximum permissible number of 
dots is the same as the number specified for the edit model: 800 × 600 dots or 
640 × 480 dots.

Frame Editing
Frames can be edited in the same manner as for patterns.

Refer to the description of pattern edit ing (page 4-37).
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 S
eries
Before Using the ZM Series

Before attempting to use the ZM series, preliminaries including creation of 
screen data and its transfer to the ZM series, cable arrangement for connection 
with the PLC, and connection data setting are required.  Refer to the following 
for details.

Preliminary Steps

The steps below are required before the use of the ZM series.

Operations
• Data writing by CF card 

manager

Arrangements
• CF card
• CF card reader/writer

Screen data file edit ing

Screen data transfer to the ZM 
series

Connection to PLC

Start of communicat ion with PLC

Page 5-2

Operations (For screen data files:)
• PLC model check
• Communication parameters check
• Modular jack MJ1/2 and backlight setting check

Arrangements
• Personal computer
• ZM-71SE (ZM series screen editing software)

Page 5-12

Data transfer to CF card Screen data transfer to memory 
card (ZM-1REC)

Page 5-15 Page 5-17ZM-300 series

Operations
• Transfer with cable: (ZM-80C)

- COM port check
• Transfer on Ethernet (on LAN)

- Ethernet connection check

Arrangements
• With ZM-80C

- ZM series
- ZM-80C

• On Ethernet
- ZM series
- Ethernet cable
- ZM-80NU/80NU2

Other methods
• Online editing
• Transfer via modem

Operations (For PLC)
• Baud rate and parity check

Arrangements
• PLC
• PLC - ZM-42/43/52/62/72/82 connection cable

Page 5-40

Screen data transfer 
to the ZM-300 series

Screen data transfer 
to the ZM series

Operations
• Data writing to the ZM series

Arrangements
• CF card
• ZM-300 series

Operations
• COM port check

Arrangements
• Memory card
• ZM-1REC
• AC adaptor
• ZM-80C

Operations
• Data writing to the ZM series

Arrangements
• Memory card
• ZM-1REC
• Cable with the ZM-1REC
• ZM series

Page 5-30
Page 5-32
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Screen Data Check

Data required for communication with PLC are set in the screen data file and the 
data is reflected in communications after its transfer to the ZM series.  Go to 
[System Setting] to make the settings.

Setting for Communications with PLC
PLC Type Setting

Select the type of the PLC to be connected.  Following the selection, the [Comm. 
Parameter] dialog is displayed.

Communication Parameter Setting

[Read Area] and [Write Area]
These options are necessary for the ZM series to display the specified 
screen or confirm the currently displayed screen.  Each area is provided with 
3 words as default.  Check that the memory addresses for these areas are 
not already in use.

[Baud Rate], [Signal Level], [Parity], [Stop Bit], etc.
Set these options in accordance with the corresponding PLC data.

Other Settings
Before data transfer to the ZM series, check the following settings as well.

ZM Series Setting

Make settings for memory expansion, backlight, touch switch type, etc.

Font Setting

Set the font type to be displayed on the ZM series.

Modular Jack

Make settings for the use of the modular jack (MJ1/MJ2).

Printer Setting

Make settings for the printer (its model, etc.) connected to the ZM series.

For more information on the three words each given to the read area and the write area, 
see “Chapter 1 System Setting” in the ZM-71SE Instruct ion Manual (Funct ion).

For more information on the communication parameters, see the ZM-300 User’s Manual.

For more information, see “Chapter 1 System Sett ing” in the ZM-71SE Instruction Manual 
(Function).
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Screen Data Transfer

There are some differences in preliminaries before screen data transfer as well 
as in procedure for data transfer from the screen editor software, depending on 
the transfer method.

Preliminaries

For a New ZM Series (Just after being unpacked)
When a new ZM series unit is first turned on after being unpacked, the following 
screen is displayed.

A new ZM series unit stores the data below.
A. ZM series system program (ref. page 5-25)
B. Font data: Japanese 32 (ref. page 5-26)
C. I/F driver: universal serial (ref. page 5-21)

ZM-300 ZM-42 to 82

At the time of screen data transfer from the editor software (computer) to the ZM 
series:  If the editor software has a ZM series system program containing 
functions that are not supported by the ZM series, the computer transfers the 
system program as well to the ZM series.  Otherwise, the program is not 
updated. If the screen data contains any font data other than Japanese 32, the 
computer transfers the font data as well to the ZM series.  If any option other 
than universal serial is set for the I/F driver in the screen data, the computer 
transfers the I/F driver file as well to the ZM series.
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For a ZM Series (Being put to use)
When screen data has been transferred to a ZM series unit that has already 
been put to use (not just after being unpacked), it is brought to either status at 
power-on.

• Communicating with the PLC (RUN mode)

• Showing the [Main Menu] (local main) screen stored in the ZM series (STOP 
mode: communication stopped)

Screen data transfer is allowed in either status.  However, it may be necessary 
to bring up the [Main Menu] (local main) screen (STOP mode) to make data 
transfer possible.  For more information, see page 5-12.

2002-4 -1  09:23:30

SYSTEM PROG. VER. 1.000
FONT
VER.1.300/1.000/1.000
          HK Gothic

I/F DRV VER.1.210
     SHARP JW series

Editor:MJ1

Connection : 1:1
Signal Level : RS232C

PLC Stat.No. : 0

Baud Rate : 19200
Data Lebgth : 7

Stop Bit : 1
Parity : Even

Send Delay : 0 msec

Main Menu Z M - 3 7 1 T A

System Information

PLC Type : SHARP JW link module
Comment :

Screen Data
    Information
Size: 5832704

SRAM/Clock

Ethernet

Card
Menu

I/O Test

Error : Stop
Time-Out : 0.50 sec

Retry : 3

Ethernet Information
Trans.Speed : 10BASE-T

Stat. No. : 192.168.1.68
PORT: 10000
MAC: 0050FF000035

At the time of screen data transfer from the editor software (computer) to the ZM 
series:  If the editor software has a ZM series system program containing 
functions that are not supported by the ZM series, the computer transfers the 
system program as well to the ZM series.  Otherwise, the program is not 
updated.  If the screen data contains any font data other than Japanese 32, the 
computer transfers the font data as well to the ZM series.  If the set PLC model 
is different from the previously set model, the computer transfers the I/F driver 
file as well to the ZM series.
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Data Transfer Methods

Data Transfer via ZM-80C
Screen data is transferred from a computer to a ZM series unit while a RS-232C 
cable “ZM-80C” is connected between the modular jack MJ1 on the ZM series 
and the computer.

Arrangements

• LCD control terminal ZM series

• Cable ZM-80C (3 m)
Available from Sharp Corporation

D-sub 9pin

ZM-80C

8pin

MJ1
RESET

disc

F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER

If [Modular Jack 1: Editor Port] is not set in the [Modular Jack] dialog 
selected from the [System Setting] menu, press the [SYSTEM] key 
and then [F1] key on the ZM series.  The ZM series is brought to the 
STOP mode (= [Main Menu] ( local main) screen).

ZM seriesComputer

Modular jack

[Modular Jack 1: Editor Port] in the [Modular 
Jack] dialog under [System Setting]
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Data Transfer on Ethernet
Screen data is transferred on Ethernet while a computer and a ZM series unit 
are connected via LAN cable.

Arrangements

• LCD control terminal ZM series

• Ethernet cable
With a cross cable, data transfer is possible between a computer and a 
ZM-300 (High function display) (1:1) even if they are not on a network.

• Ethernet communication interface unit ZM-80NU/80NU2
This optional unit is necessary for Ethernet communications with ZM-300 or 
ZM-43 to 82.  (Since ZM-300 (High function display) is equipped with a 
built-in LAN port, the optional unit is not necessary.)

Ethernet

RESET

disc

PLC

F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER

Computer

ZM series
(With ZM-300/
ZM-43 to 82)

+
ZM-80NU/80NU2
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Data Transfer to CF Card (For ZM-300 (High function 
display) only)
A CF card to which screen data has been transferred from the ZM-71SE 
software (computer) is inserted into a ZM-300 and the data is transferred from 
the card to the ZM-300.

Arrangements

• CF card
For recommended CF cards, see the ZM-300 User’s Manual or “Chapter 23 
CF Cord” in the ZM-71SE Instruction Manual (Function).

• CF card reader/writer

96
M

B

CompactFlash Card

C F R M

96MB

RESET

disc

F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER

CF card 
manager

CF card

CF card reader/writer

ZM series

CF card reader/writer
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Data Transfer to Memory Card (ZM-1REC)
A memory card (SRAM/FROM) to which screen data has been transferred form 
the ZM-71SE software (computer) is connected to a ZM-300 and the data is 
transferred from the card to the ZM-300.

Arrangements

• Memory card (SRAM/FROM)
Use a memory card on the market.

• ZM-1REC (plus accompanying ZM-1REC cable as well as AC adaptor)

ZM-1REC

RESET

disc

Cable with
the ZM-1REC

M
O

N
ITO

U
C

H

M
O

N
ITO

U
C

H

REC-MCARD

ZM-1REC

ZM-80C

F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER

M
O

N
ITO

U
C

H

M
O

N
ITO

U
C

H

REC-MCARD

Memory card

* Some ZM-42 to 82 series models are 
equipped with built- in sockets for 
memory card insertion, thus 
requiring no ZM-1REC.

ZM series

Memory card

AC adaptor

Connecting to the serial port
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Data Transfer via Modem
For more information, see page 5-32.

MJ1

RESET

disc

PW ER OH CD DA
LINE

PW ER OH CD DA

LINE
F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER

RS-232C cable (straight) 
accompanying the modem

Computer
(PC)

Telephone line

RS-232C cable (straight)
(ZM-80C + cross cable + RS-232C cable accompanying the modem)

Modular cable accompanying 
the modem

Modular cable accompanying 
the modem

Telephone line modular socket

Telephone line modular socket

Modem

Modem

ZM series
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[Transfer] Dialog

Select [Transfer] from the [File] menu or click the [Transfer] icon on the icon bar.  
The [Transfer] dialog is displayed.

Setting the [Transfer] dialog is required for data transfer, except for transfer to a 
CF card.  When using a CF card, CF card manager setting is required.

Options Contents

Transfer 
Device

Display Select this option when the target/source for transfer is a ZM series unit.

Memory Select this option when the target/source for transfer is a memory card.

Transfer Data Screen Data Screen data is transferred.  If  the PLC model setting or font data is 
different between the screen data and the data stored in the ZM series, 
the I/F driver file or the font data is also transferred with the screen data.

I /F Driver The I/F driver file is transferred.  During screen data transfer to a new 
ZM series unit , the I /F driver file is also transferred automatically.  
Therefore, this option is not necessary.  When the ZM series already 
contains the I/F driver file and it  should be updated, select this option.

Program Select this option when updating the ZM series system program 
(SYSTEM PROG.).

Font Data Select this opt ion when updating the font data (12-point size only in the 
case of Gothic, English/Western Europe (HK Gothic), and 
English/Western Europe (HK Times)) and the [Main Menu] (local main) 
screen in the ZM series.

Temp./PLC2 This option is valid only when the temperature control network or PLC2 
Way function is used.  Select the opt ion when updating the protocol file 
for either of them.

Ex. Font This option is valid for the Gothic,  English/Western Europe (HK Gothic) 
and English/Western Europe (HK Times) font types.  Font data specified 
by manual font setting (except for 12-point size) is transferred.  (Font 
data specified by automatic font setting is transferred with screen data.)
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Transfer Data SRAM Data This option is valid when an SRAM cassette or a built-in SRAM is in 
use.  With the option setting, the data is backed up at the time of SRAM 
battery change and then is returned to SRAM.  For more information on 
SRAM, see “Chapter 24 SRAM” in the ZM-71SE Instruction Manual 
(Funct ion).

Station No. Table This option is valid when a temperature controller model F-MPC04P 
(FUJI) is used on the temperature control network and also the stat ion 
table is used.

Ladder Comm. Prg. It is possible to write ladder sequence for PLC (Mitsubishi 
Q02/Q02H/Q06H) via a ZM series unit.   Select this option for the 
purpose.  For more information, see the ZM-300 User’s Manual.

Modbus Comm. Prg. This option is valid when Modbus slave communication is in use.  Select 
the option when updat ing the Modbus slave program f ile.

 Use Simulator Check this opt ion when performing debugging using the ZM-71SE 
simulator.  The I/F driver file “UNIPLC20.tpb” for simulator is transferred 
accordingly.

 Read Comments in Data Transfer This option is provided for screen data transfer from a ZM series unit  to 
a computer after the data is t ransferred from the computer to the ZM 
series without the included comments.   When the previous screen data 
with comments stored in the computer is overwritten by the data from 
the ZM series while the option is checked, the comments are not 
deleted.  If the option is not checked, the comments are deleted from 
the previous data.

* To transfer screen data with comments, open the [Environment 
Setting] tab window in the [Unit Setting] dialog selected from 
the [System Setting] menu and check [  Transfer Comment].

 All Data Transfer This option is valid when [Memory] is chosen for [Transfer Device].  
When the option is checked, screen data, I/F driver f ile, ZM series 
system program, and font data are transferred during communicat ion 
with a memory card.

 Transfer Through Ethernet Check this option for communicat ions with a ZM series unit on Ethernet 
while a cable ZM-80C is not used.

MODEM (See page 5-32.) Check this opt ion for communications with a ZM series unit via a 
modem while a cable ZM-80C is not used.

Transfer [PC ->] From computer to transfer device
[PC <-] From transfer device to computer
[PC <->] Data comparison between computer and transfer device
[Info] This is valid only when [Memory] is chosen for [Transfer 

Device].
Memory card data check is allowed.

Up-date of System The ZM series system program, font data (except for the [Main Menu] 
(local main) screen), and I/F driver file are updated at one time.

Detail Setting [Serial Port]  (COM1 - COM8)
Select a computer port.

[Baud Rate] (9600, 19200, 38400, 57600, 115200 bps)
Select a data transfer rate between the computer and the transfer 
device.  (This option does not apply to transfer between a PLC and a 
ZM series unit .)
* The baud rate at 115,200 bps may be disabled for some 

computers.  Choose [57600 bps] or less for such a computer.
When [  Transfer through Ethernet] is checked:

The IP address sett ing dialog is opened.  Set the IP address for the 
ZM series as the transfer target.   For more information, see the 
ZM-300 User’s Manual.

Options Contents
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Screen Data Transfer via ZM-80C

Connecting Method
Connect a ZM series unit and a computer as illustrated below.

New ZM Series (Just after being unpacked)

ZM-80C Series (Being put to use)

RESET

disc

ZM-80C

Make sure to connect the cable to the modular jack MJ1 on the ZM series.

2002-4 -1  09:23:30

SYSTEM PROG. VER. 1.000
FONT
VER.1.300/1.000/1.000
          HK Gothic

I/F DRV VER.1.210
     SHARP JW series

Editor:MJ1

Connection : 1:1
Signal Level : RS232C

PLC Stat.No. : 0

Baud Rate : 19200
Data Lebgth : 7

Stop Bit :1
Parity : Even

Send Delay : 0 msec

Main Menu Z M - 3 7 1 T A

System Information

PLC Type : SHARP JW link module
Comment :

Screen Data
    Information
Size: 5832704

SRAM/Clock

Ethernet

Card
Menu

I/O Test

Error : Stop
Time-Out : 0.50 sec

Retry : 3

Ethernet Information
Trans.Speed : 10BASE-T

Stat. No. : 192.168.1.68
PORT: 10000
MAC: 0050FF000035

RESET

disc

ZM-80C

PLC

(Communicating)

or

STOP mode

RUN mode

Make sure to connect the cable to the modular jack MJ1 on the ZM series.
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Screen Data Transfer to ZM Series
1. Click the [Transfer] icon or select 

[Transfer] from the [File] menu.

2. The [Transfer] dialog is displayed.
Select [Display] for [Transfer 
Device] and [Screen Data] for 
[Transfer Data].

3. Click the [Detail Setting] button.  
The [Communication Detail] dialog 
is displayed.
Select a computer serial port to be 
used and a baud rate between the 
computer and the ZM series.  Click 
[OK].

4. Click the [PC ->] button.  Screen 
data transfer starts.

Screen Data Transfer from ZM Series
1. Click the [Transfer] icon or select 

[Transfer] from the [File] menu.

2. The [Transfer] dialog is displayed.
Select [Display] for [Transfer 
Device] and [Screen Data] for 
[Transfer Data].

3. Click the [Detail Setting] button.  
Select a computer serial port to be 
used and a baud rate between the 
computer and the ZM series.  Click 
[OK].

4. Click the [PC <-] button.  Screen 
data transfer starts.

When [Modular Jack 1: Editor Port] is specified in the [Modular Jack] dialog 
selected from the [System Setting] menu in the screen data file, data transfer 
between the computer and the ZM series is executable while the PLC and the 
ZM series are in either RUN or STOP mode.

When any setting other than [Modular Jack 1: Editor Port] is made, press the 
SYSTEM key and then the F1 key on the ZM series to bring it to the STOP 
mode (= [Main Menu] (local main) screen), and start data transfer.
5-13



Chapter 5  Transfer
Screen Data Comparison between Computer and ZM 
Series
1. Click the [Transfer] icon or select 

[Transfer] from the [File] menu.

2. The [Transfer] dialog is displayed.
Select [Display] for [Transfer 
Device] and [Screen Data] for 
[Transfer Data].

3. Click the [Detail Setting] button.  
Select a computer serial port to be 
used and a baud rate between the 
computer and the ZM series.  Click 
[OK].

4. Click the [PC <->] button.  Screen 
data comparison starts between the 
ZM series and the computer.

Screen Data Transfer on Ethernet

If screen data transfer is aborted, the message below appears on the screen, 
and the screen data as well the font data is deleted.  Keep this in mind if aborting 
data transfer.

Font Data not setting

Down-load by Panel Editor.

For the descript ion of screen data transfer on Ethernet, see the ZM-300 User’s Manual (“1. 
Ethernet” in “Chapter 4 Network Communication”).
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5

Screen D
ata Transfer
Screen Data Transfer via CF Card (For the ZM-300 Series Only)

Connecting Method
Connection between CF Card and Computer

Connection between CF Card and ZM-300

• With a new ZM-300 (just after being unpacked)

• With a ZM-300 other than the above

C F R M

96MB

RESET

disc

CF card
CF card reader/writer

CF card 
manager

96
M

B

CompactFlash Card

96
M

B

CompactFlash Card
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Screen Data Transfer between CF Card and Computer
Screen Data Transfer to CF Card

1. Insert a CF card into the CF card reader/writer.

2. Start up the ZM-71SE software.  Select [CF Card Manager] from the [File] 
menu.

3. Specify the drive in which the CF card is now inserted.  Click [OK].  The CF 
card manager starts.

4. Select [Write to CF Card] from the [File] menu.  The [Write to CF Card] dialog 
is displayed.

5. Click the [Refer] button for [File to be Converted].  Select a file (extension: 
“*.Z3”) to be written to the CF card.

6. Click [OK].  The screen data file is stored as [Dsp0000.bin] (BIN file) in the 
access folder [Dsp] in the CF card.  At the same time, files with certain 
extensions are written to CF card folders in accordance with the screen data 
file settings.

Screen Data Transfer from CF Card

1. Insert a CF card into the CF card reader/writer.

2. Start up the ZM-71SE software.  Select [CF Card Manager] from the [File] 
menu.

3. Specify the drive in which the CF card is now inserted.  Click [OK].  The CF 
card manager starts.

4. Check that the access folder [Dsp] in the CF card stores the screen data file 
[Dsp0000.bin] (BIN file).  Select the file.

5. Select [Put BIN File Back] from the [File] or right-click menu.

6. The [Select a screen data to save] dialog is displayed.  Select the desired file 
name and click [Save].

7. The converted file is stored in the specified place.

Screen Data Transfer between CF Card and LCD Control 
Terminal ZM series

For how to store screen data for automatic uploading or other functions of CF card, see 
“Chapter 23, CF Card” in the ZM-71SE Instruct ion Manual (Funct ion).

For the description of screen data transfer between a CF card and a ZM-300, see 
“Chapter 2 ZM-300 Operations” in the ZM-300 User’s Manual.
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ata Transfer
Screen Data Transfer via Memory Card (ZM-1REC)

Connecting Method
Connection between Memory Card (ZM-1REC) and Computer

Connection between Memory Card and LCD Control Terminal ZM 
Series

• ZM-300 series
- With a new ZM-300 (just after being unpacked)

RESET

disc

M
O

N
ITO

U
C

H

M
O

N
ITO

U
C

H

REC-MCARD

ZM-1REC

ZM-80C

Connecting to serial port

Memory card

AC adaptor

ZM-1REC

Cable with
the ZM-1REC

M
O

N
ITO

U
C

H

M
O

N
ITO

U
C

H

REC-MCARDMemory card
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- With a ZM-300 other than the above

• ZM-42 to 82 series

ZM-1REC

Cable with
the ZM-1REC

M
O

N
ITO

U
C

H

M
O

N
ITO

U
C

H

REC-MCARDMemory card

MONITOUCH

MONITOUCH

REC-MCARD

ZM-1REC
M

O
N

ITO
U

C
H

M
O

N
ITO

U
C

H

REC-MCARD

Cable with
the ZM-1REC
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or

(with a built-in socket)
Memory card

Memory card

A memory card is not available to transfer screen data to a new ZM-42 to 82.  
Transfer the data from a computer directly.
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Screen D
ata Transfer
Screen Data Transfer between Memory Card (ZM-1REC) 
and Computer
Screen Data Transfer to Memory Card (ZM-1REC)

1. Click the [Transfer] icon or select 
[Transfer] from the [File] menu.

2. The [Transfer] dialog is displayed.  
Select [Memory] for [Transfer 
Device] and [Screen Data] for 
[Transfer Data].

3. Click the [Detail Setting] button.  
The [Communication Detail] dialog 
is displayed.  Select a computer 
serial port to be used and a baud 
rate between the computer and the 
memory card (ZM-1REC).  Click 
[OK].

4. Click the [PC ->] button.  Screen 
data transfer starts.

Screen Data Transfer from Memory Card (ZM-1REC)

1. Click the [Transfer] icon or select 
[Transfer] from the [File] menu.

2. The [Transfer] dialog is displayed.  
Select [Memory] for [Transfer 
Device] and [Screen Data] for 
[Transfer Data].

3. Click the [Detail Setting] button.  
Select a computer serial port to be 
used and a baud rate between the 
computer and the memory card 
(ZM-1REC).  Click [OK].

4. Click the [PC <-] button.  Screen 
data transfer starts.
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Screen Data Comparison between Memory Card (ZM-1REC) and 
Computer

1. Click the [Transfer] icon or select 
[Transfer] from the [File] menu.

2. The [Transfer] dialog is displayed.  
Select [Memory card] for [Transfer 
Device] and [Screen Data] for 
[Transfer Data].

3. Click the [Detail Setting] button.  
Select a computer serial port to be 
used and a baud rate between the 
computer and the memory card 
(ZM-1REC).  Click [OK].

4. Click the [PC <->] button.  Screen 
data comparison starts between the 
memory card (ZM-1REC) and the 
computer.

Screen Data Transfer between Memory Card (ZM-1REC) 
and LCD Control Terminal ZM Series
With a ZM-300

With a ZM-42 to 82

For the description of screen data transfer between a memory card (ZM-1REC) and a 
ZM-300, see “Chapter 2 ZM-300 Operations” in the ZM-300 User’s Manual.

For the description of screen data transfer between a memory card (ZM-1REC) and a 
ZM-42 to 82, see the ZM-42 to 82 User’s Manual (“16. Operat ion of ZM-42 to 82 Main 
Menu” in “1 Hardware Specif ications”).
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Screen D
ata Transfer
Transfer of Other Data

This section explains options for [Transfer Data] other than [Screen Data].

I/F Driver (Extension: “*.tpb”)
Only when the screen data is transferred to the ZM series first, the I/F driver file 
is also transferred.  Afterwards, I/F driver file transfer will be executed 
automatically if the PLC model in the screen data is changed.

Transferring Procedure

1. Click the [Transfer] icon or select [Transfer] from the [File] menu.

2. The [Transfer] dialog is displayed.  Select [I/F Driver] for [Transfer Data].

3. Click the [PC ->] button.  The [Open] dialog is displayed.  Select the I/F driver 
file corresponding to the PLC model.

The list below shows PLC models and their corresponding I/F drive files.

When the editor software (ZM-71SE) has been updated, choose [I/F Driver] for 
transfer to the ZM series.

PLC model File

MITSUBISHI A series link MelAnA.tpb

A series CPU MelACpu.tpb

A series (OPCN1) MelAnA_J.tpb

A series (CC-LINK) Mel_CC.tpb

QnA series link MelQnA.tpb

QnA series CPU MelQCpu.tpb

QnA series (CC-LINK) Mel_CC.tpb

QnA series (Ethernet) MelQnA_E.tpb

QnH (Q) series link MelQnA.tpb

QnH (A) series CPU MelQHCpA.tpb

QnH (Q) series CPU MelQHCpQ.tpb
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MITSUBISHI QnH (Q) series (CC-Link) Mel_CC.tpb

QnH (Q) series (Ethernet) MelQnA_E.tpb

FX series CPU MelFx.tpb

FX2N series CPU

FX1S series CPU

FX series link (A protocol) MelFx_A.tpb

Net10 MelNet10.tpb

A link + Net10 MelAnA.tpb

SHARP JW series Sharp.tpb

JW100/70H COM port

JW20 COM port

JW (FL-Net) JW_FL.tpb

OMRON SYSMAC C Sysmac.tpb

SYSMAC C (OPCN1) Sysmac_J.tpb

SYSMAC CV SysmacFs.tpb

SYSMAC CS1

SYSMAC CS1 DNA Cs1Dna.tpb

HITACHI HIDIC-H HidicH.tpb

HIDIC-S10/2α HidicS.tpb

HIDIC-S10/ABS

HIDIC-S10 (OPCN1) HidicS_J.tpb

MATSUSHITA MEWNET Mewnet. tpb

YOKOGAWA FA500 Yokogawa.tpb

FA-M3

FA-M3R

FA-M3/FA-M3R (Ethernet) FAM3_E.tpb

FA-M3R (FL-Net) FAM3R_FL.tpb

YASKAWA Memobus Membus.tpb

CP9200SH/MP900

TOYOPUC Toyopuc.tpb

FUJI MICREX-F series MicrexF.tpb

MICREX-F series, ZM-41/70 compatible

MICREX-F T link F_TLink.tpb

MICREX-F T link, ZM-41/70 compatible

FLEX-PC series FlexPc.tpb

FLEX-PC  CPU FlexCpu.tpb

FLEX-PC  COM (T) FlexCom.tpb

FLEX-PC (T) FlexPc.tpb

FLEX-PC  CPU (T) FlexCpu.tpb

FLEX-PC (OPCN1) FlexPc_J.tpb

PLC model File
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ata Transfer
KOYO SU/SG Koyo_GE.tpb

SR-T

SR-T (K protocol) Koyo_K.tpb

SU/SG (K-Sequence) KoyoKSeq.tpb

A.B PLC-5 ABPlc.tpb

SLC500

Micro Logix 1000

Control Logix ABCL.tpb

GE Fanuc 90 series Koyo_GE.tpb

90 series (SNP-X) GESnpX.tpb

TOSHIBA T series Toshiba.tpb

TOSHIBA 
MACHINE

TC200 ToshibaC.tpb

SIEMENS S5 SimS.tpb

S5 PG port SimS5PG.tpb

S5, ZM-41/70 compatible SimS.tpb

S7

S7-200 PPI SimS7PPI.tpb

S7-300MPI (HMI ADP) SimMPI.tpb

S7-300MPI (PC ADP)

S7 PROFIBUS-DP SimS7_DP.tpb

TI500/505 SimTI.tpb

TI500/505 (ZM-41/70 compatible)

SHINKO SELMART Selmart. tpb

SAMSUNG SPC series Samsung.tpb

N_plus

SECNET Mewnet.tpb

KEYENCE KZ series link Sysmac.tpb

KZ-A500 CPU MelACpu.tpb

KZ/KV series CPU Keyence.tpb

KZ24/300  CPU kzcpu.tpb

KV10/24  CPU kvcpu.tpb

KV-700  CPU KV700Cpu.tpb

LG MASTER-K10/60/200 LGK10.tpb

MASTER-K500/1000 LGK500.tpb

MASTER-KxxxS LGSCpu.tpb

MASTER-KxxxS  CNET LGCNet.tpb

GLOFA CNET

FANUC Power Mate PowMate.tpb

FATEK 
AUTOMATION

FACON FB series FaconFB.tpb

IDEC MICRO3 Micro3.tpb

PLC model File
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4. Click [Open].  Data transfer starts.  On completion of transfer, bring the ZM 
series to the STOP mode ([Main Menu] (local main) screen).  Check the I/F 
driver model and the version on the screen.

MODICON Modbus RTU Modbus.tpb

YAMATAKE MX series Yamatake.tpb

DMC50 YM_DMC50.tpb

TAIAN TP02 Taian.tpb

SAIA PCD SaiaPcd.tpb

MOELLER PS4 Moeller.tpb

Telemecanique TSX Micro Telway.tpb

Automationdirect DL305 Koyo_GE.tpb

DL305 (K-Sequence) KoyoKSeq.tpb

VIGOR M series VIGOR.tpb

DELTA DVP series DELTA.tpb

Universal serial General.tpb

Universal FL-Net FL_Net.tpb

Simulator UniPlc20.tpb

PLC model File
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Program (Extension: “*.prg”)
The ZM series system program is not transferred automatically with the screen 
data.

Transferring Procedure

1. Click the [Transfer] icon or select [Transfer] from the [File] menu.

2. The [Transfer] dialog is displayed.  Select [Program] for [Transfer Data].

3. Click the [PC ->] button.  The [Open] dialog is displayed.  Select the system 
program file corresponding to the model of the ZM series.

The list below shows the ZM series models and their corresponding system 
files.

When the editor software (ZM-71SE) has been updated, transfer the ZM series 
system program to the ZM series.

Model File Model File

ZM-381SA/382SA Zm38.prg
Zm382.prg 
(128-color mode)

ZM-82T/82TC/82TV/82TVC Zm82.prg

ZM-381S/382S ZM-72TS/72TSC/72TSV/72TSVC

ZM-371SA/372SA ZM-72T/72TC/72TV/72TVC Zm72.prg

ZM-371S/372S ZM-72D

ZM-371TA/372TA ZM-52D Zm52.prg

ZM-371T/372T ZM-42D Zm42.prg 
(Zm421.prg)ZM-362SA Zm36.prg

Zm362.prg 
(128-color mode)

ZM-42L

ZM-362S ZM-43T Zm43.prg

ZM-352D Zm35.prg ZM-43D

ZM-43L

ZM-52HD Zm52h.prg

ZM-62E Zm62e.prg
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4. Click [Open].  Data transfer starts.  On completion of transfer, bring the ZM 
series to the STOP mode ([Main Menu] (local main) screen).  Check the 
system program version on the screen.

Font Data (Extension “*.ftd”)
Only when the screen data to be transferred contains font data that is different 
from the font data in the ZM series, the font data (including the [Main Menu] 
(local main) screen data file) is also transferred automatically.  Afterwards, font 
data transfer will be executed automatically if any changes are made to the font 
data in the screen data.

The list below shows the font types and their corresponding font data files.
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Never turn off the ZM series during system program transfer.

Font File

Japanese Fnt_jpn.ftd

Japanese 32 Fnt_jpn2.f td

English/Western Europe Fnt_eng.f td

Chinese Fnt_twn.ftd

Chinese (simplified) Fnt_chn.ftd

Korean Fnt_kor.ftd

12-point font data is automatically transferred for the fonts of Gothic, 
English/Western Europe (HK Gothic), and English/Western Europe (HK 
Times).  It is not necessary to select these files.
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Temp./PLC2
Only when the screen data to be transferred contains the temperature control 
network/PLC2Way settings that are different from the settings in the ZM series, 
the temperature control network/PLC2 program is also transferred.  Afterwards, 
the temperature control network/PLC2 program transfer will be executed 
automatically if any changes are made to the program in the screen data.

When the editor software (ZM-71SE) has been updated, choose [Temp./PLC2] 
for transfer to the ZM series.

Ex. Font
This option is valid when the screen data contains the Gothic, English/Western 
Europe (HK Gothic), or English/Western Europe (HK Times) font data.  The 
Gothic font data is divided into these three kinds: 12-point data, automatic font 
setting data, and manual font setting data.  The automatic font setting data is 
handled as screen data.  The 12-point data is transferred as font data.  The 
manual font setting data is included in the expansion font data.  When any 
changes are made to the manual font settings in the screen data, select this 
option and transfer the data.

SRAM Data
This option is valid when the ZM series uses an SRAM cassette or built-in 
SRAM.  With this option setting, data is backed up at the time of SRAM cassette 
battery change.  For more information, see the ZM-300 User’s Manual.

Station No. Table
When the temperature control network as well as a temperature controller model 
FUJI: MPC04P is used, the station number table becomes available.  With the 
station number table in use, this [Station No. Table] option becomes valid.  When 
the screen data is transferred to the ZM series first, the station number table is 
also transferred automatically.  It is not transferred automatically afterwards.  
When any changes are made to the table, transfer the table data to the ZM 
series.

However, when [Memory] is selected for [Transfer Device], the expansion font 
data (= manual font setting data) is also transferred as the screen data together 
with the automatic font setting data.
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Ladder Comm. Prg.
This option is valid when [Modular Jack 1 (or 2): Ladder Tool] is selected for 
[QnH CPU Port] as PLC model setting.  When the screen data is transferred to 
the ZM series first, the ladder communication program is also transferred 
automatically.  It is not transferred automatically afterwards.  When the editor 
software ZM-71SE has been updated, choose [Ladder Comm. Prg.] for transfer 
to the ZM series.

Modbus Comm. Prg.
This option is valid when Modbus slave communication is in use.  When the 
screen data to be transferred contains Modbus slave communication settings 
that are different from the settings in the ZM series, the Modbus communication 
program is transferred.  Afterwards, the program transfer will be executed 
automatically if any changes are made to the Modbus slave communication 
settings in the screen data.  When the editor software ZM-71SE has been 
updated, choose [Modbus Comm. Prg.] for transfer to the ZM series.

System Updating

The [Up-date of System] button is provided for updating the entire ZM series 
system.  It is recommended that system updating be executed when the editor 
software ZM-71SE has been updated.

The files below are updated by the [Up-date of System] button.
• I/F driver file
• ZM series system program
• Font data

Follow the procedure below.

1. Click the [Transfer] icon or select [Transfer] from the [File] menu.

2. The [Transfer] dialog is displayed.  Click the [Up-date of System] button.
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3. The following confirmation message appears.

[Transfer only New Data]
Only the data files in the ZM series that are older than the counterparts in 
the transfer data are updated.  Note that no confirmation message 
appears in advance.

[Transfer All]
All data files specified for updating are transferred.  Therefore, transfer 
will be executed even if the transfer data is older than the data in the ZM 
series.  Note that no confirmation message appears in advance.

[Yes]/[No]
When the transfer data is older than or the same as the data in the ZM 
series, the confirmation message is displayed by clicking either button.  
To continue transfer, click [Yes].  To discontinue, click [No].

4. On completion of data transfer, the ZM series is brought to the previous 
state.

Never turn off the ZM series during system updating.
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Online Editing

Online editing means editing screen data on the computer while the ZM series is 
communicating with the PLC and transferring only added or altered data to the 
ZM series.  Since the data to be transferred is limited as mentioned above, 
transfer time will be shortened.

Preliminaries
With ZM-80C

On Ethernet

For the contents of arrangements, see page 5-5.

ZM-80C

RESET

disc

PLC

F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER

Computer

ZM series

Select [Editor Port] for [Modular Jack 1] in the [Modular Jack] dialog selected 
from the [System Setting] menu.

For the contents of arrangements, see page 5-5.

Ethernet

RESET

disc

PLC

F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER

Computer

ZM series
(With ZM-300/ZM-43 to 82)

+
ZM-80NU/80NU2
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Online Editing Procedure

1. Select [On-line Editing] from the [File] menu or the right-click menu.

2. If there is a discrepancy between the screen data on the ZM series and the 
screen data being edited on the computer, the following inquiry message 
appears.  When no discrepancy is found, go to step 4.

3. If transferring the screen data to the ZM series is allowed, click [Yes].  Online 
editing is started after the data is transferred.

4. After online editing is started, the [ON-line RUN] icon on the icon bar and 
[On-line Run] in the [File] menu and the right-click menu become active.

5. When the current screen or window is switched to another during online 
editing, the changed data is automatically transferred from the computer to 
the ZM series.

6. Aside from the automatic transfer mentioned above, you can transfer 
changed data by clicking the [ON-line RUN] icon or selecting [On-line Run] 
from the [File] menu or the right-click menu.

Online editing is performed during screen editing.  Open the desired screen data 
file.

or
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Escaping from Online Editing
When escaping from online editing and going back to normal editing, the 
procedure is the same as used for starting online editing.  Select [On-line 
Editing] from the [File] menu or the right-click menu.  The [ON-line RUN] icon on 
the icon bar becomes inactive.

Screen Data Transfer via Modem

With modems, it is possible to transfer screen data to the ZM series in a remote 
place.

Preliminaries and Procedure
Arrangements

Receive side: ZM series
• Modem (Accessories: RS-232C cable, modular cable, AC adaptor)
• ZM-80C
• RS-232C cross cable (page 5-37)
• ZM-71SE or communication software (HyperTerminal, etc.)

Send side: computer
• Modem (Accessories: RS-232C cable, modular cable, AC adaptor)
• ZM-71SE

Data Transfer Procedure

Receive side: ZM series

1. Connect the modem on the receive (ZM series) side to a computer according 
to the instruction manual.

2. Transfer AT commands to the modem (see the following page).

3. Disconnect the modem from the computer.  Connect the modem to the ZM 
series (see page 5-37).

4. Set a baud rate between the ZM series and the modem (see page 5-36).

Send side: computer

1. Connect the modem on the send (computer) side to a computer according to 
the instruction manual.

2. Start up the ZM-71SE software.  Transfer AT commands to the modem (see 
the following page).

3. Make settings for communications between the computer and the modem 
(see page 5-38).

4. Transfer screen data.  (* Online editing is not allowed.)

ZM series Modem Telephone 
line

Modem Computer
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AT Command Setting
1. Start up the ZM-71SE software.  Select [Send AT command] from the [File] 

menu.  (If the ZM-71SE software is not available on the receive side, follow 
the steps below using communication software such as HyperTerminal.)

2. The [AT command] dialog is displayed.

3. Select a serial port at [Serial Port].

4. Select [AT] from the pull-down menu and click the [Send] button.

5. When [OK] is displayed, the modem and the computer are connected 
normally.

6. Send the commands below.  The setting items and the contents will vary with 
the model of the modem.   Check the settings for your modem.
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AT commands for the receive (ZM series) side

*1 Do not use the XON/XOFF flow control.
*2 This command is required when you turn off the modem power after AT 

command setting.

AT commands for the send (computer) side

*1 Do not use the XON/XOFF flow control.
*2 This command is required when you turn off the modem power after AT 

command setting.

If the settings for your modem are the same as the above, select the 
commands below from the pull-down menu and send the AT commands.

[OK] appears when the commands have been transferred normally.

7. Turning the modem power off deletes the transferred commands.  Therefore, 
select [AT&W0] from the pull-down menu and send it.  [OK] appears when 
the commands have been transferred normally.

Setting items Contents

Result  code presence/absence Q0 (presence)

Result  code display format V1 (word format)

Echo back E1 (yes)

Communication standard select ion B0 (ITU-T standard)

ER signal control &D0 (ER signal normally ON)

Flow control*1 &K0 (No flow control)

Number of calls until arrival S0 = 1 (except for “0”)

Writing to non-volat ile memory*2 &W0 The current operat ion status to be written 
to “STORE PROFILE 0”

Setting items Contents

Result  code presence/absence Q0 (presence)

Result  code display format V1 (word format)

Echo back E1 (yes)

Communication standard select ion B0 (ITU-T standard)

ER signal control &D2 (Line to be disconnected at ER ON → 
OFF)

Flow control*1 &K0

Writing to non-volat ile memory*2 &W0 The current operat ion status to be written 
to “STORE PROFILE 0”

Receive (ZM series) side AT B0 E1 Q0 V1 &D0 &K0 S0=1

Send (computer) side AT B0 E1 Q0 V1 &D2 &K0
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8. If the settings for your modem differ, delete the written AT commands and 
directly enter the AT commands written in your modem’s manual.

9. Enter AT command directly into this field.

Send the AT commands.
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LCD Control Terminal ZM Series Setting
Set a baud rate between the ZM series and the modem.

1. On the [Main Menu] (local main) screen, press [Editor: MJ1].  The [Extended 
Function Setting] screen is displayed.

2. Select the desired baud rate for [Modem Comm. Baud Rate] using the arrow 
buttons [↑]/[↓].  Press the [Setting Finished] button to finish the selection.  
(Options: 4800, 9600, 19200, 38400, 57600, 115200)

3. The [Main Menu] (local main) screen is displayed automatically.  [Modem 
Connect Mode] automatically appears under [Editor: MJ1].

4. When a modem is not used for screen data transfer, specify [Not Used] for 
[Modem Comm. Baud Rate].

After the [Setting Finished] button is pressed, the switches and function switches 
on the [Main Menu] screen do not work for 15 seconds.

Pressing the [Setting Finished] button sends AT commands to the modem 
automatically and sets the baud rate between the ZM series and the modem.

For screen data transfer while a computer is connected with ZM-80C, specify 
[Not Used] for [Modem Comm. Baud Rate].

Editor:MJ1

Tr s. peed : 10B E T
Stat. No. : 192.168.1.6

PORT: 10000
MAC: 0050FF000035

Extended Function Setting

Modem Comm. Baud Rate :

Main Menu

Up

Down

Up Down

Setting
Finished

Not used

Setting Value

Editor:MJ1

Modem Connect Mode

Ethernet Informatio
Trans.Speed : 10B

Stat. No. : 192
PORT: 10000
MAC: 0050FF0000

Pressing [Editor: MJ1] 
brings up the [Extended 
Funct ion Sett ing] screen.

Pressing [Sett ing Finished] 
brings up the [Main Menu] 
(local main) screen again.
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Description of Connections

Connection between ZM Series and Modem

• Connect the ZM-80C to the modular jack MJ1 on the back of the ZM series.
• Connect the RS-232C cable accompanying the modem to the RS-232C 

connector on the back of the modem.
• The cable to connect the ZM-80C and the RS-232C cable accompanying the 

modem should be arranged for by the customer.

Cross Cable Connection
The ZM-80C is a cross cable.  To bring the signal connection to a straight state, 
manufacture another cross cable to be connected.

MJ1

RESET

disc

PW ER OH CD DA
LINE

PW ER OH CD DA

LINE
F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER

1

2

2
3

Receive side

Send side

ZM series

RS-232C cable (straight) 
accompanying the modem

RS-232C cable (straight)
(ZM-80C + cross cable + RS-232C cable accompanying the modem)

Modular cable 
accompanying the modem

Modular cable 
accompanying the modem

Telephone line

Modem

Modem

Telephone line 
modular socket

Computer
(PC)

Telephone line 
modular socket

RD

SD

SG

2

3

5

RTS

CTS

7

8

RD

SD

SG

2

3

5

9-pin connector 
of the modem

* For a modem that is not capable of flow 
control setting, short-circuit RTS and CTS.

Modem (9-pin) ZM-80C (9-pin)

Signal Pin  No. Signal Pin No.
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Connection between Modem and Telephone Line

Connect the modular cable accompanying the modem between the modular 
jack (LINE) for telephone line on the back of the modem and the telephone line 
modular socket.  If the distance between the modem and the telephone line is as 
long as tens of meters, data transfer failure may occur.

Connection between Modem and Computer

Connect the RS-232C cable accompanying the modem between the RS-232C 
connectors on the back of the modem and on the computer.

Screen Data Transfer
1. Start up the ZM-71SE software.  Open a screen data file to be transferred.

2. Click the [Transfer] icon or select [Transfer] from the [File] menu.

3. The [Transfer] dialog is displayed.

4. Check [  MODEM].  Click the [Detail Setting] button.

5. The [Modem Comm. Setting] dialog is displayed.

[Serial Port] (COM1 - COM8)
Select a serial port.

[Baud Rate] (9600, 19200, 38400, 57600)
Select a data transfer rate between the computer and the modem.

RD

SD

SG

3

2

7

RTS

CTS

4

5

RD

SD

SG

2

3

5

25-pin connector 
of the modem

* For a modem that is not capable of flow 
control setting, short-circuit RTS and CTS.

Modem (25-pin) ZM-80C (9-pin)

Signal Pin No. Signal  Pin No.
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[TONE/PULSE]
Select [TONE] (pushbutton) or [PULSE] (dial) according to the telephone 
line type in use.

[Telephone No.]
Specify the telephone number of the receiver.

[Dial timeout] (sec)
Set a timeout period until a normal response is given from the receiver.  
The default is 60 seconds.

6. When the dialog setting is concluded, click [OK].  The [Transfer] dialog is 
displayed again.

7. Click [PC ->] for [Transfer].  Screen data transfer starts.

Transfer Error Messages Displayed on ZM-71SE
The following error messages are added associated with the modem function.  If 
any occur, the message is displayed on the ZM-71SE.

When screen data transfer with a modem is executed while the [Main Menu] 
(local main) screen is displayed, a message “Transferring Data” appears at the 
bottom left of the screen.  The message disappears on completion of transfer.  
For about 15 seconds after the message disappears, the switches and the 
function switches on the [Main Menu] screen do not work.

Error message Symptom and solution
No response from target. • Check the connection with the other end for 

power-on/-off  or cable disconnect ion.
• Timeout may occur before a response is 

returned.  Extend the timeout period.

The circuit is cut. The telephone line is disconnected on the 
other end.

Command error A command that is not applicable to the target 
modem is transferred.

The target line is busy. The target line is busy.
The telephone number is not specified. Set the telephone number.

Cannot detect dial tone. The response is NO DIALTONE.
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After Screen Data Transfer

When screen data transfer has been completed, allow the ZM series to 
communicate with the PLC and check whether the data has been received.

Connection

The D-sub 25-pin connector is required for connection with the PLC.

Screen Check

When the ZM series is in communication (RUN mode) with the PLC, the ZM 
series brings up the created screen data.

When the [Main Menu] (Local Main) Screen is 
Displayed:
The ZM series stops communication with the PLC (in the STOP mode), and is 
not in the RUN mode.  Press the [SYSTEM] key on the right or at the bottom of 
the ZM series.  Menu options are displayed in a line vertically or horizontally.  
Press the [F1] (MODE) key next.  The status is switched to the RUN mode, and 
the ZM series starts communication with the PLC.

For the cable to connect the PLC and the ZM series, see each ZM User’s Manual.

For using the universal serial communication, Ethernet communication, or other optional 
communication interface units, refer to their respect ive manuals.

BR

BR

BR

S
Y
S
T
E
M

M
O
D
E

B
A
C
K
 L
T

2002-4 -1  09:23:30

SYSTEM PROG. VER. 1.000
FONT
VER.1.300/1.000/1.000
          HK Gothic

I/F DRV VER.1.210
     MELSEC AnA/N/U

Editor:MJ1

Connection : 1:1
Signal Level : RS232C

PLC Stat.No. : 0

Baud Rate : 19200
Data Lebgth : 7

Stop Bit : 1
Parity : Even

Send Delay : 0 msec

Main Menu V 7 1 0 i T

System Information

PLC Type : MITSUBISHI A Series link
Comment :

Screen Data
    Information
Size: 5832704

SRAM/Clock

Ethernet

Card
Menu

I/O Test

Error : Stop
Time-Out : 0.50 sec

Retry : 3

Ethernet Information
Trans.Speed : 10BASE-T

Stat. No. : 192.168.1.68
PORT: 10000
MAC: 0050FF000035

BR

BR

BR

S
Y
S
T
E
M

M
O
D
E

B
A
C
K
 L
T

RUN mode
5-40



Chapter 5  Transfer

5

After Screen D
ata Transfer
If an Error Occurs:
The following error message will be displayed due to faulty communication cable 
connection or PLC or ZM series parameter setting mismatch.  Check for these 
probable causes and restart communication (RUN).

If the following error message is displayed, a screen number that does not exist 
may be specified in the read area memory address “n + 2.”  After the ZM series 
starts communication (RUN mode) with the PLC, it displays the screen specified 
in the read area address “n + 2.”  Check and correct the setting in the memory 
address.

POWER

F1

F2

F3

F4

F5

F6

F7

SYSTEM

Communication Error

Time-Out
Screen No. : Received Code No. :

R E T R Y

POWER

F1

F2

F3

F4

F5

F6

F7

SYSTEM

Check

Screen No. Error
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Preliminaries

This chapter explains the procedure for printing the ZM series screen data file 
from the computer.

Available Printers

Any printer that is available in the Windows environment can print from the 
ZM-71SE editor.

Preliminary Steps

Follow the steps shown below.

The procedures of connecting a printer to the ZM series and printing the screen data file 
from the ZM series are not explained here.  For more information on printing from the ZM 
series, see “Chapter 15 Print” in the ZM-71SE Instruction Manual (Function).

These printers available in the Windows environment may not be used for 
printing from the ZM series.  Please take note of this.

Prepare the printer.Refer to the 
above.

Environment sett ing

Select and print the data.

Page 6-2

Page 6-4

Connect a printer to the computer.

Select [Printer Setting] from the [File] 
menu.  The [Option Setting] dialog is 
displayed.  Set printing environment data 
in the dialog.

Select [Print] from the [File]  menu.  
The [Print Setting] dialog is 
displayed.  Choose the desired data 
and start printing.
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[Option Setting] Dialog

Select [Printer Setting] from the [File] menu.  The [Option Setting] dialog 
containing the following options is displayed.

The following setting items are included.

[  Screen Output]
Screen images are printed.

[  List Output]
Items set for the screen are printed.

[  Table Print]
The table of screen images is printed.  When this option is checked, the 
[Screen Output] and [List Output] options are not active.

[  Reverse]
The screens are printed in reverse video.  Only the white and black portions 
are reversed.

[  Monochrome]
If the printed screen data is difficult to see, check this box.  Legibility may be 
improved.
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Options Under [Page Setting]

[Left Margin] [Right Margin] [Upper Margin] [Bottom Margin]
Enter the desired values for each option.  The size of the printed screen 
depends on the settings of [Left Margin] and [Right Margin].

[  Header]
This option is checked ( ) as default.  The PLC type and file name are 
indicated automatically.  The header setting can be changed as desired.

[  Footer]
This option is unchecked ( ) as default.  When a footer should be printed, 
check the box.

[Page No.] (Left/Center/Right)
Page numbers are printed in any of the three positions.  When page 
numbers should not be printed, uncheck the box.

[Font Size]
Set this option to determine the character size.  The default value is “10.”

[Print Setup] Dialog

Clicking [Printer Setting] brings up the [Print Setup] dialog.  Set paper size, and 
portrait or landscape mode.
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Print Procedure

[Print Setting] Dialog

Select [Print] from the [File] menu.  The [Print Setting] dialog is displayed as 
follows:

The following setting items are included.

[  System Setting] (See page 6-9.)
Click this option for printing the system setting data.  The tile list is also 
printed out.

[  List of Memory Use] (See page 6-10.)
Memory use by screens and screen edit items is printed.

[  Use Cross-reference] (See page 6-10.)
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Memory addresses are printed to the following edit items.

• Message
When messages are printed, memory addresses used in relay mode are 
also printed.

• Graphic Library (valid when [  Screen Output] is checked)
When graphic library is printed, memory addresses used in graphic relay 
mode are also printed.

• Page, direct, and screen blocks
When page, direct or screen blocks are printed, or when relay-sub mode is 
used, the corresponding memory addresses are also printed.

[  Net Table (Ethernet)]
This option is valid when Ethernet is set.  Check the box when printing the 
network table for Ethernet.

[  Net Table (PLC)]
This option is valid when [Mitsubishi: Net10] or [OMRON: SYSMAC CS1 
DNA], etc. is selected.  Select this option when printing the network table.

[ Multi-Languages]
The option is valid when “2” or more is selected for [Changing Characters].  
Select this option when printing the multi-language edit window.

[  Screen] (0 to 1023)
Check the box when printing screen images or items set for the screens.

[  Message] (0 to 23 (group))
Messages grouped by edit numbers are printed.

[  Pattern] (0 to 1023)
Check the box when printing patterns.

[  Graphic Library] (Group No.: 0 to 9, Graphic No.: 0 to 255)
Check the box when printing graphics in the graphic library.

[  Page Block] [  Direct Block] [  Screen Block] [  Macro Block] 
[  Data Block] [  Multi-Overlap] [  Data Sheet] [ Screen Library]

Select these options when printing respective items.  Settings in the range of 
0 to 1023 are valid.

[  Temp./PLC2 Net Table] (0 to 31)
This option is valid when the temperature control network or PLC2Way 
function is used.  Select this option when printing the temperature control 
network or PLC2Way table.

[  MR400 Format (Call)] (1 to 128)
This option is valid when the ZM series is connected to the barcode printer 
“MR400.”  Select this option when printing the MR400 format table (call).

[  MR400 Format (Register)] (1 to 128)
This option is valid when the ZM series is connected to the barcode printer 
“MR400.”  Select this option when printing the MR400 format table (register).
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[  Modbus Slave Table] (0 to 255)
This option is valid when Modbus slave communication is in use.  Select the 
option when printing the Modbus slave memory table.

[  Animation] (0 to 1023) (For the ZM-300 series except for ZM-352D)
Select this option when printing the frame that is defined with an animation 
number.  The frame used for the specified animation number can be printed.

[Start Page]
Specify the first page number to be printed.

[Option Setting] Button

Clicking this button brings up the [Option Setting] dialog.  For an explanation of 
the options, refer to “[Option Setting] Dialog.”

[Print] Button

Click this button.  Printing is executed as specified.
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Printing the Currently Opened Window

Select [Present Window Printing] from the [File] menu.  At the same time, a 
printing start command is given and the currently opened window is printed out 
as specified in the [Option Setting] dialog.

When the [Memory Address Use] List Is Opened
The [Memory Address Use] list is displayed on the editor window as follows:

However, it is printed out as below by clicking [Present Window Printing].

Set the options in the [Option Setting] dialog in advance.  (Select [Printer 
Setting] from the [File] menu).

ZM-71SE  Ver 2.00   DATE [2002/02/26] TIME [11:30:58]
Selected PLC : MITSUBISHI : ACPU Port File Comment :
File Name : D:\ZM-300data\ZM-300DEMO_ZM-381SA.Z37

[Memory Address Use/Cross-reference]
D00000  -  D09999

D00000 Comm. Parameter:Read Area
D00001 Comm. Parameter:Read Area
D00002 Comm. Parameter:Read Area
D00003 Buffering Area:Sample Control
D00050 Comm. Parameter:Write Area
D00051 Comm. Parameter:Write Area
D00052 Comm. Parameter:Write Area
D00100 Screen:No 5:Base;Num. Display:Div 0
D00100 Screen:No 5:Base;Num. Display:Div 0
D00100 Screen:No 5:Base;Num. Display:Div 0
D00100 Screen:No 5:Base;Num. Display:Div 0
D00100 Screen:No 5:Base;Num. Display:Div 0
D00100 Screen:No 5:Base;Num. Display:Div 0
D00101 Screen:No 5:Base;Num. Display:Div 0
D00102 creen:No 5:B se;Num Displ y:Div 0
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Printing Examples

Screen Output

List Output

ZM-71SE  Ver 2.00   DATE [2002/02/26] TIME [11:30:58]
Selected PLC : MITSUBISHI : ACPU Port File Comment :
File Name : D:\ZM-300data\ZM-300DEMO_ZM-381SA.Z37

ZM-71SE  Ver 2.00   DATE [2002/02/26] TIME [11:30:58]
Selected PLC : MITSUBISHI : ACPU Port File Comment :
File Name : D:\ZM-300data\ZM-300DEMO_ZM-381SA.Z37
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Table Print

System Setting

ZM-71SE  Ver 2.00   DATE [2002/02/26] TIME [11:30:58]
Selected PLC : MITSUBISHI : ACPU Port File Comment :
File Name : D:\ZM-300data\ZM-300DEMO_ZM-381SA.Z37

ZM-71SE  Ver 2.00   DATE [2002/02/26] TIME [11:30:58]
Selected PLC : MITSUBISHI : ACPU Port File Comment :
File Name : D:\ZM-300data\ZM-300DEMO_ZM-381SA.Z37

*** System Setting ***
Selected PLC: Universal Serial
File Name:S:\V7DEMO\V7DEMO_V712iS.V7
File Comment:

[Comm. Parameter]
      Connection                 : 1:1
      Baud Rate                   : 9600BPS
      Data Length                 : 8-bit
      Parity                      : Even
      Stop Bit                    : 1-bit
      Signal Level               : RS232C
      Read Area                  : $u00000
      Write Area                  : $u00050
      Calendar                    : $u16330
      Ethernet                    : Not Use     
      Trans. Mode                 : Sum Check 
      Text Process                : LSB->MSB
      Code                        : DEC 
      Busy Time                   : 0 msec
      Send Delay Time            : 0
      Top Address for Read Clear  : 4000
      No. of Words for Read Clear : 20
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Memory Use List

When [Use Cross-reference] is Checked:
Ex.: Messages

ZM-71SE  Ver 2.00   DATE [2002/02/26] TIME [11:30:58]
Selected PLC : MITSUBISHI : ACPU Port File Comment :
File Name : D:\ZM-300data\ZM-300DEMO_ZM-381SA.Z37

[Multi Overlap ]
[Message ]
[Macro Block ]
[Direct Block ]
[Data Sheet Page ]

[MR400(Register) ]

[Graphic   1 ]
[Graphic   3 ]
[Graphic   5 ]
[Graphic   7 ]
[Graphic   9 ]

7
0

41
0
0
2
0

48

3
0
0
0
0

2
0
7
0
0

0

0
0
0
0
0

ZM-71SE  Ver 2.00   DATE [2002/02/26] TIME [11:30:58]
Selected PLC : MITSUBISHI : ACPU Port File Comment :
File Name : D:\ZM-300data\ZM-300DEMO_ZM-381SA.Z37

Cross-reference
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Ex: Graphic Library

When [Animation] is Checked:

ZM-71SE  Ver 2.00   DATE [2002/02/26] TIME [11:30:58]
Selected PLC : MITSUBISHI : ACPU Port File Comment :
File Name : D:\ZM-300data\ZM-300DEMO_ZM-381SA.Z37

Cross-reference

ZM-71SE  Ver 2.00   DATE [2002/02/26] TIME [11:30:58]
Selected PLC : MITSUBISHI : ACPU Port File Comment :
File Name : D:\ZM-300data\ZM-300DEMO_ZM-381SA.Z37
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Please use this page freely.
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 Tools
Tools

The [Tool] menu provides useful tools for screen creation.  If you are familiar with 
these tools, you can edit screen data quite easily.

[Tool] Menu List

The [Tool] menu provides the following functions:

Tool Uses Ref.

Error Check Files are checked for errors. Page 7-2
Memory Use Memory used by the current editing file is 

displayed.
Page 7-4

Memory Address Use Memory addresses used in the current editing file 
are displayed.

Page 7-5

Change Memory Memory addresses used in the current editing file 
are changed.

Page 7-7

Screen Image
(Make Pattern)

The current screen image is registered as 
patterns.

Page 7-10

Screen Image
(Copy to Clipboard)

The current screen image is copied to the 
clipboard.

Page 7-12

Paste Bitmap Bitmap files are imported into screen data files (as 
patterns).

Page 7-14

DXF File Convert DXF f iles are imported into screens. Page 7-17

Convert to Rich Text 
Format

The printing image of a screen data is saved as a 
Rich Text f ile format.

Page 7-19

Add Video Menu 
Video

The ZM-300 video display funct ion can be created 
and placed with ease.

Page 7-21

Custom Part Custom parts are registered. Page 7-21
Tray Parts or items to be used often are stored in trays. Page 7-23

Tag Table Set the tag table when using Allen Bradley’s 
Control Logix.

Page 7-26
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Function 1: Error Check

The files can be checked for errors.  If any error is found, its cause and remedies 
are displayed.

Operation Procedure
1. Select [Error Check] from the [Tool] menu.

2. The check result is indicated in the [Error Check] window.

3. To close this window, click the [×] (Close) button at the upper right, or the 
click the upper left icon and select [Close].

Reading the Error Check List
When an error occurs, the following [Error Check] window is displayed.

Each line is composed of the following information:
E (error)/W (warning): Layer: Function: Division No.: Error occurring position

When no error is found, “No Error” is displayed.

E: Error
W: Warning
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Checking Method for Details

To check the details of the error or warning, double-click the line, or click the line, 
right-click the mouse and select [Detail] from the menu.  The [Error Check] 
dialog shown below is displayed.

Right-click Menu

[VIEW]
It is possible to jump to the error occurring position.

[Detail]
Refer to the explanation above.

[Latest Information]
The latest error information is displayed.

[Error Restoration]
This item is valid for some kinds of errors.  For more information, consult 
your local distributor.

Difference between Error and Warning
[E] denotes an error.  If you attempt to transfer data indicated with [E] to ZM, 
“Data has some error.” is displayed and data cannot be transferred correctly.  
Be sure to transfer data without any error.

[W] denotes a warning.  This is a moderate error that is detected due to 
discrepancy in setting but does not cause any problem in operation on ZM.

Double-click.

From the right-click menu
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Function 2: Memory Use

This window indicates the remaining memory and items registered in screen 
data files.

Operation Procedure
Opening/Closing the List of Memory Use

1. Select [Memory Use] from the [Tool] menu.

2. The [List of Memory Use] window is displayed.

3. To close this window, click the [×] (Close) button at the upper right, or the 
click the upper left icon and select [Close].

Bringing Up the Detailed List of Edit Items

1. Click the box of the desired item on the [List of Memory Use] window.

2. The list of items is displayed.  The boxes with registration are shown with an 
“∗.”

3. To go back to [List of Registration Number], click the [  List] box.

The list of the desired items can also be chosen from the [Display] menu while 
the [List of Memory Use] window is displayed.
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Function 3: Memory Address Use

It is possible to retrieve memory addresses that are used in the files currently 
being edited.

Operation Procedure
1. Select [Memory Address Use] from the [Tool] menu.

2. The [Memory Address Use] dialog is displayed.  Specify the memory 
addresses for [Start] and [End].

3. Click [Word] or [Bit] for [Display].

4. When [  Cross-reference] is checked, cross-references are shown.  If no 
cross-reference is necessary, do not check the box.

When [Cross-reference] is checked:

When [Cross-reference] is not checked:
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5. If you would like to see the memory use of the current screen, check [  
Display only [Screen/n]].  To check the memory use of the entire file, do not 
check this box.

6. Click [OK].  The [List of Memory Address Use] is displayed.

7.  To close this window, click the [×] (Close) button at the upper right, or the 
click the upper left icon and select [Close].

About “∗”
When [  Cross-reference] is not checked, “∗” is shown for the used memory 
addresses.  Double-clicking an asterisk mark (∗) brings up the screen or dialog 
to which the memory address is allocated.

By locating the cursor on an asterisk mark (∗), the mouse turns into “+MEM” 
mark and the corresponding address is indicated on the status bar.

Address where the “+MEM” cursor is placed
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Function 4: Change Memory

Change All Memory
Memory addresses allocated to the current editing file can be changed 
simultaneously.  Up to 10 different memory ranges can be set.

Operation Procedure

1. Select [Change Memory] from the [Tool] menu.  The sub-menu is displayed.  
Click [Change All Memory].

2. The [Change All Memory] dialog is displayed.

3. Check the numbered box.  Memory address selection becomes available.

4. Choose [Bit] or [Word].  Memory change is performed in units of bits or words 
as selected.

5. Enter the first address of the memory addresses to be changed for [Before 
Change Start Mem. No.].  Likewise, enter the last address of the memory 
addresses to be changed for [Before Change End Mem. No.].

6. Enter the desired first address after change for [After Change Start Mem. 
No.] in the same manner.

7. Click [Option] and set the items of which memory addresses should be 
changed.  For more information, refer to the next section.

8. Click [Change].  The specified memory addresses are changed at one time.
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[Change Item Select] Dialog

Click [Option] in the [Change All Memory] dialog.  The [Change Item Select] 
dialog is displayed.

The following items are included.

[Screen] [Macro Block] [Data Block] [M.LIB] [Data Sheet] [S.LIB] 
[Temp. CTRL/PLC2Way] [System Setting]

Check the desired items.  If a range should be set, enter the numbers for 
[Start] and [End].

[ Compare Station No.]
This option is valid when [1 : n] (multi-drop) is selected for [Connection].  
Check this box to include port numbers of the PLCs for memory change.

[  Compare CPU No.]
Choose this option for setting the CPU number of PLC.

[  Compare Temp. Control Station No.]
This option is valid when the temperature control network is used.  Check 
this box to include the port number of the temperature controller.

[Compare File No.] [Compare Record No.]
Choose these options for specifying addresses in the memory card.

This is not available during on-line editing.
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Changing Memory of Selected Items Only
Memory addresses of the selected screen items in the current editing file can be 
changed simultaneously.

Operation Procedure

1. Select the desired items for memory change.

2. Select [Change Memory] from the [Tool] menu.  The sub-menu is displayed.  
Click [Selected Item].

3. The [Change All Memory] dialog is displayed.

4. Check the numbered box.  Memory address selection becomes available.

5. Choose [Bit] or [Word].  Memory change is performed in units of bits or words 
as selected.

6. Enter the first address of the memory addresses to be changed for [Before 
Change Start Mem. No.].  Likewise, enter the last address of the memory 
addresses to be changed for [Before Change End Mem. No.].

7. Enter the desired first address after change for [After Change Start Mem. 
No.] in the same manner.

8. Click [Option] and set the items of which memory addresses should be 
changed.  For more information, refer to the next section.

9. Click [Change].  The specified memory addresses are changed at one time.

Option Setting

Click the [Option] button in the [Change All Memory] dialog.  The [Change Item 
Select] dialog shown below is displayed.  The following items are included.

[  Compare Station No.]
This option is valid when [1 : n] (multi-drop) is selected for [Connection].  
Check this box to include port numbers of the PLCs for memory change.

[  Compare CPU No.]
Choose this option for setting the CPU number of PLC.

[  Compare Temp. Control Station No.]
This option is valid when the temperature control network is used.  Check 
this box to include the port number of the temperature controller.

[Compare File No.] [Compare Record No.]
Choose these options for specifying addresses in the memory card.
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Function 5: Copy Image to Pattern

The screen being displayed on the computer can be registered as a pattern.  A 
pattern can be pasted to a screen change switch to show the target screen 
instead of text, or can be used in various ways.

Operation Procedure
1. Bring up the desired screen.

2. Select [Screen Image] from the [Tool] menu.  The sub-menu is displayed.  
Click [Make Pattern].

3. The [Size Change] dialog is displayed.

4. Specify [X Size] and [Y Size] of the pattern.  They can be set to the screen 
size.

The following edit items can be registered as patterns:
• Screen
• Graphic library
• Multi-overlap
• Data block
• Screen library

When a normal overlap is placed on the screen, the [Layer] dialog appears first.  
Choose the editing layer to be displayed.  Click [OK].  The [Size Change] dialog 
is displayed.
Ex:
For a screen with three normal overlaps:
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5. Choose the number of colors of the pattern.
ZM-42 to 82 8, 16, or 128 colors
ZM-300 8, 16, or 128, 32,000-colors

6. Click [OK].  The message “Will Register to No. x” appears.  When the 
registration destination is the correct one, click [Yes].  To change the 
destination, click [No].

Clicking [No] brings up the [Specify Bitmap Read] dialog.  Specify the desired 
number.

Ex.: If the following screen is converted to a pattern, it changes as shown 
below.

Pattern size [120 × 90]

Screen size [800 × 600]
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Function 6: Copy Image to Clip Board

The screen being displayed on the computer can be copied to the clipboard.  
The copied image can be imported into word processing software, etc.

Operation Procedure
1. Bring up the desired screen on the computer.

2. Select [Screen Image] from the [Tool] menu.  The sub-menu is displayed.  
Click [Copy to Clipboard].

3. The following dialog is displayed.  When reversing the monochrome color on 
a screen, click [Yes].  When keeping the present color, click [No].

4. The screen is copied to the clipboard automatically.

The following edit items can be copied to the clipboard.
• Screen
• Graphic library
• Multi-overlap
• Data block
• Screen library

When a normal overlap is placed on the screen, the [Layer] dialog is displayed 
after this message.  Select display or non-display for the base screen and each 
overlap, and click [OK].
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Import of Screen Image into Word Processing Software

Ex.: This section explains how to paste a ZM-300 screen to a Microsoft Word 
screen.

1. Copy the desired screen to the clipboard as explained above.

2. Start the Word software.

3. Move the cursor to the position to place the copy.

4. Select [Paste] from the [Edit] menu.  The copied image is pasted on the 
document.  The size of the image can be changed by dragging a handle.
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Function 7: Paste Bitmap

By specifying a bitmap file (with extensions “.BMP”), the bitmap can be pasted to 
the screen.  The bitmap file is imported as a pattern automatically.

Operation Procedure
1. Select [Paste Bitmap] from the [Tool] menu.  The [Open a Bitmap File] dialog 

is displayed.

2. Click the desired bitmap file and then [Open].  The bitmap can be previewed 
in the dialog.

3. The bitmap size is indicated in the dialog.  Choose the desired number of 
colors from [Color Type for Convert].

ZM-42 to 82 8, 16, or 128 colors
ZM-300 8, 16, or 128, 32,000-colors

4. Click [OK].  A mover tool and a dotted box of the bitmap size are displayed 
on the screen.

5. Click the mouse in the position for placing the bitmap.  The bit map is pasted 
to the screen.  The same bitmap can be pasted repeatedly by clicking the 
mouse while the mover tool is displayed on the screen.

For information on the setting items in the dialog, see the next page.
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Bitmap Preview Dialog

The following setting items are included.

[  Dither]
The option is valid when an option other than [32K] is selected for [Color 
Type for Convert].  When [  Dither] is checked, middle tones are corrected.  
Dithering is performed to make the colors of the bitmap closer to the original.

[  Pseudo Gradation]
When this option is checked, pseudo gradation is used.  When the [Detail >>] 
button is clicked, the detail setting is possible.  The following items are 
included.

Note that the bitmap is pasted each time you click the mouse.  To cancel bitmap 
placement, click the [Select] icon and clear the mover tool.

When the size of a bitmap file is too large, it is partitioned automatically and 
stored in several boxes when it is registered in pattern editing.  The capacity of 
patterns that can be registered in one box is 128 KB.

When changing the setting of [  Use 3D Parts] in the [Environment Setting] tab 
window of the [Unit Setting] dialog, the pallet is changed and colors of the placed 
bitmap are also changed.  To reset, paste the bitmap again.
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[Adaptive Error Diffusion]
Error diffusion adapted to each individual part of the image can be 
performed.  This function places emphasis on smoothness of image 
more than the following [Error Diffusion] does.

[Error Diffusion]
If a color of the source image is not included in the color pallet, two bits in 
similar colors are placed alternately so as to reproduce the color.

[Nothing]
A pallet similar to the source image color is selected.

[Ordered Dithering]
Error diffusion pattern is made closer to regular pattern.

[Diffusion] (0 - 3, standard: 1)
Specify a level of diffusion.

[Color] (0 - 15, standard: 8)
Assign priority to brightness or color for depicting.  When a specified 
number gets smaller, brightness takes priority over color.

[Green] (0 - 15, standard: 8)
Assign priority to blue-green-based color or red-yellow-based color for 
depicting.  When a specified number gets smaller, green-based color 
takes priority over other colors.

[Convert]
Clicking this option (depressed) brings up the preview of the placed image.

[Redraw]
When any setting [  Dither] or [  Pseudo Gradation] has been changed, 
click [Convert] (depressed) and [Redraw].  The image according to the 
change is previewed.

When [  Use 3D Parts] is checked in the [Environment Setting] tab window of 
the [Unit Setting] dialog with the ZM-42 to 82 series, this option and [  Dither] 
cannot be selected.  The [  Pseudo Gradation] display is automatically 
selected.
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Function 8: DXF File Convert

A DXF file can be imported into a screen data file as graphic data.

Operation Procedure
1. Select [DXF File Convert] from the [Tool] menu.  The [DXF File Select] dialog 

is displayed.

2. Choose the desired DXF file and click [Open].  The [Convert Setting] dialog 
is displayed.

3. Specify [Zoom] in the range of 10% to 250%.

4. When setting conditions for file import, click [Detail Setting].

For more information, see the next section.
7-17



Chapter 7  Useful Techniques
5. Click [OK].  The cross cursor with the dot-lined square is displayed.  Clicking 
any location on a screen shows the converted DXF file as the grouped 
drawings.

[Detail Setting] Options

The following items are included.

[Standard for Fitting Diagram into Screen]

[Area of Diagram]
Only areas containing graphics are read during file import.

[Size of Plan]
Drawing sizes are read during file import.

[Area of Diagram (making)]
If the graphics could not be read in the above manner, the ZM-71SE sets 
an area and the data within the area is read.

[Display (in making DXF file)]
([8-color Display] [16-color Display] [256 (or more)-color Display])
Choose the option specified for DXF file creation.

[Way of Display]

[  Not Convert Texts]
Choose whether or not text in DXF file is converted.  (1 character is 
converted into 16 × 16 dots.)

[  Ignore Dots]
Choose whether or not dots as graphics are ignored.

These figures are converted to the drawings in the ZM-71SE editor.   The drawings 
are grouped.  The displayed color depends on the original DXF file.
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[  Ignore Measure Line]
Choose whether or not the dimension lines in DXF file are ignored.

[  Monochrome Reverse (Display Color)]
Choose whether or not inverting to black-on-white is executed.  (When a 
file is imported into the ZM-71SE editor, white-on-black or some other 
color line is used for display as default.)

[  Ignore Particular Layer]
Choose whether or not layers not to be converted are specified.  Specify 
the names of such layers instead of their numbers.

[Graphic Library No.]
[  Specify]

When blocks are used in a DXF file, choose whether or not they are 
registered in the graphic library.

After setting, click [OK].

Function 9: Convert to Rich Text Format

The contents of the screen data can be converted to the Rich Text file (with 
extensions [.RTF]) as the same image as printing.  This function makes it 
possible to check the screen setting or the image picture without using paper.  
Finally, only the necessary data can be printed out through a word processor 
application software on a personal computer.
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Operation Procedure
1. Click [Convert to Rich Text Format] in the [Tool] menu.  The following dialog 

is displayed.

2. Check each item to convert to a Rich Text file, and input the range of each 
editing item.

The setting items, [  Screen Output], [  List Output], [  Table Print], 
[ Reverse], are same as printing.

3. Specify the name and the location of a Rich Text file at the [File Name] 
setting.  When changing the name or the location, press the [Refer] button.

4. When the dialog setting is concluded, click [OK].

Data Sheet cannot be converted to Rich Text file.

For more information, see “Chapter 6 Print.”

The size of the Rich Text file made by the ZM-71SE editor is much larger 
because it is not compressed.  The size will become smaller if the Rich Text file 
is saved as the normal document file (e.g.: [.doc] in Microsoft Word) by the 
[Save As] command.
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Function 10: Add Video Menu

When a video display item is used, it is possible to automatically place an 
overlap using a macro command for video quality adjustment.

Function 11: Custom Part

A maximum of 512 items or parts can be registered in the custom parts file (with 
extensions “.Z3F/Z7F“).  The file is independent of screen data files, and 
registered parts can be used for creating screens.

Operation Procedure
Registration in Custom Parts File

1. Choose and copy the part or item to be registered as a custom part.

2. Select [Custom Part] from the [Tool] menu.  The sub-menu is displayed.  
Click [New].

3. 512 boxes are displayed in the [Custom Part] window.

4. Click the box for registration.  Its number is highlighted in red.  Paste the 
copied part or item in the box that is highlighted.  The copied part or item is 
pasted.

For more information, see “Chapter 18 Video Display” in the ZM-71SE Instruction Manual 
(Function).
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5. Click the [Save] icon for saving the file.  The message, “Will save custom 
part file [untitled]?” appears.

6. Click [Yes].  The [Select Custom Parts File to Save] dialog is displayed.  
Specify the file name and click [Save].

7. To delete the registered custom parts, click the box for deletion, and push the 
[Delete] key or click [Delete] on the [Edit] menu.

Pasting a Custom Part to the Screen

1. Select [Custom Part] from the [Tool] menu.  The sub-menu is displayed.  
Click [Open].

2. The [Select Custom Parts File] dialog is displayed.  Choose a file and click 
[Open].

3. The [Custom Part] window is displayed.  Select [Tile] from the [Window] 
menu.  The [Custom Part] window and the screen edit window are tiled.

4. Drag the desired custom part from the [Custom Part] window to the screen 
edit window.

Tile the screen edit window and the tray (icon display) window.  Hold down the 
CTRL key, and drag the chosen item to the tray window.  The item can also be 
registered in this manner.

Drag and place.
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Function 12: Tray

Parts or graphics can be stored in 15 trays.  These parts or graphics can be 
used in different screen data files.  Since the trays are registered in the 
environment file (“Zm71e.try”), they can be used any time until the file is deleted.

Operation Procedure
Registration/Deletion in/from Trays

1. In a screen edit window, choose a part or graphic to be registered in a tray 
and copy it.

2. Select [Tray] from the [Tool] menu.  The [Tray (Icon Display)] window is 
displayed.

3. Paste the copied part or graphic to the tray window.  The copied item is 
reduced to an icon and displayed in the window.

4. When deleting a tray icon, click it and press the DEL key, or select [Delete] 
from the [Edit] menu.

Tile the screen edit window and the tray (icon display) window.  Hold down the 
CTRL key, and drag the chosen item to the tray window.  The item can also be 
registered in this manner.

Hold down the [Ctrl] key 
and drag.
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Pasting Part in Tray to Screen

1. Tile the screen edit window and the tray window.

2. Drag the tray icon of the desired part to the screen edit window.  The part is 
pasted to the window.

Tray Display Change

• Right-click on the tray window and select [Change Window].  The [Tray (List 
Display)] window is displayed instead of the [Tray (Icon Display)] window.  
The contents of each tray can be viewed.  Clicking [Change Window] again 
brings back the tray (icon display) window.

Drag and place.
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• Right-click a tray icon on the [Tray (Icon Display)] window and select 
[Property].  The [Property] dialog is displayed.  The information on the 
registered part and its image are displayed.  When necessary, a comment 
(name) can be attached by entering data for [Comment].
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• Click [Display] on the [Tray (Icon Display)] window.  The display format can 
be selected from four options.

[Large Icon] Large tray icons are displayed.

[Small Icon] Small tray icons are displayed.

[List] All tray icons are listed.

[Detail] The number of registered parts and bytes, and the top part of 
each tray are displayed.

Function 13: Tag Table

This option is valid only when Allen-Bradley’s Control Logix is selected for the 
PLC model.
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File Management

This feature makes it possible to copy or delete any screen data file.  It is also 
possible to copy only a selected item included in a file, such as a screen, 
message, or graphic.  It is also possible to copy parts between part files.  A 
screen data file can be partitioned for storage on floppy disks, and can be 
recombined.

File Management Outline

File Management Functions
The following options are included in [File Managing].

1. Selected screens or messages can be copied to a different file.

2. Parts can be copied between part files.

3. Entire files can be copied.

4. Unnecessary files can be deleted.

5. A file occupying large amounts of memory can be partitioned and 
recombined.

6. Files can be compared.

1
2
3
4
5

6
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Files for File Management
The following two types of files can be handled by the file management function.  
When copying files, specify two files with the same extensions.

1. Screen data file (with extensions “.Z37” or “.Z71”).

2. Part file (with extensions “.Z3P” or “.Z7P”).

Screen Data File Management
One file can be copied entirely.  Also, selected items in the file can be copied to 
a different file.

With screen data file management, the items are copied by the categories 
shown in the [Item] menu: such as “screens,” “graphics library,” “messages, 
“patterns,” “tiles,” and “external characters.”  In addition, animation tables, 
system setting and color pallets are copied.

The file management function is not available for files with different extensions.

AAAAA
BBBBB
CCCCC
DDDDD
EEEEE
FFFFF
GGGGG
HHHHH
I I I I I
JJJJJ
KKKKK

AAAAA
BBBBB
CCCCC
DDDDD
EEEEE
FFFFF
GGGGG
HHHHH
I I I I I
JJJJJ
KKKKK

AAAAA
BBBBB
CCCCC
DDDDD
EEEEE
FFFFF
GGGGG
HHHHH
I I I I I
JJJJJ
KKKKK

Copying only 
screen No. 2

Messages File “AAA”
Screens

Patterns

File “BBB”
Screen
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In addition to the function as mentioned above, the following are also available:
• Copying files
• Deleting files
• Partitioning a file occupying large amounts of memory
• Combining the partitioned sections of a file

Part File Management
The desired parts can be copied between part files.

File Management: Screen Data File

1. Select [File Managing] from the [File] menu.

2. Select [Screen Data File].  The [File Manage (Screen Data)] dialog is 
displayed.

3. Specify the desired files for [Copy Source] and [Copy Target] respectively.  
Files can be selected by clicking [Reference].

4. Click [OK].  The [File Managing] dialog is displayed.  The contents to be 
displayed vary somewhat depending on the selected item from the dialog.
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Copying Screens between Windows
• The copy source and target file windows are displayed as shown below 

when any of the following items are selected from the [File Managing] dialog.
Screen, Graphic Library, Multi-Overlap, Data Block, Pattern, Data Sheet, 
Screen Library, Animation Frame

• The copy source and target file windows are displayed.  The source file 
window is placed above the other.  Perform copying as described below.

1. Click the screen to be copied in the source file window.  The screen 
number is highlighted in red.

2. If necessary, scroll the target file window until the desired file number 
comes into view.

3. Drag the selected screen to the desired target box number.  The copied 
screen is displayed in the target position by releasing the mouse.

In the case of a screen, only the screen is copied.  The pattern or graphic library 
that is used on the screen is not copied.
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4. To copy consecutive screens, click the first number of the source 
screens.

5. While holding down the SHIFT key, click the last number of the source 
screens.  The screens for the first number to the last number are selected 
at one time.

6. Drag one of the selected screen to the copy target box.  All the selected 
screens are copied to the target file window at one time by releasing the 
mouse.

Hold down the 
SHIFT key and 
click.

Click f irst.
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7. When selecting screens to be copied individually, click the screens one 
by one while holding down the CTRL key.

8. Drag one of the selected screens to the copy target box.  All the selected 
screens are copied to the target file window at one time by releasing the 
mouse.

Change to a Different Item

1. Select [Change Display] from the [Display] menu with the screen list window 
open.

2. The [Change Display] dialog is displayed.  Choose the desired item and click 
[OK].

3. The corresponding window appears.

Even if screens to be copied are selected individually, their copies appear in the 
consecutive boxes in the target file window.
7-32



Chapter 7  Useful Techniques

7

 File M
anagem

ent
Copying Items by Designating Item Numbers
• When any of the following items are selected from the [File Managing] 

dialog, the screen list windows are displayed and then the [No. Designation] 
dialog is displayed on them.

Message, Macro Block, Page Block, Direct Block, Screen Block, System 
setting options

• Specify the desired numbers for [Copy Source No.] and [Copy Target No.], 
and click [OK].  Copying is executed.

Change to a Different Item

1. Select [Copy by Specifying No.] from the [Edit] menu.

2. The [File Managing] dialog is displayed.  Click the desired option and then 
[OK].

3. The [No. Designation] dialog for the option is displayed.

Other Setting Items
The following items can be copied to the clipboard when they are selected.

Animation Table, System Setting, Color Pallet
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[File] Menu for File Management

Clicking [File] brings up the following menu items.

• [Copy Target New]
Creates a new copy target file.

• [Copy Target Open]
Opens a copy target file.

• [Copy Target Save]
Overwrites the currently opened copy target file.

• [Copy Target Save As]
Click this option to give a different name to the currently opened copy target 
file for saving.

• [Copy Source Open]
Opens a copy source file.

• [Quit File Managing]
Quits [File Managing].

• [Quit Application]
Quits the ZM-71SE editor.

Before closing the copy target file window, choose whether or not to save the 
copied data.
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File Management: Part File

1. Select [File Managing] from the [File] menu.

2. Select [Parts File].  The [File Manage (Part)] dialog is displayed.

3. Specify the desired files for [Copy Source] and [Copy Target] respectively.  
Files can be selected by clicking [Reference].

4. Click [OK].  The following dialog is displayed.
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5. Choose the item for copy and click [OK].  The copy source and target file 
windows are displayed.  The source file window is placed above the other.

6. Click the part to be copied in the copy source file window.  The part number 
is highlighted in red.

7. Drag the part to the desired box in the copy target file window.  (If a part has 
already been registered in the box, the message for overwriting confirmation 
appears.)

Copy of Parts in Consecutive Numbers
1. Click the first part of the parts to be copied.
2. While holding down the SHIFT key, click the last part of the parts to be 

copied.
3. Check that all the desired parts numbers are highlighted.  Drag one of them 

to a box in the target file window.
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Copy of Parts by Selecting them Individually
1. While holding down the CTRL key, click parts to be copied one by one.
2. Check that all the desired parts numbers are highlighted.  Drag one of them 

to a box in the target file window.  The copied parts are displayed 
consecutively.
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[File] Menu for Parts File Management

Clicking [File] brings up the following menu items.

• [Copy Target New]
Creates a new copy target file.

• [Copy Target Open]
Opens a copy target file.

• [Copy Target Save]
Overwrites the currently opened copy target file.

• [Copy Target Save As]
Click this option to give a different name to the currently opened copy target 
file for saving.

• [Copy Source Open]
Opens a copy source file.

• [Quit File Managing]
Quits [File Managing].

• [Quit Application]
Quits the ZM-71SE editor.

Before closing the copy target file window, choose whether or not to save the 
copied data.
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File Management: File Copy

1. Select [File Managing] from the [File] menu.

2. Select [File Copy].

3. The [File Copy] dialog is displayed.  Specify the desired files for [Copy 
Source] and [Copy Target].

4. [When [ Copy the Environment File] is checked, the environment file for the 
copy source file (with extensions “.ENV”) is also copied.  The environment 
file is not copied when unchecked.

5. Click [OK].  Copying is executed.
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File Management: File Deletion

1. Select [File Managing] from the [File] menu.

2. Select [File Delete].

3. The [File to Delete] dialog is displayed.  Specify the file to be deleted.

4. Click [Delete].  The confirmation message is displayed.

5. Click [Yes].  The file and its environment file of the same name are deleted.
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File Management: File Division and Combination

The ZM-300 series can create a screen data file of great capacity.  With the 
ZM-42 to 82 series, it is also possible to create a screen data file  using large 
amounts of memory depending on the model.  However, such a file cannot be 
stored on only one floppy disk.  Using [File Divide] and [File Combine], the file 
can be divided into several sections for storage on floppy disks and can be 
recombined.

File Divide
1. Select [File Managing] from the [File] menu.

2. Select [File Divide].  The [Divide File] dialog is displayed.

3. Specify the desired file name for [Divide Source].  Clicking [Refer] brings up 
the [File to Divide] dialog.  A file can be selected from the dialog.

4. Specify the desired file name for [Store Target].  The extensions “.div” is 
provided.

5. Select the floppy disk capacity from [1.44 Mbyte], [1.25 Mbyte], or [720 
Kbyte].

6. Click [OK].  The file is divided automatically.

At this time, the divided sections of the file cannot be stored on floppy disks.  
Store them on the hard disk once.

The divided sections of the file are stored in the format of “file name (n).div.”  
Save all the files to recombine them.
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File Combine

1. Select [File Managing] from the [File] menu.

2. Select [File Combine].  The [Combine File] dialog is displayed.

3. Specify the desired file name for [Combine Source].

4. Click [Open].  At the same time, the file name before division is entered for 
[Store Target].

5. Click [OK].  The sections are combined automatically.

When the divided sections of a file are stored on different floppy disks, copy 
them to one directory in advance.

The divided sections of the file are stored in the format of “file name (n).div.”  
Specify one of the divided sections.
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File Management: File Comparison

Two screen data files are compared and the result is reported.

File Comparing
1. Select [File Managing] from the [File] menu.

2. Select [File Comparing].

3. The [File Comparing] dialog shown below is displayed.  Specify the files to 
be compared.

4. Click [OK].  File comparison is started and the result is reported in the 
window shown below.  When the files are consistent, “Data corresponds.” is 
displayed.

It is not possible to compare files of the ZM-300 series and the ZM-42 to 82 
series.
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About Menu Items
[Save to TEXT File] ([File] Menu)

The contents after comparison can be saved in a text file (extension “*.txt”).

[Display Condition Setting] ([Display] menu)

Selecting this command brings up the [Display Condition Setting] dialog.

[Number of Display] (10 to 100) (default: 20)
The number of errors specified is displayed in the report window.

For errors having detailed information, the details (discrepant items) can be 
checked in the following procedure.

• [Display] → [Detail]
• Double-click the error.
• Right-click the error and select [Detail].

• [Enter] key on the keyboard
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Simulator

Outline

• Normally, when a ZM series screen has been created, perform an operation 
check connecting the ZM series to the PLC.  However, when the Simulator is 
used, it is possible to perform an operation check on a newly created screen 
without the PLC.  The Simulator runs on Windows, and it is possible to 
set/reset bit device as well as input data to word device.

• By starting up ZM-71SE and the simulator simultaneously on a computer, 
either software can be operated independently by switching the active 
window.  The operations of the parts placed on the screen can be checked 
just between the computer and the ZM series.  Therefore, both screen 
creation and debugging become possible on one computer and time can be 
saved.

• A test sheet based on ZM screen data memory called an “SIM file” is created 
on each screen.  One SIM file is created for each screen.  Additionally, an 
SIM file can be created based on the memory addresses of any edit screen 
(system setting, normal overlap, multi-overlap, data block, or data sheet).

Composition

The Simulator is automatically installed when screen creation software 
ZM-71SE is installed.

Operation Procedure

Possible Simulation
• Automatically create SIM files based on the screen data file currently open 

on your personal computer, and perform a test.  (See page 8-2.)
- This is used when the Simulator is started up from the ZM-71SE editor.
- The SIM file created cannot be saved.

• Create a new SIM file and perform a test.  (See page 8-3.)
- An SIM file can be created freely.
- The SIM file created can be saved.

It is not possible to use the Simulator for the ZM series of universal serial 
communication.  For the ZM series with Ethernet communication, the simulation 
via Ethernet is not possible; however, it is possible with serial communication 
using the ZM-80C cable.

SIM File
A memory file used to read and write PLC memory on the Simulator screen.
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Operation Procedure
Creating SIM File(s) Automatically

Refer to the following flowchart for the procedure of starting up both ZM-71SE 
and the Simulator, creating SIM file(s) based on the currently open screen data 
file, and then performing a test.  SIM files are always kept in their most recent 
statuses as determined by screen transfer or update of screen data.  It is not 
possible to save SIM file(s) due to the fact that it is automatically updated each 
time it is started up.

Open screen data on ZM-71SE.

Transfer screen data from the ZM-71SE editor to the ZM 
series.

Transferring screen data and the I /F driver page 8-4
Connecting a personal computer with the ZM seriespage 8-5

Start up the Simulator.

Starting up the Simulator from ZM-71SE page 8-6

Start Simulator communication.

Starting communication with the ZM series page 8-7

Use the SIM file to perform a test.

Testing bit memory page 8-18
Testing word memory page 8-19

Stop Simulator communication.

Stopping communication with the ZM series page 8-8
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Creating a New SIM File

The procedure for creating a new SIM file and then performing a test is shown 
below.  The SIM file name, memory to be tested, etc., can be set freely.  The 
contents of the SIM file created here can be saved.

Open screen data on ZM-71SE.

Transfer  screen data from the ZM-71SE editor to the ZM 
series.

Transferring screen data and the I/F driver page 8-4
Connecting a personal computer with the ZM seriespage 8-5

Start up the Simulator.

Starting up the Simulator from the windows menu page 8-6

Start Simulator communication.

Starting communication with the ZM series page 8-7

Create a new SIM file.

Creat ing a new SIM f ile page 8-15

Use the SIM file to perform a test.

Test ing bit memory page 8-18
Test ing word memory page 8-19

Stop Simulator communication.

Stopping communication with the ZM series page 8-8
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Preliminaries

Transferring Screen Data and the I/F Driver
Transfer the screen data and the I/F driver from the ZM-71SE editor to the ZM 
series for debugging on the Simulator.

1. Click the [Transfer] icon in the tool bar.  The [Transfer] dialog is displayed.

2. Check the [  Use Simulator] box and choose [Screen Data] for [Transfer 
Data].  Transfer the screen data.

3. After transferring the data, check that PLC I/F driver type is “UNIPLC20” on 
the Main Menu screen of the ZM series.

2002-4 -1  09:23:30

SYSTEM PROG. VER. 1.000
FONT
VER.1.300/1.000/1.000
          HK Gothic

I/F DRV VER.1.210
     UNIPLC

Connection : 1:1 Baud Rate : 19200

Main Menu Z M - 3 7 1 T A

System Information

PLC Type : SHARP JW link module
Comment :

Screen Data
    Information
Size: 5832704

Error : Stop
Time-Out : 0.50 sec

Retry : 3
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Connecting a Personal Computer with the ZM Series
Connect the ZM series to a computer using the data transfer cable (ZM-80C).  
On the ZM series side, use MJ1 (modular jack 1).  On the ZM-71SE editor, 
select [Modular Jack 1: Editor Port] in the [Modular Jack] dialog selected from 
the [System Setting] menu.

UNIPLC20
This is a type of I /F driver used when a personal computer and the ZM series 
communicate using the Simulator.  The file named [UNIPLC20.TPB] is automatically 
transferred.

ZM-80C

D-sub 9pin

8pin

MJ1
RESET

disc

F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER

Computer ZM series

Modular

[Modular Jack 1: Editor Port] in the [Modular 
Jack] dialog under [System Setting]

It  is possible to use the Simulator only when ZM series and PLC are 1 : 1 connection.  I t 
is impossible to use the Simulator when ZM series and PLC are 1 : n or n : 1 connection.
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Starting up and Closing

Starting Up the Simulator from ZM-71SE
1. Use ZM-71SE to open the screen data file that will be tested with the 

Simulator.

2. Click the [Start Simulator] icon, or go to the [File] menu and click on [Start 
Simulator].  The simulator will start with the SIM files which are automatically 
displayed.

Starting Up the Simulator from Windows Menu
1. Click in the order of [Start], [Programs], [Zm-71s] and [Simulator].

2. The simulator initial screen is displayed.

or
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Closing a Simulator File
1. Click [Exit] in the [File] menu of the Simulator or the [Close] button.

2. The file is closed.  When the file has been modified, a message as to 
whether the file is to be saved appears.

Starting and Stopping Communication

Starting Communication with the ZM Series
Click the [Start Simulator] icon, or go to the [File] menu of the ZM-71SE editor 
and click on [Start Simulator].  The communication is automatically started.  To 
confirm whether the communication is established or not, check if the 
[Communication] icon is depressed.  Also, “Comm.” is displayed on the status 
bar of the Simulator during communications.

When the Simulator is started from the Windows menu, the communication is 
not started.  In this case, start the communication by following the steps 
described below.

Or, double-click the simulator program icon to open a simulator file.

or

or Depressed
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1. Choose [Start] from the [Communication] menu.  Or click the 
[Communication] icon.  The ZM series has established the communication 
with the computer.

2. The simulator state displayed on the screen is changed from [Stop] to 
[Comm].

Stopping Communication with the ZM Series
1. Choose [End] from the [Communication] menu.

Or click the [Communication] icon.  The communication between the ZM 
series and a personal computer stops.  The Main Menu screen is displayed 
on the ZM series automatically.

2. The Simulator state on the status bar is changed from [Comm.] → [Stop].  To 
restart communications, click [Start] from the [Communication] menu or click 
the [Communication] icon.
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Setting Items Necessary for Communication

This describes how to make settings necessary for communication between a 
personal computer and the ZM series.  To check the communication setting, 
stop the communication with the ZM series.

Click on the [File] menu.  Make settings for [PLC Type...], [Baud Rate], [COM 
Port], and [Memory Setting...].

1. PLC Type
Set the PLC type corresponding to the screen data transmitted to the ZM 
series.

2. Baud Rate
Set the baud rate for communication between a personal computer and the 
ZM series.  (This has no relation to the actual communication baud rate 
between the ZM series and the PLC.)

3. COM Port
Set the RS-232C COM port for the personal computer.

If the following settings are made incorrectly, the ZM series and personal 
computer will not communicate normally.
8-9



Chapter 8  Applications for ZM-71SE Editor
4. Memory Setting
The starting address is either 0 or 1 for each device.  Determine the starting 
address for the device and then enter the correct number of words.  For 
example.  If you check [  Make All Data Cleared], all the memory values for 
the SIM file will be cleared.

It is also possible to clear all the memory values by going to the [Edit] menu to [Initialize 
Memory].

Start ing up the Simulator from the ZM-71SE editor and automatically creating an SIM file:
• The PLC model set in screen data is displayed in the [PLC Type] tab window.
• The necessary words for [Memory Sett ing] are set automatically based on the memory 

data used in screen data.
• Addit ionally, if there is a change in the memory used by screen data, the setting value 

can be corrected by going to the [File] menu to [Apply ZM Data].
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Be careful when sett ing [Memory Setting...]  in the following cases:

When using EM (expanded memory) in OMRON’s SYSMAC (CV)
Follow the registrat ion procedure below when using mult iple banks:

To set bank number 0 as 100 words, and bank number 1 as 150 words:
1. Enter “02” for the bank number and “100” for the number of words.
2. Then, enter “1” for the bank number and “150” for the number of words.  The newly 

entered values will be displayed in place of the values entered in 1.

To check and see if registration took place normally af ter you are finished making 
entries, enter “0” and then “1” for the bank number, and confirm that the 
corresponding word number for each is displayed.

When using F (f ile register) for each type of Sharp’s PLC
Follow the registrat ion procedure below when using mult iple f iles:

To set file No. 1 as 100 words, and file No. 2 as 150 words:
1. For file No. 1, enter “100” for the number of words.
2. Then, for file No. 2, enter “150” for the number of words.

The newly entered values will be displayed in place of the values entered in 1.

To check and see if registration took place normally af ter you are finished making 
entries, enter “1” and “2” for the f ile number, and confirm that the corresponding word 
number for each is displayed.

When using W (user file) for two types of FUJI’s MICREX-F
Follow the registrat ion procedure below when using mult iple user files:

To set file No. 30 as 100 words, and f ile No. 31 as 150 words:
1. For file No. 30, enter “100” for the number of words.
2. Then, for f ile No. 31, enter “150” for the number of words.  The newly entered values 

will be displayed in place of the values entered in 1.

To check and see if registration took place normally af ter you are finished making 
entries, enter “30” and “31” for the file number, and confirm that the corresponding 
word number for each is displayed.

EM
Bank No.

0 0
No. of word

F
File No.

1 0
No. of word

W
File No.

30 0
No. of word
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About SIM Files

An SIM file is a memory file used to read and write PLC memory on the 
Simulator screen.

Timing of Creating or Updating SIM File Automatically
When the ZM-71SE editor and the Simulator are both started up, an SIM file is 
created automatically.  SIM file update timing:
1. When you go to the [Tool] menu for ZM-71SE and select [Start Simulator] 

(or)
2. When screen data is sent from ZM-71SE (or)
3. When you go to the [File] menu for the Simulator and select [Apply ZM Data]
Update occurs automatically in both cases, followed by the display of an SIM file 
sheet on screen.

Names of Automatically Created SIM Files
An automatically created SIM file is saved temporarily in “\TEMP.”  The following 
file names are attached to these SIM files.

The memory data for items set on each 
screen is saved here.

The memory data for items set on each 
multi-overlap is saved here.

The memory data for normal overlaps 
within each screen is saved here.

The memory data for data display set on 
each block is saved here.

The memory data for data display set on 
each data sheet is saved here.

The memory data for the system memory 
of the screen data f ile is saved here.

The memory data for the buffering area 
is saved here.

Scrn0010.simSIM

Mlib0010.simSIM

ScrnOv00100.simSIM

Dtblk0010.simSIM

Tyo0010.simSIM

System.simSIM

Buffer.simSIM

Screen number

Multi-overlap number

Screen number
Overlap number

Data block number

Data sheet number

When SIM f iles are automatically created, all the SIM files in the “\TEMP” folder are 
deleted.  If you have created a SIM file, do not save it in the “\TEMP” folder.
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Memo
If you close a sheet mistakenly, go to the [File] menu to [Open...] and choose the 
SIM file that you wish to re-open from the directory displayed.
 

Sheet Configuration
Test sheet (SIM file) configuration is as follows:
This example includes the format display, item display, and comment display.

1. Address.................... Shows the address.
2. Setting value............ Shows the setting value currently entered.
3. Display type............. Shows the display format currently set.
4. Data length .............. Shows the data length currently set.
5. ASCII display........... Shows the current setting value in ASCII code.
6. Item display.............. Shows the placement layer, division number, and item 

number.
7. Comment display..... Shows comments.  For an automatically created SIM 

file, this display shows the switch/lamp OFF 
characters, as well as the allocated functions.

1 2 3 4 5 6 7

Sheet background color
Gray sheet. .... ..... .An SIM f ile automatically created from the ZM-71SE editor or an SIV f ile
White sheet ... ..... . A newly created SIM file

Be careful about the following points at the gray sheet.
• The display type returns to the default whenever transferring the data.
• It is impossible to add a new memory.
• It is impossible to save the setting value.

To perform these operations, create the white sheet.  (However, even with white 
sheet, the setting data in the internal memory ($s) cannot be saved.)
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Changing the Display on a Sheet
In an automatically created SIM file(s), or SIM file(s) created from an SIV file, 
memory set for different items is jumbled together on one sheet.  It is possible to 
display this jumbled memory on a personal computer according to such 
classifications as item type, function, etc.

1. Go to the [View] menu and click on [Display Sheet].  4 menu items will be 
displayed.

2. Click on your preference.  Only the filtered results will be displayed on your 
personal computer.

3. You can perform the same operation by clicking on the tool bar icons.

All Display
Word

Select Item Display
Bit

It is possible to combine [Word] or [Bit] and [Comment Display].
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Creating a New SIM File
The procedure for creating a new SIM file is described below.  When a new file is 
created, you can set the memory that is displayed on the sheet as you wish.  
You can also choose the SIM file name.  It is possible to create a new SIM file 
even when an automatically created SIM file, or an SIV-based SIM file, is 
already displayed on the personal computer.

1. Go to the [File] menu and click on [New...].  Or, click on the [New (Word)] 
icon on the tool bar.

2. A sheet with the title [Untitled x] is displayed.  Add or insert the memory that 
you wish to test.

Saving a Newly Created SIM File
The procedure for saving a newly created SIM file is described below.

1. Click on the [File] menu.  There are two options, [Save] and [Save As...].

2. Choosing [Save]:
If this is the first time that you have saved, the [Save As...] dialog will be 
displayed.  Enter a file name and click on [Save].

3. Choosing [Save As...]:
The [Save As...] dialog will be displayed.  Enter a file name and click on 
[Save].
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Adding or Inserting Memory in the Sheet
The procedure for adding memory that you wish to test to the end of the test 
sheet, or for inserting this memory between lines, is described below.

Memo
It is only possible to add or insert into a newly created sheet (white sheet).
 

1. Adding
Go to the [Edit] menu and click on [Add].  Or, click on the [Add] icon.

Inserting
Click on the line where you wish to insert memory to highlight it.  Go to 
the [Edit] menu and click on [Add].  Or, click on the [Insert] icon.  In either 
case, the [Add] or [Insert] dialog shown to the right will be displayed.  
1024 pieces of memory can be registered on 1 sheet.
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2. Check the [  Bit Device] box only when adding memory in bit units.  When a 
bit device is specified as [Top Memory] (described later), a hyphen and bit 
number are displayed at the end of the memory, and a test can be performed 
in bit units.

3. Specify the top address for the memory that will be added to [Top Memory].

4. If you click on the [  Block] box, it is possible to continuously add multiple 
pieces of memory.  Enter the amount of memory that you wish to add in 
[Number of Memories].  The maximum setting is 1024.

5. When adding word device, make settings for display format, data length, 
with/without sign, and ASCII code display/non-display.  For the display 
contents, see page 8-13.

6. Click [OK].  For adding, memory will be added to the end of the sheet.  For 
inserting, memory will be inserted immediately above the line that was 
selected.

Testing

Testing will be explained using the screen shown below as an example.

Note that if this box is not checked and a bit device is specified as [Top Memory] 
(described later), bits are treated as word units, and memory will be added in 
16-bit increments.

F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER

1

M101

Auto

2

M102

Manual

3

M103

Run

4

M104

Stop

12345

12345

12345

12345

12345

12345

12345

12345

12345

12345

Lamp
Switch

Data display
8-17



Chapter 8  Applications for ZM-71SE Editor
Testing Bit Memory
• From the ZM series to the Simulator

Use the Simulator to check the output signal.  As an example, M101 is set as 
output memory on the [Auto] switch on the far left side.

1. Press the [Auto] switch on the far left side of the ZM series.

2. M0101 will turn on at the Simulator.  The left icon will change from [OFF] 
to [ON].

• From the Simulator to the ZM series
Use the Simulator to turn the lamp on.  As an example, M104 is set for lamp 
“4” on the far right side.

1. On the Simulator, click the [OFF] icon for M104 (lamp memory).

2. The icon will change from [OFF] to [ON].  Lamp “4” will light up on the ZM 
series.

When pressing the space key with the memory selected by cursor, the bit device can be 
reversed.  Regarding the way to reverse multiple bits simultaneously, see page 8-20.
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Testing Word Memory
The procedure for changing the numerical value of the data display is described 
here.  As an example, the value D100 will be changed.

1. Double-click on the setting value on the data display.

2. The [Write Memory] dialog is displayed.

3. Enter the desired number into the box.

4. If necessary, change the format of the value that you enter.  As an example, 
“123” is entered in decimal notation.

5. Click on [OK] to close the dialog.

6. “123” is displayed on the ZM series.

Double-click here.
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Testing Overlap
1. Display the screen that has an overlap setting on the ZM series.

2. Click on one of the icons for [Overlap 0] to [Overlap 2].  The registered 
overlap will be displayed on the ZM series.

3. Once the overlap is displayed on the ZM series, the overlap test sheet with 
items registered on it will be displayed on the Simulator.  If you click on the 
same icon again, the overlap on the ZM series and the overlap test sheet on 
the Simulator disappear.

4. When an overlap switch registered on the screen is pressed, the overlap will 
be displayed on the ZM series.  An overlap test sheet will be displayed on 
the Simulator at the same time.

Note:
In the case of a multi-overlap with the internal command setting, it is impossible 
to open the overlap from the Simulator.
 

Setting/Resetting Multiple Bits Simultaneously
1. Select the bit memory that will be set/reset (multiple select ions possible).  Select 

sequentially by holding down the [SHIFT] key and clicking the mouse.  Select 
randomly by holding down the [CTRL] key and clicking the mouse.

2. Pressing the space bar sets the bits.
3. Pressing the space bar again resets the bits.

Entering Numerical Values for Multiple Pieces of Memory Simultaneously
1. Select the memory that you will set numerical values for (multiple selections 

possible).  Select sequent ially by holding down the [SHIFT] key and clicking the 
mouse.  Select randomly by holding down the [CTRL] key and clicking the mouse.

2. Right-click on any of the lines that are selected, and then click on [Change Sett ing 
Value... ].

3. Set the desired number and click [OK].  The numbers of all the selected lines will be 
changed simultaneously.
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Useful Operations

Creating a New SIM File Using a Shortcut Key
By directly dragging an item displayed on the ZM-71SE editor (such as a switch 
or numerical display) to the Simulator, you can automatically display the 
applicable memory and comments for that item.  The procedure is described 
below.

1. Go to the [File] menu on the Simulator and click on [New] to create a new 
file.  Or, click the [New (Word)] icon to create a new file.

2. Open screen data with the ZM-71SE editor and display the screen that will 
be tested.  As an example, a screen with lamps arranged is shown here.
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3. Click on a lamp to select it, and then hold down the [CTRL] key while 
dragging it to the Simulator.

4. Memory addresses will be displayed as follows in the new file:
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Incrementing or Decrementing Memory Values
It is possible to increment or decrement numerical values of word memory by 
setting the memory counter.

Setting Method

1. To set the memory counter, double-click on the current memory value.  The 
[Write Memory] dialog is displayed.

2. Check the [  Use Memory Counter] box.  The memory counter setting items 
become active.

3. Make the desired entries for [Increment Value] and [Interval Time].  An 
increment value from −1000 to 1000 can be entered.  An interval time from 1 
to 300 can be entered.

4. When the [  Specify the Range] box is checked, it is possible to set the 
upper and lower limits.  The maximum upper limit setting is 2147483647, and 
the maximum lower limit setting is −2147483648.

5. Click [OK] to close the dialog.  A white square-shaped icon will be displayed 
to the left of memory on the sheet.

If  you right-click on the memory that will be set as a timer counter, a menu is displayed.  
From there, it is possible to display a dialog by clicking on [Change Setting Value...] .  The 
same dialog can be displayed by going to the tool bar and clicking on the [Setting Value] 
icon.
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Use Method

1. Click on the white square-shaped icon to the left of memory on the sheet.  
Or, select memory that is set for the memory counter and then press the 
space bar.  The icon will change to a clock indicating that the memory 
counter has started.

2. To stop the memory counter, either click on the clock icon on the left, or 
press the space bar.  The icon will revert to a white square-shape.

Click here.

When the memory counter reaches the upper or lower limit,  it will revert to 0 and continue 
counting.

Setting the Memory Counter for Mult iple Pieces of Memory Simultaneously
1. Select the memory that will be set for the memory counter (multiple selections 

possible).  Select sequent ially by holding down the [SHIFT] key and clicking the 
mouse.  Select randomly by holding down the [CTRL] key and clicking the mouse.

2. Right-click on one of the selected lines and then click [Change Setting Value.. .].
3. Set the memory counter according to the procedure described on the next page.

The way to set/reset multiple bits simultaneously is the same as setting the memory 
counter.

Simultaneously Starting or Stopping the Memory Counters
1. Select all the memory that has a t imer setting.
2. Press the space bar.  All the timers will start  simultaneously.
3. Pressing the space bar again will cause all the timers to stop simultaneously.
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Testing Sampling Mode with a CSV File
By creating simulation data with a CSV file and then reading that data with the 
Simulator, it is possible to display a sampling screen on the ZM series that is 
very close to the actual image.

Conditions for a Test

The following conditions must occur if you wish to perform a test on a ZM series 
screen data file by using a CSV file:

• In the [Buffering Area Setting] dialog the [  Memory Designation] box 
should be checked.

• [Sampling Method] should be [Constant Sample] or [Bit Synchronize].

Notes on Creating a CSV File

• Each sampling data should be entered on one line.

• Memory set for [Sampling Buffer Word No.] in each sampling mode should 
be entered (beginning with the most recent) from the left of each line.

• Only create necessary data on the display.  If a title line or row exists, it will 
not be displayed correctly.

• Do not leave lines or rows blank.  Data in blank lines or rows will be 
displayed as “0.”
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CSV File Setting Example

The following example shows settings for a CSV file created with Microsoft 
EXCEL.

Using buffering area No. 0
Memory Designation D200
Sampling Method Constant sample
No. of Words 4
No. of Samples 100
Store Target Internal buffer
Full Processing Continuous

When a CSV file like this is created with Microsoft EXCEL:

1st sampling data

Word No. 0 Word No. 1 Word No. 2 Word No. 3

When the number of sampling times is smaller than the CSV file data amount:
Example: Sampling frequency is 20 but the CSV file has 60 pieces of data.

[Stop]
The program will stop after displaying 20 pieces of data.  20 points are 
displayed on the ZM series.

[Continuous]
The first 20 pieces of data are cont inuously displayed.
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Read Procedure

1. Go to the [File] menu and click on [Read CSV File].  The [Select CSV File] 
dialog is displayed.

2. Select the file name to read.

3. Set the buffer number for the stored data.  For the setting example on the 
previous page, this setting would be “0.”

4. If the CSV file that is read is one that was created with ZM-CARD Software, 
click on the [  Make from M-CARD SFTE] box.

Note:
“ZM-CARD SFTE” is memory card editor.  This is an application software 
separate from the ZM-71SE editor.
 

5. Click the [Read] button.
• For [Sampling Method: Constant Sample], the data read is immediately 

shown on the ZM series graph.
• For [Sampling Method: Bit Synchronize], the data read will be shown on 

the ZM series depending on whether the sample control memory trigger 
sets or resets the bit.

When writ ing sampling data stored in the memory card as a CSV file (using ZM-CARD 
Software),  time data appears at the far left of each line.  When you check [Make from 
M-CARD SFTE], the time data is not recognized as sampling data and thus, is not read.

For details on the sampling method or sample control memory, see “Chapter 10 
Sampling” in the ZM-71SE Instruction Manual (Function).
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Menu and Icons

Commands included in each menu correspond to the icons as shown below:

File Menu

Edit Menu

6
7
4
5
1
2
3
8
9

10
11
12
13
14

1 2 3 4 5 6 7 8 9 10 11 12 13 14
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Communication Menu

View Menu

Screen Number and Comment Display
The comment registered during screen edit is displayed here.

Click:
Depressed ... .Start
Raised...... .... .End

18
19
20

15
16
17

15 16 17 18 19 20

When a screen is 
selected here, the 
screen shown on 
the ZM series will 
change.
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Right-click Menu
A menu like the one shown here is displayed when the right mouse button is 
clicked.

However, the following menu items are only active for a new file.
• Cut
• Paste
• Delete
• Change Display Address
• Item Setting
• Comment Setting

Help Menu
Help functions are accessible from the [Help] menu.  Information such as the 
operation method can be displayed on the personal computer by clicking on 
[Help Index] and [Help Topics].  Additionally, version information can be checked 
by clicking [About V Simulator] or the [About V Simulator] icon.
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Error List

The following errors may arise on the ZM series screen during communication 
between the ZM series and simulator (computer).

F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER

Communication Error
Error code received : 05

RESET

disc

Numerical Data Entry Screen

Data1

Data2

Data3

Data4

Data5

4 5 6

7 8 9

1 2 3 CLR

0 . + - ENT

Max

Min

Entered value

Communication Error
Error code received : 05

Computer

Simulator
running

ZM series

Num. Data Entry Screen

Message Contents Measures

Check I/F driver
When sending a communicat ion request to 
a personal computer (simulator), there is no 
reply from a personal computer.

Check the following items:
• Wiring between ZM series and personal 

computer
• Settings of baud rate and COM port
• PLC I/F driver on the ZM series side 

(UNIPLC20)
If  the error is not recovered after checking 
the above items, re-start the simulator.

Received Code: 01 Communicat ion error, such as a parity error

A communication error arises between ZM 
series and the computer.  Check if there are 
any adverse effects due to noise, etc.

Received Code: 02 Command error  (unregistered commands)

Received Code: 03 Format error  (characters in nonconforming 
formats)

Received Code: 04 Sum check error

Received Code: 05 Memory address error  (unacceptable 
memory type/address)

Select [Memory Setting] f rom the [File] 
menu and specify the correct memory 
address (used for the ZM series).
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ZM-MDD Transfer Utility

Outline

The ZM-MDD transfer utility is a utility program that is used to update the 
ZM-MDD program.

Composition

The ZM-MDD transfer utility is automatically installed when screen creation 
software ZM-71SE is installed.

What is ZM-MDD?
The ZM-MDD used to change the programmer port into two ports with Mitsubishi A 
series, QnA series or FX series CPU.  This is useful when you would like to connect LCD 
control terminal directly to the CPU of the A series, the QnA series or the FX series.

GD

G
P
P

CPU

1 2 3

RESET

disc

Computer

Slide switch (connecting model selection)
1 : A series (ACPU port)
2 : QnA series (QnACPU port)
3 : FX series
Note: Set the slide switch before turning 

the power on.

Ladder transfer 
cable

Mitsubishi A/QnA/FX series
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Operation Procedure

1. Connect the ZM-1MD2 to the RS-422 connector at Mitsubishi’s A/QnA/FX 
series CPU.

2. Connect the computer and the ZM-1MD2 (on the GPP port side) using the 
ladder transfer cable.

3. Turn the PLC power on.  The ZM-1MD2 is activated at the same time.  (Be 
sure to set the ZM-1MD2 slide switch before turning the power on.)

4. Start up the ZM-MDD transfer utility on the computer, and transfer the 
ZM-1MD2 program file “dpprg.mdd.”

ZM-MDD Transfer Utility

Starting
1. Click in the order of [Start]  → [Programs]  → [Zm-71s]  → [ZM-MDD Transfer 

Utility].

2. The [ZM-MDD Transfer Utility] dialog is displayed.

About “mdd” File
The “mdd” file (“dpprg.mdd”) is located in the “Tpa” folder that is installed with the 
ZM-71SE editor.  To check the program version of the ZM-MDD, the ZM-MDD transfer 
utility must be used.  The latest “mdd” file can be downloaded from Sharp Manufacturing 
Systems’ Web site.

For the procedure of starting and operating the ZM-MDD transfer utility, refer to “ZM-MDD 
Transfer Utility” in the next section.

Do not remove or attach the cable during program transfer.  If communication is 
suspended, turn the power off and on, and transfer the program again.

1

2

3

4

It is possible to start from the ZM-MDD transfer utility shortcut icon.
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Closing
Click the [Close] button in the [ZM-MDD Transfer Utility] dialog.  The ZM-MDD 
transfer utility is closed.

[ZM-MDD Transfer Utility] Dialog
[Select COM Port]

Select the port to be used.

[ZM-MDD Information
Click the [ZM-MDD Information] button.  The following dialog is displayed.  
Check the ZM-MDD program version and the PLC model.

[File Path]
The target location of the ZM-1MD2 program file (“mdd” file) is displayed.  As 
default, “C\PROGRAM FILES\Z3W\Tpa\dpprg.mdd” is selected.  Select the 
desired program file and click the [Refer to] button.  The [Select Program 
File] dialog is displayed.  Select the program to be transferred.

[Send]
Turn the PLC power off and on.  Click the [Send] button.  The program is 
transferred.  When no program to be transferred is selected, the [Select 
Program File] dialog is displayed.  Select the program in this dialog.  The 
communication status (“Connecting to ZM-MDD,” “Transferring the Data,” 
etc. is shown in 2.  During transfer, a bar is shown in 3.  When transfer has 
been completed, “Transfer Finished” is displayed.  To cancel program 
transfer, click the [Cancel Send] button.

When the [ZM-MDD Information] or [Send] button is clicked again after 
communication with the ZM-1MD2 was performed, the message “Time Over for 
waiting Receiving” is displayed.  Turn the PLC power off and on, and try again.

When the [ZM-MDD Information] or [Send] button is clicked again after 
communication with the ZM-1MD2 was performed, the message “Time Over for 
waiting Receiving” is displayed.  Turn the PLC power off and on, and try again.
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The wizard function is provided to aid you in setting, for instance, the entry mode 
or sampling mode, which will be complicated in combination with other parts like 
switches or display areas.  Screens in these modes can be created with ease by 
following the instructions to be given.

Opening the [Wizard] Dialog

Open the [Wizard] dialog when using the wizard function.

Select [Wizard] from the [Part] menu.  The [Wizard] dialog is displayed.

Select the desired part from the list while referring to [Image] and [Explanation] 
in the dialog and click the [OK] button.  Follow the instructions to be given on the 
screen.

Parts available with the wizard function Finished image
9-1



Chapter 9  Wizard
Wizard Usage Examples

Radio Button Creation

This section explains the procedure for creating four radio buttons with output 
memory D100-0 to D100-3.

Radio buttons operate in such a manner that only the button currently being pressed is 
activated in output memory and the others are deact ivated in output memory.

A

B

C

D

D100-0

D100-1
D100-2
D100-3

D100

A

B

C

D

D100-0

D100-1
D100-2
D100-3

D100
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Setting Procedure
1. In the [Wizard] dialog, select [Switch] from the parts list and click the [OK] 

button.

2. Select [Radio Button] and click the [Next] button.
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3. Four types of radio buttons are previewed.

[ON] and [OFF] tab
Open either window to check the image.

Pull-down menu
Select a color as desired.

Click the desired type from the four.  The lower left type is selected in this 
example.  The selected type is enclosed in a red frame.

Click the [Next] button.

4. The selected switch image is displayed.

[Number of Switch]
Select the number of switches.  “4” is selected in this example.

[Memory]
Allocate a memory address to the switches.  “D100” is allocated in this 
example.

Click the [Next] button.
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5. Enter texts to be placed on the switches.

[1] to [4] tabs
Open tab windows one by one and enter texts of the switches in the OFF 
status.  “A,” “B,” “C,” and “D” are entered respectively for the four 
switches in this example.

[Char. Color]
Select a text color from the pull-down menu.

Click the [Finish] button.

6. A cross cursor is displayed.  Click it in the desired position.
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Error Display

This section explains the settings to place an error display, in which errors 
currently occurring will be shown from ten registered messages and placed from 
the top position in order of importance.

Setting Procedure
1. In the [Wizard] dialog, select [Error Display] from the parts list and click the 

[OK] button.

M

1

15 0

M Error 2
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2. Select whether or not error history records are necessary.

It is necessary to know the errors currently occurring in this example.  
Therefore, select [Not Necessary].

Click the [Next] button.

3. Select in which order error messages are to be displayed.  Select [Order of 
Registered Messages (Relay)].

Click the [Next] button.

“(Relay)”: 
The relay mode is established on complet ion of setting.
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4. Four types of message displays are previewed.

Pull-down menu
Select a color as desired.

Click the desired type from the four.  The upper right type is selected in this 
example.  The selected type is enclosed in a red frame.

Click the [Next] button.

5. The selected display image is displayed.

[Target Memory Setting]
Allocate a memory bit for error message display.  “M0” is allocated in this 
example.

[  With Sub-display (Relay-sub)]
Check this when detailed information should be displayed as a 
sub-message.  Uncheck the option in this example.

Click the [Next] button.
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6. Specify the number of error messages (memory bits).

“10” is specified in this example.

Click the [Next] button.

7. Register error messages.

[Message Group No. of Registered Target] (0 - 23)
Specify a message editing group number.

Message registration field
Register error messages.  In step 6, “10” is specified as the number of 
error messages.  Register ten lines of messages.

[Message Color]
Select a message color as desired.

Message registration field

Leave the number setting as default generally.  To change, select a number with 
no registered message.
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Click the [Next] button.

8. Attached parts are available.

[  Scroll Switch]
Uncheck the option if message scroll switches are not necessary.

Click the [Finish] button.

9. A cross cursor is displayed.  Click it in the desired position.
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Trend Graph Display

This section explains the settings to place a trend graph, in which sampling data 
in memory specified as desired (D200 and D201) will be expressed by two lines 
at one-second intervals.

D200
D201

30

50

90

D200
D201 50

Max100

Min 0

Max100

Min 0

60 Max100

Min 0

D200
D201 50
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Setting Procedure
1. In the [Wizard] dialog, select [Trend Display] from the parts list and click the 

[OK] button.

2. Data in the desired memory addresses should be sampled at regular 
intervals.  Select [Store the values from specified addresses into the 
buffering area in LCD Control Terminal and display the area as line graphs.] 
(Trend sampling).

Click the [Next] button.

(Trend sampling): 
Trend sampling function in the sampling mode is established on completion of sett ing.
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3. Four types of graphs are previewed.

Pull-down menu
Select a color as desired.

Click the desired type from the four.  The upper right type is selected in this 
example.  The selected type is enclosed in a red frame.

Click the [Next] button.

4. The selected display image is displayed.

[Top Memory]
Specify a memory address for data sampling.  “D200” is specified in this 
example.

[Timing for Storing Data in Buffering Area]
Specify the timing for storing data in the buffering area.  “1” (sec.) is 
specified for [Periodic] in this example.

[Number of Sample]
Specify the number of sampling times.  “100” is specified in this example.

Click the [Next] button.
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5. [Number of Graph]
Specify the number of lines in the trend graph.  “2” is specified in this 
example.

[Points of X Direction]
Specify the number of points on the X axis in the trend graph.  “10” is 
specified in this example.

[Graph Max.] and [Graph Min.]
Specify the maximum and minimum values in the trend graph.  “100” and 
“0” are specified respectively in this example.

[Word Count]
Select the number of words for data sampling memory specified in step 
4.  [1 Word] is selected in this example.

Click the [Next] button.

6. Select colors as desired.  Open each tab window and select a graph color.
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7. A cross cursor is displayed.  Click it in the desired position.
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Deleting Placed Parts

When deleting a part placed by the wizard function, follow the procedure below.

1. Select [Undo Wizard] from the [Edit] menu.

2. The following message appears.

This message always indicates the final part placed by the wizard function 
and its screen number.  Click the [OK] button.
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3. The specified part is deleted from the editing screen.  Deletion is completed.

Before delet ion

Error display part placed by the wizard funct ion
Messages are registered in the message 
editing area.

After deletion

All settings are deleted.

When a placed part is selected by clicking and then deleted by the command in 
the right-click menu or the deletion icon, the part is deleted from the screen; 
however, the settings in the message editing area and the buffering area remain.  
To avoid such an instance, go to the [Edit] menu and select [Undo Wizard] as 
explained above when deleting a part.
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Please use this page freely.
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Types of Fonts
Types of Fonts

The following fonts are available on the ZM series.

The ZM-71SE version 2.00 or greater is available with all the above fonts though 
there are some limitations on editing in each font type.  This chapter provides 
notes on font usage and description of editing in different fonts.

Font
Screen memory capacity when the font is in use (unit: KB)

Ref.
ZM-300 series ZM-52/72/82/52HD ZM-42/43/62E

Japanese 5,376 3,264 1,216 −

Japanese 32 4,992 2,816 768 −

English/Western Europe 5,648 3,456 1,408 Page APP1-3

Chinese 5,504 3,328 1,280 Page APP1-3
Chinese (simplified) 5,376 3,264 1,216 Page APP1-3

Korean 5,504 3,392 1,344 Page APP1-3
Gothic

As per setting Page APP1-4
English/Western Europe 
HK Gothic
English/Western Europe 
HK Times
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Font Setting

When performing font setting, select [Font Setting] from the [System Setting] 
menu.

By transferring screen data together with the selected font file to the ZM series, 
the font can be displayed on the ZM series.  Generally, only one type of font is 
available in one screen data file.
With the language selection function, however, it is possible to specify multiple 
fonts in one screen data file and to select one font.  For more information, see 
“Chapter 29 Language Selection” in the ZM-71SE Instruction Manual (Function).
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Available Fonts

English/Western Europe Fonts
The following languages are included in the English/Western Europe Fonts.

(Latin-1)

Chinese and Chinese (Simplified)
Screens in Chinese or simplified-type Chinese can be created.

Korean
Screens in Korean (using the Hangul alphabet) can be created.

• Icelandic • Irish
• Italian • English
• Dutch • Swedish
• Spanish • Danish
• German • Norwegian
• Portuguese • Finnish
• Faeroese • French
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HK Gothic and HK Times

Outline

The English/Western Europe HK Gothic and English/Western Europe HK Times 
fonts used for the ZM series are Sharp Corporation’ original fonts.

The English/Western Europe HK Gothic and HK Times feature: 

• The English/Western Europe font creates a smooth typeface when the 
specified enlargement factors are even numbers; however, only a normal 
typeface is available when the factors are odd numbers.  With the 
English/Western Europe HK Gothic or HK Times font, a smooth typeface is 
created in any size.

On the ZM series it is possible to use fonts similar to the Windows True Type fonts (Arial 
and Times).  The font similar to Arial is called English/Western Europe HK Gothic.  The 
font similar to Times is called English/Western Europe Times.

English/Western Europe HK Gothic English/Western Europe HK Times

English/Western Europe font

English/Western Europe HK Gothic font

Enlargement factors:  odd (1 × 1)

(3 × 3)

Enlargement factors:  even (2 × 2)

12 points

20 points

28 points

36 points
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• In the case of the English/Western Europe font, the minimum enlargement 
factors are X: 1 and Y: 1.  When smaller characters should be displayed, the 
1/4 size must be selected.  With the English/Western Europe HK Gothic or 
HK Times font, the number of points is used to specify a character size in 
place of enlargement factors.  The minimum permissible number of points is 
eight.  A smoother typeface can be realized as a result.

English/Western Europe font

English/Western Europe HK Gothic font

Minimum size (1/4)

(1 × 1)

8 points

9 points

11 points

12 points

Minimum size

It is not possible to use the English/Western Europe HK Gothic or HK Times font 
in combination with the English/Western Europe font.
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Points of English/Western Europe HK Gothic/HK Times
The following sizes are supported.

Display Function Specifications

Points Selection from Used or Not used

8 Available

9 Available

10 Available

11 Available

12 Set to be used

14 Available

16 Available

18 Available

20 Available

22 Available

24 Available

26 Available

28 Available

36 Available

48 Available

72 Available

Characters 
available for 
display

Lat in1 Icelandic, Irish, Italian, English, Dutch, Swedish, 
Spanish, Danish, German, Norwegian, 
Portuguese, Finnish, Faeroese, French

Character 
sizes

8 points 6 × 11 dots
12 points 8 × 16 dots

Displayed 
characters

Display resolution 320 × 240 640 × 480 800 × 600
8 points 53 characters 

× 21 lines
100 characters 
× 43 lines

100 characters 
× 54 lines

12 points 40 characters 
× 15 lines

80 characters 
× 30 lines

100 characters 
× 37 lines

← When [English/Western Europe HK 
Gothic] or [English/Western Europe HK 
Times] is selected for [Font],  the 
12-point size is automatically 
recognized as the font to be used and 
the data is transferred to the ZM series.
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Setting Procedure
1. Font type setting (page APP1-8 in this chapter)

Select [English/Western Europe HK Gothic] or [English/Western Europe HK 
Times] for [Font].

2. Font setting for individual functions in use (page APP1-9 in this chapter)
Specify the number of points as a character size in property setting when 
setting a part, mode, or text in drawing.

3. Manual font setting (page APP1-11 in this chapter)
When automatic font setting is not valid for any function set in step 2, make a 
manual font setting.

4. Data transfer to the ZM series (page APP1-13 in this chapter)
Transfer the screen data using the HK font to the ZM series.
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Font Type Setting
In the [Font Setting] dialog selected from the [System Setting] menu, select 
[English/Western Europe HK Gothic] or [English/Western Europe HK Times] for 
[Font].

If you attempt to change a [Font] setting from [English/Western Europe] to 
[English/Western Europe HK Gothic] or [English/Western Europe HK Times], the 
following alarm message appears.

When [Yes] is clicked, the English/Western Europe font is converted into the HK 
Gothic or HK Times (whichever is selected) that is in the number of points 
closest to the X enlargement factor of the English/Western Europe font.  If no 
backup copy of the screen data is saved, click [No] and save a backup copy.

If you attempt to change a [Font] setting from [English Western Europe HK 
Gothic] or [English/Western Europe HK Times] to [English/Western Europe], an 
alarm message appears as well.  The table below shows the character sizes in 
relation to font conversion.

HK Fonts → [English/Western Europe]

Points X and Y enlargement factors

8 1 × 1

9 1 × 1

10 1 × 1

11 1 × 1

12 1 × 1

14 1 × 1

16 1 × 1

18 1 × 1

20 2 × 2

22 2 × 2

24 2 × 2

26 2 × 2

28 2 × 2

36 3 × 3

48 4 × 4

72 6 × 6

[English/Western Europe] → HK Fonts

Points X enlargement factor

1 12

2 24

3 36

4 48

5 72

6 72

7 72

8 72
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Font Setting for Individual Functions
With [English/Western Europe HK Gothic] or [English/Western Europe HK 
Times] selected for [Font], the character property setting made for a function 
(part or mode) is altered to the setting for the HK font.

Ex.: Text in drawing (created from [Draw] and [Text])

When either HK font is used, specify a character size in points in the dialog.  
Both X and Y sizes are enlarged/reduced equally according to the specified 
number of points.

For each function (part of mode), the number of character points, and whether 
automatic or manual font setting is to be made for placed texts, differ as the 
table on the following page indicates.

Note:
For automatic font setting and manual font setting mentioned in the table, refer 
to “Manual Font Setting.”
 

[1/4] and [Italic] options are inactive in the property setting.
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* Refer to the notes on the following page.

Funct ion Automatic font sett ing Manual font setting No. of points
Switch, lamp Texts on switch and lamp − Variable

Numerical data 
display

Numerical data display − Variable

Character display − Character display Variable

Message display − Message display Variable
Relay mode Message in display area *,

messages on switch and lamp
− Variable in display 

area, Limited to 12 
points on switch and 
lamp

Relay-sub Message in display area − Variable
Message mode Message in display area, 

messages on switch and lamp 
(Requirements: [Block] is 
selected for [Act ion select]  and 
[ Internal] for [Command].)

Message in display area, 
messages on switch and lamp 
(Requirements: [Block] or 
[Message] is selected for 
[Action select] and [External]  
for [Command].)

Variable in display 
area, Limited to 12 
points on switch and 
lamp

Data sampling Numerical data and character 
displays

− Limited to 12 points

Bit sampling Message in display area − Limited to 12 points

Relay sampling (as mentioned for “Relay 
mode”)

− (as ment ioned for 
“Relay mode”)

Alarm display Message in display area, 
numerical data display

− Limited to 12 points

Memory card mode File number and record 
number displays in display 
area

File name and record name 
displays in display area

Variable

Calendar display Calendar numerical data and 
text

− Variable

Time display Time display − Variable
Table data display Numerical data display and text 

in drawing *
Character and message 
displays

Variable

Text in drawing Displayed characters − Variable
Multi-text Displayed characters − Variable

Data sheet (None) (None) (None)
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Manual Font Setting
In the case of the HK fonts, character codes used on screens will be recognized 
automatically or manually, depending on the used functions (part or mode) (see 
the table on the previous page).

Automatic Font Setting

By means of automatic font setting, character codes used on the screen are 
recognized and only partial sections of the font data including the codes are 
transferred to the ZM series.

There is no special operation to be performed by the user.

Manual Font Setting

When text data, for instance, to be displayed on a character display or message 
display will vary, such text data is not determined on the software.  In such a 
case, select probable items of font data to be used and transfer them to the ZM 
series.  This operation is a manual font setting.

It is necessary to check the number of points specified for the placed text as well 
as the function (mode or part) in which the text is placed.  Whether or not to 
make manual font settings is determined as a result.  (See the table on page 
APP1-10 in this chapter.)

* In the case of the matrix type (ZM-72/82)
Spacing of characters is different between the matrix type and the analog type.  
The matrix type shows characters based on dots at regular intervals.  The 
space between characters varies with the specified number of points.

20-point-size characters in the relay mode

Touch switch: Analog switch Touch switch: Matrix switch

Since the 12-point size data is transferred to the ZM series first , manual font setting is not 
necessary.

For more information on the 12-point size data, see page APP1-14 in this chapter.
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When any function (mode or part) that needs manual font setting is used on the 
screen, proceed to set the [Font Setting] dialog.

1. Open the [Font Setting] dialog from the [System Setting] menu.  Open the 
[Manual Font Setting] tab window.

As seen from the window, every option is provided with a check box.

Check the boxes of the options used in the screen data.  All checked options 
are transferred as font data.

2. Click the [Capacity Calculation] button.  The amounts of memory used by the 
checked options and available memory are indicated.

[  Transfer Fonts]
This option is displayed for the ZM-42 to 82.  If your ZM-42 to 82 system program version 
is earlier than 1.520 and the ZM-42 to 82 data is transferred to a memory card with this 
box checked, the manual font setting data is also transferred as screen data.  When 
uploading the data from the memory card to the ZM-42 to 82, not all HK font data (HK 
Gothic and HK Times) is specified as the data to be uploaded even with [Font Data] 
selected on the ZM-42 to 82 screen.  To allow the manual font sett ing data to be 
uploaded, select [Screen Data].

Memory for manual font setting data is limited to 4 MB for the ZM-300 (or 6 MB if 
only manual font setting data is stored in a CF card) and to 2 MB for the 
ZM-42/43/52/62/72/82  even if available memory still remains.  Check the value 
specified for [Remaining Font].
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3. When the tab window setting is concluded, click [OK].

Data Transfer to the ZM Series

Transfer screen data including the HK font data to the ZM series.

In the [Transfer] dialog, select [Screen Data] and click the [PC ->] button.  The 
screen data and the font data are transferred to the ZM series.

If data transfer to the ZM series is executed while a minus value is specified for 
[Remaining Font] or [Remaining Screen], the editor software gives the following 
alarm message.

If the alarm occurs, a size that cannot be displayed normally on the ZM series 
may be specified in the font data.  Check [Remaining Font] or [Remaining 
Screen] and correct the data as necessary.

When a ZM-42/43/52/62/72/82 is used, transfer the ZM-42/43/52/62/72/82 
system program to the ZM-42/43/52/62/72/82 to update the program before 
transferring screen data.

This section changes.

2002-4 -1     09:23:30

SYSTEM PROG. VER. 1.040

FONT
VER.1.300/1.010/1.000
               HK Gothic

I/F DRV VER.1.210
     SHARP JW series

   Connection: 1 : 1
    Signal Level: RS232C
PLC Stat. No. : 0

   Baud Rate: 19200
Data Length: 7
        Stop Bit: 1
           Parity: Even
Send Delay:     0msec

Main Menu Z M - 3 7 1 T A

System Information

PLC Type: SHARP JW link module
Comment:

Screen Data
Information

Size:  5832704

       Error: Stop
Time-Out: 0.50  sec
      Retry: 3

When screen data is transferred, the 12-point font data is always transferred to 
the ZM series first.
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Notes on Font Data to be Transferred

If changes are made to the [Manual Font Setting] tab window during online 
editing, the correct font data according to the changes will not be transferred.  
Stop online editing and perform data transfer.

Error for the ZM series
• Item No.

22 : Expansion font

• Error No. (as per the following)

Error No. Contents Remedies

204

The font data specified by manual font setting in 
the screen data does not exist in the ZM series.  
Texts specified by automatic font setting are 
displayed normally.  However, in the case of font 
data that does not exist on the ZM series, texts 
are displayed in the 12-point size temporarily.

Transfer the screen 
data again.

Data transfer order

12-point font data

Screen data

Expansion font (automatic/manual font setting)

Transferred

Transferred

Transferred
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3D Parts

3D parts provided from Sharp Corporation will aid in more realistic display of 
parts on the screen.  This chapter explains the 3D parts setting procedure on the 
screen and the notes on usage.  The explanation slightly varies with the edit 
model (ZM-300 or ZM-42 to 82 series).  Check the model in use and the 
corresponding explanation.  For the functions of parts, see the ZM-71SE 
Instruction Manual (Function).

With ZM-300 Series

This section provides notes on 3D parts usage and the setting procedure for the 
ZM-300 series*1 .  Read the following thoroughly in advance.

*1 For the model ZM-352D, see page APP2-15 in this chapter.

Notes on Usage
Parts File

Sharp Corporation provides ten 3D parts files for the ZM-300 series.  Depending 
on the components selected at the time of installation, the installed parts files 
vary.

• Installed as standard (only [  Program Files] is checked)
- 3DStd.z3p: Switches, lamps (2 patterns), other parts
- 3Dfront.z3p: Switches, lamps (2 and 3 patterns), ZM-42 to 82 

compatible
- 3Dside.z3p: Switches, lamps (2 and 3 patterns), ZM-42 to 82 

compatible

• Installed as options ([  3D Parts] is checked)
- 3Dnow_p2.z3p: Switches, lamps (2 patterns), other parts
- 3Dnow_p3.z3p: Switches, lamps (3 patterns)
- 3Dnow_p4.z3p: Switches, lamps (4 patterns)
- 3Dnow_p5.z3p: Switches, lamps (5 patterns)
- 3Dnow_p6.z3p: Switches, lamps (6 patterns)
- 3Dnow_p7.z3p: Switches, lamps (7 patterns)
- 3Dnow_p8.z3p: Switches, lamps (8 patterns)

During software installation, the selected files are stored in the 
[~\ZM71SE\Parts] folder.

Do not move the [Parts] folder, [Parts3D] folder, and bitmap files in folders to 
different storage places.  Do not change their names.
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Memory Capacity

3D parts need more memory than memory for ordinary parts.  Check the current 
status of memory use by selecting [Memory Use] from the [Tool] menu.

Limitation on Parts Placement

A maximum of 1,023 patterns of 3D parts can be used in one screen data file.

• Pattern count

- When one part or multiple parts of the same type in the same size are 
placed:
Switch/lamp .................................... Count the notch number of one part.
Parts other than switch and lamp ... Count one pattern.

- When parts of the same type in different sizes are placed:
Switch/lamp .................................... Count the notch number of each part.
Parts other than switch/lamp .......... Count one pattern for each part.

Ex: The switch and lamp parts on the following screen use 58 patterns.
2 (-notch) × 26 (pieces) + 3 (-notch) × 2 (pieces) = 58

If a message “The size is too large to communicate.” is given during data 
transfer, memory expansion by installing an optional memory cassette 
ZM-300EM is recommended.

Each bottom right value indicates the notch number of the part.

3-notch parts They are the same-type parts in different sizes.  
They are counted individually.

2 2 2

222

2 2 2

2

2

2 2 2 2

2 2 2 2

2222

2

2

3

3

Only one part  
is the target to 
count because 
they are of the 
same type in 
the same size.
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Setting Procedure
Switch and Lamp

This section explains the 3D switch parts setting procedure.  Also follow the 
same procedure when placing lamps.

1. Click the [Switch] icon.

2. The [Switch] dialog is displayed.  Click the [Parts Select] button.

The procedure varies for ZM-42/43/52/62/82-compatible 3D parts 
(3Dfront.z3p/3Dside.z3p).  Refer to page APP2-10 in this chapter.
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3. The [Switch List] window is displayed.  When the desired 3D parts file is 
already displayed, go to step 5.  Click the [Parts File] button.

4. The [Select Parts File] dialog is displayed.  Select a parts file [3DStd.z3p] or 
[3Dnow_p .z3p] according to the number of the switch patterns.

Ex: When the file [3Dnow_p4.z3p] is selected, a 4-pattern switch can be 
selected.
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5. 3D parts are displayed in the [Switch List] window.

[JUMP] [<] [>]
These buttons scroll up/down the parts list.

[Parts File]
Click this button when selecting another parts file.

[Select]
Click this button to select a switch part.

[Display Pattern]
This option is used to check the displays of the OFF, ON, and P3 to P8 
patterns.

[Color Select]
This option is used to select a color from eight.

Select the desired part and color, and click [Select].
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6. The selected part is previewed in the [Switch] dialog.

[OFF/ON/P3/P4/P5/P6/P7/P8] [OFF/ON/P3/P4/P5/P6/P7/P8 Color]
Clicking each tab shows the preview of the corresponding pattern.  Color 
change  (8 colors) is possible while the preview is displayed.
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[Image]
A part selected from the parts list has different ON, OFF, and P3 to P8 
patterns (as per “Image setting”: “No” below).  When making the ON and 
OFF patterns the same or interchanging the ON and OFF patterns (as 
per “Image setting”: “Yes” below), use this button.

1) When changing a pattern, show the preview of the desired part and click 
the [Image] button.  The [Image Setting] dialog is displayed.

2) Select a pattern.  A setting example is provided below.  Colors are 
changeable.

The above step completes a part selection.

Image sett ing No Yes

OFF

ON

Image sett ing No Yes

OFF

ON

P3

For other sett ings such as memory, see the ZM-71SE Instruction Manual (Function).
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Flash Function
When 3D parts in the file [3DStd.z3p] or [3Dnow_p .z3p] are used, the OFF 
pattern and a pattern of ON and P3 to P8 can be displayed alternately like they 
are flashing.  The following explains the lamp flashing setting procedure.  Also 
follow the same procedure in the case of switches.

Setting Procedure

1. Open the [Lamp] dialog.  Open the [Customize] tab window.  The [OFF] 
pattern is previewed.

Note:
For [  Custom Bitmap], see page APP2-23 in this chapter.
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2. Select the tab of a pattern for flashing.  The pattern is previewed.

Ex: [ON] pattern selected for flashing display

3. Check [  Flash].

Ex: When lamp memory M0 is specified for the above setting:

M0

ON

OFF

Display
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Switch/Lamp (ZM-42 to 82 Compatible)

This section explains the procedure for setting ZM-42 to 82-compatible 3D 
switch parts.  Also follow the same procedure when placing lamps.

1. Click the [Switch] icon.

2. The [Switch] dialog is displayed.  Click the [Parts Select] button.

A f lashing time interval corresponds to the [Blink/Flash] tab window settings in the [Unit 
Setting] dialog selected from the [System Sett ing] menu.
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3. The [Switch List] window is displayed.  When the desired 3D parts file is 
already displayed, go to step 5.  Click the [Parts File] button.

4. The [Select Parts File] dialog is displayed.  Select a parts file [3Dfront.z3p] or 
[3Dside.z3p].
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5. 3D parts are displayed in the [Switch List] window.

[JUMP] [<] [>]
These buttons scroll up/down the parts list.

[Parts File]
Click this button when selecting another parts file.

[Select]
Click this button to select a switch part.

[Display Pattern]
This setting is active only when a switch or lamp part is selected.  The 
displays of the OFF, ON, and P3 to P8 patterns can be shown.

Select the desired switch part and click [Select].  The selected part is 
previewed in the [Switch] dialog.

The above step completes a part selection.

For other settings such as memory, see the ZM-71SE Instruction Manual (Function).
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Numerical Data Display, Character Display, Message Display, Bar 
Graph, Pie Graph, Panel Meter, Statistic Graph, Closed Area Graph, 
and Calendar Parts

This section explains the procedure for setting 3D numerical data display parts.  
Also follow the same procedure when placing the other parts.

1. Click the [Num. Data Display] icon.

2. The [Num. Display] dialog is displayed.  Click the [Parts Select] button.

3. The [Num. Display List] window is displayed.  When the desired 3D parts file 
is already displayed, go to step 5.

Click the [Parts File] button.
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4. The [Select parts file.] dialog is displayed.  Select a parts file [3DStd.z3p] or 
[3Dnow_p2.z3p].

5. 3D parts are displayed in the [Num. Display List] window.

[JUMP] [<] [>]
These buttons scroll up/down the parts list.

[Parts File]
Click this button when selecting another parts file.

[Select]
Click this button to select a switch part.

Make sure to select either [3DStd.z3p] or [3Dnow_p2.z3p] parts file.  Any files 
other than these two show only 3D switch/lamp parts.
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[Color Select]
This option is used to select a color from eight.

Select the desired part and color.  Click the [Select] button.

6. The selected part is previewed in the [Num. Display] dialog.  The [Color 
Select] option is valid to change the color.

The above step completes a part selection.

With the Model ZM-352D

This section provides notes on 3D parts usage and the setting procedure for the 
ZM-352D.  Read the following thoroughly in advance.

Notes on Usage
Parts File

Sharp Corporation provides two 3D parts files for the ZM-352D.  During 
installation of the ZM-71SE software, the files are stored in the [Parts] folder 
included in the [Zm71S] folder.

• 3Dfront_128.z3p: (Switches, lamps)
• 3Dside_128.z3p: (Switches, lamps)

For other sett ings such as memory, see the ZM-71SE Instruction Manual (Function).

Do not move the [Parts] folder and bitmap files in the folder to different storage 
places.  Do not change their names.
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Memory Capacity

3D parts need more memory than memory for ordinary parts.  Check the current 
status of memory use by selecting [Memory Use] from the [Tool] menu.

Color Pallet

Use the color pallet for 3D parts instead of the ordinary color pallet when setting 
the colors of 3D parts.  Open the [Environment Setting] tab window in the [Unit 
Setting] dialog selected from the [System Setting] menu.  Check [Use 3D Parts].  
The message below appears.

Click [Yes] to start reading of the 3D parts pallet file.  Then the colors used in the 
already created screen data are changed to 3D parts colors while the basic 15 
colors remain the same.

If a message “The size is too large to communicate.” is given during data 
transfer, memory expansion by installing an optional memory cassette 
ZM-300EM is recommended.

Both ordinary color pallet and 3D parts color pallet cannot be used in one file.  
The pallet to be used is selected by checking/unchecking [  Use 3D Parts].  
See this option setting to check which pallet is selected.

Silver-color

The silver-color on the 3D color 
pallet is slight ly brighter than 
that on the ordinary color pallet.

3D parts color palletOrdinary color pallet

The basic 15 colors are 
used on both pallets.
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Limitation on Parts Placement

A maximum of 1,023 patterns of 3D parts can be used in one screen data file.

• Pattern Count

- When one part or multiple parts of the same type in the same size are 
placed:
Count the notch number of one part.

- When parts of the same type in different sizes are placed:
Count the notch number of each part.

Ex: The switch and lamp parts on the following screen use 58 patterns.
2 (-notch) × 26 (pieces) + 3 (-notch) × 2 (pieces) = 58

Each bottom right value indicates the notch number of the part.

3-notch parts They are the same-type parts in different sizes.  
They are counted individually.

2 2 2

222

2 2 2

2

2

2 2 2 2

2 2 2 2

2222

2

2

3

3

Only one part  
is the target to 
count because 
they are of the 
same type in 
the same size.
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Setting Procedure
This section explains the 3D switch parts setting procedure.  Also follow the 
same procedure when placing lamps.

1. Click the [Switch] icon.

2. The [Switch] dialog is displayed.  Click the [Parts Select] button.

3. The [Switch List] window is displayed.  When the desired 3D parts file is 
already displayed, go to step 5.  Click the [Parts File] button.
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4. The [Select Parts File] dialog is displayed.  Select a 3D parts file 
[3Dfront_128.z3p] or [3Dside_128.z3p].

5. 3D parts are displayed in the [Switch List] window.

6. The following message appears.  Click [Yes].  The 3D parts color pallet 
becomes available (page APP2-15 in this chapter).

[JUMP] [<] [>]
These buttons scroll up/down the parts list.

[Parts File]
Click this button when selecting another parts file.

[Select]
Click this button to select a switch part.
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[Display Pattern]
This setting is active only when a switch or lamp part is selected.  The 
displays of the OFF, ON, and P3 to P8 patterns can be shown.

Select the desired switch part and click [Select].

7. The selected part is previewed in the [Switch] dialog.

The above step completes a part selection.

For other settings such as memory, see the ZM-71SE Instruction Manual (Function).
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With ZM-42 to 82 Series

The notes on 3D parts usage and the setting procedure for the ZM-42 to 82 
series are almost the same as for the ZM-352D.  This section, therefore, 
provides the notes associated with the ZM-42 to 82 series only.  Read the 
section for ZM-352D as well.

Notes on Usage
Applicable ZM-42 to 82 Series

Using 3D parts may result in exhaustion of memory.  In terms of available 
memory, the following versions are recommended.  (For the hardware version of 
the ZM-42 to 82 series, see “LOT NO:” on the sticker put on the back of the 
ZM-42 to 82 series.)

If using 3D parts with the ZM series in any version other than recommended, it is 
recommended that Sharp Corporation’ optional memory cassette ZM-4EM or 
ZM-43EM (not available with ZM-42D/42L and ZM-62E) be installed for memory 
expansion.  With either memory cassette (ZM-4∗EM) installed, open the 
[Memory Expansion] tab window in the [Unit Setting] dialog from the [System 
Setting] menu and select [4M (Memory Extension 1)].

Memory Capacity

3D parts need more memory than memory for ordinary parts.  Check the current 
status of memory use by selecting [Memory Use] from the [Tool] menu.

Analog type
Model Version

ZM-82T∗ F or later
ZM-82DC E or later

ZM-72TS∗ F or later
ZM-72T∗ G or later

ZM-72D F or later
ZM-52D D or later

ZM-52HD All versions

Matrix type
Model Version

ZM-82TCM Other than D
ZM-72TCM (All versions)

ZM-72DM Other than D

Recommended hardware versions

If the used ZM-42 to 82 is not in recommended versions (ZM-52/72/82), open 
the [Memory Expansion] tab window in the [Unit Setting] dialog selected from 
the [System Setting] menu and uncheck [  Memory Capacity +2M].  Without 
this setting, the memory use list ([Memory use] from the [Tool] menu) will not 
indicate correct values.

If a message “The size is too large to communicate” is given during data transfer 
even though there is available memory, check the hardware version of the ZM 
series.
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Parts File

Sharp Corporation provides the following two 3D parts files for the ZM-42 to 82 
series.  During installation of the ZM-71SE software, the files are stored in the 
[Parts] folder included in the [ZM71SE] folder.

• 3Dfront.z7p: Switches, lamps (2 and 3 patterns)
• 3Dside.z7p: Switches, lamps (2 and 3 patterns)

Do not move the [Parts] folder and bitmap files in the folder to different storage 
places.  Do not change their names.
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Customizing

When a part being edited for creating a ZM-300 screen has the [Customize] tab 
in the part setting dialog, a user-created bitmap is available for the part.

Types of Parts
The parts below are provided with the [Customize] tabs in their respective 
dialogs.

• Switch
• Lamp
• Numerical data display
• Character display
• Message display
• Bar graph
• Pie graph
• Panel meter
• Statistic graph
• Closed area graph
• Calendar

Setting Procedure
A lamp is used as an example for the following customizing procedure.  Also 
follow the same procedure in the case of the other parts.

1. Open the [Lamp] dialog.  Open the [Customize] tab window.

2. Click [  Custom Bitmap].

Checking [  Custom Bitmap] deletes the 3D parts setting.
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3. Select a bitmap file from [Bitmap Selection].

If the [Bitmap Selection] column does not include the desired bitmap file, 
click the [Refer] button and select the desired one.  The bitmap file is copied 
to the [~\ZM71SE\Parts\User] folder and displayed under [Bitmap Selection].

4. The selected bitmap and its file name are displayed.  The file is opened.  In 
the case of a lamp part, as many tabs as the notch number of the part are 
provided; therefore, a bitmap can be selected individually.  Perform step 3 in 
each tab window.

Use this button to delete 
unnecessary bitmap f iles 
from the 
[~\ZM71SE\Parts\User] 
folder.  Deleting a file 
currently being used causes 
error No. 91 on the ZM 
series.

Parts stored in the 
[~\ZM71SE\Parts\User] 
folder are listed.

For information on [  Flash], refer to “Flash Function” (page APP2-8 in this chapter).
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Notes on Usage
• If the [~\ZM71SE\Parts\User] folder in the computer you are going to operate 

for screen editing does not store a bitmap used in the screen data, the 
bitmap file is automatically created at the time of opening the screen data 
and is registered in the folder.  If another bitmap file having the same name 
already exits, the above-mentioned automatic file creation is not executed.  
Use the [Refer] button in the [Customize] tab window and execute reading of 
the bitmap file again.  A bitmap file registered by automatic creation is not 
completely identical to the original file.

• Switches and lamps are drawn in the REP mode.

• Transparent color
The ZM series recognizes areas on a screen colored black (code 0000) as 
transparent.  When there is an area that should not be depicted on the 
screen, color it black.  To depict black areas instead of transparent areas, 
draw them using a color code similar to black.
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All items making up screens, such as switches, lamps, numerical data, and 
overlaps, are called “parts” and are saved in “part files.”  The “part file” is an 
independent file and is separate from screen data files.  Any part can be copied 
from part files to screen data files at any time.  The same part can be placed in 
different screen data files.

Users can create and save their own parts together with the standard parts 
originally saved in part files.  With this feature, the user can easily create a 
screen by using parts of their own design, such as switches and graphs.

Menu

1234
OFF

Screen data 
files 0

Screen data 
files 1

Part  file “AAA”
File containing parts only

Any part can be 
called up form 
part  files.

Any part can be called 
up form part files.

1234
OFF

7 8 9

4 5 6

1 2 3

0 . CL CR

+/-

UP

DW

Users can save their own unique parts.

Part file “AAA”
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Components of Parts

Parts saved in a part file may be different in shape but have common 
components.  A part is basically composed of three different elements: a “basic 
part area,” “part area,” and “graphic data.”  The “basic part area” is the area 
which possesses the part’s function.  The “part area” is the area covering the 
whole part, which is equivalent to the part’s size.

1234

• Switch part

Part area

• Num. data display part

Part  area

Graphic data

Basic part area
(switch area) Graphic data

Basic part area
(Area for 
numericals only)

• Bar graph part • Closed area graph part

Graphic 
data

Basic part  area

Graphic data

Part  area Basic part area

• Display area part

Graphic 
data

Basic part area

Part 
area
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Modifying Parts (In Screen Data Files)

This section describes the procedure for modifying parts.  It is possible to slightly 
modify parts in screen editing, keeping the original parts stored in the part file 
unchanged.

Parts Modifying Procedure

Click a part placed on the screen.  Handles are shown around it.  Click the 
[Change the Setting of a Part Placed] icon in the tool bar.

The [Modify Part] window is displayed.  Modify the part.  Adjust the frame to fit 
the modified part if necessary.  The part modifying procedure is almost the same 
as the part editing procedure.  For more information, see “ [Modify Part] window” 
(page APP3-8) in “Editing Procedures for Each Part” described in this chapter.

After the part has been modified, close the [Modify Part] window.  The former 
screen edit window is displayed.  The modified part is shown on the screen.

How to save a part in a part file after modifying it in screen editing:
• Copy the desired part.
• Open a part file,  and bring up the edit  window of the copied part .
• Paste the copied part to the target window for registrat ion.
• Click [Save] or [Save As] to save the part.
Registration has been completed.
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Creation and Storage of Part Files

Creating Part Files

Creating a New File Opening an Existing File
1. Select [Parts Edit] from the [File] menu, and 

click [New].
1. Select [Parts Edit] from the [File] menu, and 

click [Open].
2. The [Edit Model] dialog is displayed.  Choose 

the correct model and click [OK].
2. The [Select parts file.] dialog is displayed.

3. The [Select PLC Type] dialog is displayed.  
Choose the PLC model to be used for the 
screen data file for the part file you are going 
to create.  Click [OK].

When opening a ZM-300 part file, specify 
“*.z3P” for [Files of type]; when opening a 
ZM-42 to 82 part file, specify “*.z7P.”  Select 
the desired part file, and click [Open].
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4. The [Part Edit] dialog is displayed.  Choose the part to be edited and click 
[OK].

5. The [Part [0] Edit] window for the selected part is displayed.

6. When an existing file is opened, click the [Screen List] icon.  Double-click the 
target box for registration.  The corresponding [Part Edit] window is 
displayed.

7. To change a part for modification in the [Part Edit] window, click the desired 
part icon.  The [Part Edit] dialog is displayed.

Specify the desired number and click [OK].  The corresponding [Part Edit] 
window is displayed.

Click this button.
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8. Create a part.  (See “ Editing Procedures for Each Part” (page APP3-7).)

Saving and Closing Part Files

1. For a new part file, select [Save] or [Save As] from the [File] menu.  Give the 
file a name.

2. When overwriting an existing file, select [Save] from the [File] menu.

3. Select [Quit Part Edit] from the [File] menu.  This step completes part editing.  
By selecting [Quit Application] in the [File] menu, the ZM-71SE editor is 
terminated.

• Outline
[Part Edit] window

[New Part] icon
[Change the Setting of a Part Placed] icon

[Modify Part] window
Modify a part.  Icons, edit menu options, or right-clicking menu 
options for the selected part are displayed.

[Part Edit] window

The base color of  the [Part Edit] window can be changed so that the image of the part  can 
be obtained when it is placed on the screen.  Select [Display Environment] from the 
[Display] menu.  The [Display Environment] dialog is displayed.  Open the [Menu Dsp.]  
tab window.  Choose the desired color for [Background].  (See page APP3-39.)
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Editing Procedures for Each Part

Editing Overlap Parts

In overlap parts, the “basic part areas” equal the “part areas” in size.

Editing Procedure
Procedure to edit and register a new part is explained below:

[Overlap Part Edit] window

1. Check that the edit window indicating the selected registration number is 
opened.

2. Click the [New Part] icon.  A dotted box and a mover tool appear.

3. Click the mover tool in the desired position.  A new overlap part is placed in 
the window.

4. Double-click the overlap part.  The [Overlap (Normal)] dialog is displayed.  
Set the dialog as desired.

5. Select the overlap part.  Click the [Change the Setting of a Part Placed] icon.

[New Part] icon

Basic part  area

The dialog for each part cannot be set after the [Modify Part] window is opened.  
Set the dialog before opening or after closing the window.
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[Modify Part] window

6. The [Modify Part] window for the overlap part is opened.  Edit the part or 
change its size.

7. After editing the part, close the [Modify Part] window.

[Overlap Part Edit] window

8. The former [Overlap Part Edit] window is displayed.  The modified overlap 
appears in the window.

[Change the Setting of a Part  Placed] icon

• Frame adjustment cannot be used for overlap parts because they have no frames.
• No graphic outside the basic part area is active.  Draw graphics within the area.
• A basic part  area color can be specif ied in the [Overlap] dialog.
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Editing Switch/Lamp Parts

Editing procedures for switches and lamps are almost the same.  Unlike other 
parts, different displays for ON and OFF (/P3/P4/P5/P6/P7/P8) should be 
created.

Notches
A maximum of seven types of the switch or lamp part are available, such as two 
different displays for ON and OFF, three different displays (ON, OFF and 
another), etc.  The relation between patterns and notches is shown below.

For a 2-notch switch or lamp part, two different displays for ON and for OFF 
should be created.  For a 3-notch part, three different displays are required.  
Likewise, register as many graphics as required for the notches (2, 3, 4, 5, 6, 7 
or 8) of the switch or lamp part.

Editing Procedure (Ex.: 2-notch switch part)
Procedure to edit and register a new part is explained below:

[Switch Part Edit] window

1. Check that the edit window indicating the selected registration number is 
opened.

Notches Patterns

2-notch OFF + ON = 2 patterns

3-notch OFF + ON + another type = 3 patterns

4-notch OFF + ON + other 2 types = 4 patterns

5-notch OFF + ON + other 3 types = 5 patterns

6-notch OFF + ON + other 4 types = 6 patterns

7-notch OFF + ON + other 5 types = 7 patterns

8-notch OFF + ON + other 6 types = 8 patterns

Determine the number of notches when placing a new part.  Note that once the 
number of notches has been chosen, it cannot be changed later.

2-notch

3-notch

OFFOFF O NO N

STOP RUNREADY
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2. Click the [New Part] icon.  [2-notch] to [8-notch] can be chosen.

3. Click [2-notch].  A dotted box and a mover tool appear.

4. Click the mover tool in the desired position.  A new switch part is placed in 
the window.

5. Double-click the placed part.  The [Switch] dialog is displayed.  Set the dialog 
as desired.

6. Create the OFF display of the switch.  Check that the [OFF] icon is 
depressed.  If not, click the icon.

Click the desired position.

The dialog for each part cannot be set after the [Modify Part] window is opened.  
Set the dialog before opening or after closing the window.
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7. Select the switch part.  Click the [Change the Setting of a Part Placed] icon.

[Modify Part] window

8. The [Modify Part] window for the switch part is opened.  Edit the part or 
change its size.

“Switch Area” Setting
A switch part  contains a “switch area.” Pressing here activates the switch.  This area can 
be moved in switch part editing.  Select [Switch Area Setting] f rom the [Edit] menu.  (Or, 
right-click the mouse and select [Switch Area Sett ing] from the pop-up menu.)

The switch area can be moved to the desired position by dragging the mover tool.

Mover tool

The switch area is 
moved to the posit ion.

Drag the mover tool while 
fitting it to the switch part.
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Part Frame Setting
In a switch part,  the graphic size may differ from the switch area.  If an irregular graphic is drawn for a 
switch part , the switch area may not fit the graphic.  The part frame can be adjusted to f it  the whole 
part in this situat ion.

The part f rame can be set either automatically or manually.
When f it ting a frame to a part automatically, select [Frame Auto Fitt ing] from the [Edit] menu.  (Or,  
click the [Frame Auto Fit]  icon, or choose [Frame Auto Fitt ing] from the right-clicking menu.)

A frame can be set manually as desired.  Select [Frame Manual Fit ting] from the [Edit ] menu.  The 
mover tool appears as shown below:  Drag the mover tool to the desired position.  The frame is 
placed in the position.

Frame or Area Property for the Graphic
When creating ON and OFF displays for a switch/lamp part,  their colors can be changed directly f rom 
the [Switch/Lamp] dialog by designat ing the ON/OFF graphics as frame property ([Frame]) or area 
property ([Area]).  Refer to the following table.

The frame automatically 
fits the part.

Mover tool

Part Graphic Property In [Switch/Lamp] Dialog

When creating 
OFF display

[Frame] [OFF Frame Color]

[Area] [OFF Color]

 When creating 
ON display

[Frame] [ON Frame Color]

[Area] [ON Color]

* The above function is also used for lamp parts.
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9. After editing the OFF display, copy the display for creating the ON display.

10. Close the [Modify Part] window.  The former [Switch Part Edit] window is 
displayed.  The OFF display as created appears in the window.

[Switch Part Edit] window

11. Create the ON display of the switch.  Click the [ON] icon in the tool bar.

12. Click the switch part, and click the [Change the Setting of a Part Placed] 
icon.

[Modify Part] window

13. The [Modify Part] window for the switch part is opened.  Edit the part for the 
ON display.  Paste the copied OFF display to the window.  After editing, reset 
the part frame by choosing [Frame Auto Fitting].

14. Close the [Modify Part] window.  The ON display as created appears in the 
window.

For a 3- to 8-notch part, the same drawing or editing procedure applies.

Switch Grids
As default , [  Place Switches on Switch Grids] is checked.  Switches are placed and 
enlarged/reduced, or switch areas are moved along switch grids.  With the matrix type 
ZM-42 to 82, switch areas can be moved only along switch grids.  Keep [  Place 
Switches on Switch Grids] checked.  With analog switches, switches can be moved dot 
by dot, regardless of switch grids.  To do this,  select [Display Environment] from the 
[Display] menu, open the [Grid] tab window, and uncheck [  Place Switches on Switch 
Grids].

Preparation for Creating the ON Display of a Switch Part
When creating a switch part, the ON display is placed on top of the OFF display.  When 
the ON or OFF state of a switch is distinguished only by color change, the ON and OFF 
displays of the switch must be in the same position.  To create the ON display after the 
OFF display has been created, copy the OFF display in the [Modify Part] window, then 
paste the copied display to the [Modify Part] window for the ON display and finish it as the 
ON display.

Whether or not the created switches or lamps appear as desired in the ON, OFF, 
and P3 to P8 displays depends on the [Draw Mode] selection between [XOR] 
and [REP].
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Editing Data Display Parts

There are three different types of data display parts: “numerical data display,” 
“character display,” and “message display.” However, the editing procedure is 
the same for all of them.

Editing Procedure (Ex.: Numerical data display part)
Procedure to edit and register a new part is explained below:

[Num. Display Part Edit] window

1. Check that the edit window indicating the selected registration number is 
opened.

2. Click the [New Part] icon.  A dotted box and a mover tool appear.

3. Click the mover tool in the desired position.  A new numerical data display 
part is placed.

4. Double-click the part.  The [Num. Display] dialog is displayed.  Set the dialog 
as desired.

5. Select the numerical data display part by clicking.  Click the [Change the 
Setting of a Part Placed] icon.

[Modify Part] window

6. The [Modify Part] window for the numerical data display part is displayed.  
Edit the part or change its size.

1234
The top left corner of the part moves to 
the clicked posit ion.

The dialog for each part cannot be set after the [Modify Part] window is opened.  
Set the dialog before opening or after closing the window.

1234

For a numerical data display part  with a painted box, it is recommended that the box color 
be specif ied for [Background] in the [Char. Prop.]  tab window of the [Num. Display] dialog 
and that [Transparent] be unchecked.  With [Transparent] checked, a flickering will occur 
on the LCD Control Terminal screen when the data on the display part is changed, and 
the data display speed will be slow.

1234

1234

Background color
Foreground color
Painted box
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7. After editing the part, click the [Frame Auto Fit] icon.  The frame 
automatically fits the part.

8. Close the [Modify Part] window.

[Num. Display Part Edit] window

9. The former edit window is displayed.  The modified numerical data display 
part appears in the window.

Editing a Keypad

The keypad for inputting numerals or characters consists of numerous individual 
switch parts, but is registered in the part file as a single part.  Therefore, to 
create and register a keypad part, each individual part should be created, 
following the procedure explained in “Editing Switch/Lamp Parts” and should be 
grouped into one part.

1234 1234

.
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5
8 97

4 6
1 3
0 CL CR

UP

DW

+/-
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E
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W

F
L
R

X
DW SP DL CL CR

A keypad part consists 
of a group of switch 
parts.  ([Function] of 
each switch part is 
selected from [Entry].)

When creating a switch for a keypad, there is no option for choosing the number 
of notches.  (The parts for the keypad must be “2-notch.”)  However, a function 
must be chosen from the switch function pull-down menu.
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Editing Procedure
Procedure to edit and register a new part is explained below:

1. Check that the edit window indicating the selected registration number is 
opened.

2. Click the [New Part] icon.  The function pull-down menu is displayed.

3. Choose [Text/Num.], for example.  A dotted box and a mover tool appear.
Click the mover tool in the desired position.  A new switch part is placed in 
the window.

4. Create the ON and OFF displays of the switch as explained in “Editing 
Switch/Lamp Parts” (steps 6 to 14 on page APP3-10).

5. After editing the switch, close the [Modify Part] window.  The former edit 
window is displayed.

6. Create additional switches for a keypad.  Follow steps 3 to 5.

0
Enter the numeral “0” for the switch in 
the [Character]  tab window of the 
[Switch] dialog.

1 1

00
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Editing Graph Parts

There are seven different types of graph parts, “bar graph,” “pie graph,” “panel 
meter,” “statistics graph (bar),” “statistics graph (pie),” “trend graph,” and “closed 
area graph.”  To create these graph parts, follow their individual procedures.

Bar Graph Editing Procedure
Procedure to edit and register a new part is explained below:

[Bar Graph Part Edit] window

1. The edit window indicating the selected registration number is opened.

2. Click the [New Part] icon.  The bar graph type pull-down menu is displayed.

3. Choose [Horizontal Bar RGT], for example.  A dotted box and a mover tool 
appear.

4. Click the mover tool in the desired position.  A new graph part is placed.

Characters on a Keypad
When [Text/Num.] is selected from the switch function pull-down menu, enter 
characters/numerals for the switches in the [Character]  tab window of the [Switch] dialog.  
When a switch is pressed, the character or numeral of the switch is recognized.  
Characters/numerals registered in the graphic library can also be used for switches in 
screen editing.  See “Chapter 7 Entry Mode” in the ZM-71SE Instruction Manual 
(Function).  In this case, however,  the character or numeral is not recognized when a 
switch is pressed.

Multiple Copies
When creating a keypad consisting of the same-shape switches, create one switch and 
copy it using the multi-copy function.  Then set their functions and characters/numerals in 
the [Switch] dialog.

Several switch parts for a keypad are registered as a keypad part.  When placing 
a keypad part in screen editing, the switch parts are grouped.  To relocate the 
switch parts, ungroup a keypad part into single parts.
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5. Double-click the part.  The [Bar Graph] dialog is displayed.  Set the dialog as 
desired.

6. Select the bar graph part.  Click the [Change the Setting of a Part Placed] 
icon.

[Modify Part] window

7. The [Modify Part] window for the bar graph part is displayed.  Edit the part or 
change its size.

8. After editing the part, click the [Frame Auto Fit] icon.  The frame 
automatically fits the part.

9. Close the [Modify Part] window.

[Bar Graph Part Edit] window

10. The [Modify Part] window for the bar graph part is displayed.  Edit the part or 
change its size.

The dialog for each part cannot be set after the [Modify Part] window is opened.  
Set the dialog before opening or after closing the window.

Click the [Frame Auto Fit] icon.
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Pie Graph Editing Procedure
Pie Graph Types
The following types of pie graph parts are available.

Procedure to edit and register a new part is explained below:

[Pie Graph Part Edit] window

1. Check that the edit window indicating the selected registration number is 
opened.

2. Click the [New Part] icon.  The pie graph type pull-down menu is displayed.

3. Choose [Without Internal Circle, Symmetry], for example.  A dotted box and 
a mover tool appear.

4. Click the mover tool in the desired position.  A new pie graph part is placed.

5. Double-click the part.  The [Pie Graph] dialog is displayed.  Set the dialog as 
desired.

Without internal circle, 
Symmetry

Without internal circle, 
Complete Round

Without internal circle,  
Asymmetry

With internal circle, 
Symmetry

With internal circle, 
Complete Round

With internal circle, 
Asymmetry

The dialog for each part cannot be set after the [Modify Part] window is opened.  
Set the dialog before opening or after closing the window.
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6. Select the pie graph part.  Click the [Change the Setting of a Part Placed] 
icon.

[Modify Part] window

7. The [Modify Part] window for the pie graph part is displayed.  Edit the part or 
change its size.

8. After editing the part, click the [Frame Auto Fit] icon.  The frame 
automatically fits the part.

9. Close the [Modify Part] window.

[Pie Graph Part Edit] window

10. The former edit window is displayed.  The modified pie graph part appears in 
the window.

The pie graph has a size limit.
• The radius of a pie graph without internal circle must be 16 dots or more.
• The inside radius of a pie graph with internal circle must be 10 dots or more, 

and the difference between the inside and outside radii must be 16 dots or 
more.

Icons for  Editing Pie Graph Parts
In the window for editing pie graph parts, unique icons appear in the tool bar.

A. [Move Start/End Angles Separately] 
There are “start angles” and “end angles” for all pie graphs except circles.  These 
angles can be changed freely when the graph is edited.  Click icon A and click the part 
area of the pie graph.  Handles are shown around the part .

Drag either handle on “start  angle” or “end angle” to the desired size.

A. [Move Start/End Angles Separately]
B. [Symmetry]

C. [With Internal Circle]
D [Same Start/End Angles]

Click the part.  
Handles are 
shown.Click this icon.

Drag the start angle to 
change it.

Drag the end angle to 
change it.
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B. [Symmetry]
Unlike icon A, this icon changes “start angle” and “end angle” simultaneously and 
symmetrically.   Click icon B, and click the part area of the pie graph.  Handles are 
shown around the part.  Drag either handle to change both angles simultaneously and 
symmetrically.

C. [Same Start/End Angles]
Click icon C and click the part  area of the pie graph part .  Handles are shown around 
the part.

Drag either handle on “start angle” or “end angle”.   They are put together.  The sector 
becomes a complete circle.   (The “start angle” moves to the “end angle.”)

D. [With Internal Circle]
The circle at the center of the pie graph is called the “internal circle.”  The graph looks 
like a donut.   This circle can be created or deleted as you like.  Click icon D once.  The 
icon is depressed, and an internal circle (hole) is created in the pie graph part.

Click the depressed icon D.  I t pops up.  The internal circle (hole) is deleted.

Drag either handle to change 
the start  and end angles 
simultaneously and 
symmetrically.Click this icon.

Click the part.  Handles 
are shown.

Click this icon.

The start and end angles 
can be moved as you like.

This is the start angle 
and also the end angle.

Click this icon.  I t is 
depressed. An internal circle is shown.

Click the depressed icon, 
and it pops up. The internal circle is deleted.
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Panel Meter Editing Procedure
Basically, the panel meter composition is similar to the pie graph.  The pie graph 
indicates the value with execution color, but the panel meter uses an indicator.  
Both “start angle” and “end angle” can be changed in the same manner as in pie 
graphs.

Basic area for the 
panel meter partIndicator

Start  angle End angle

The panel meter always has an internal circle.  The [With Internal Circle] icon is, 
therefore, inactive when the panel meter is edited.  The panel meter has a size 
limit.  The inner radius must be 10 dots or more.  The difference between the 
inner and outer radii must be 16 dots or more.

The procedure for editing and registering panel meter parts is the same as used for pie 
graph.  See the example for edit ing pie graphs explained previously (page APP3-19).
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Statistic Graph (Bar) Editing Procedure
Procedure to edit and register a new part is explained below:

[Stat. Bar Graph Part Edit] window

1. The edit window indicating the selected registration number is opened.

2. Click the [New Part] icon.  The statistic graph (bar) type pull-down menu is 
displayed.

3. Choose [Horizontal Bar Graph], for example.  A dotted box and a mover tool 
appear.

4. Click the mover tool in the desired position.  A new graph part is placed.

5. Double-click the part.  The [Stat. Bar Graph] dialog is displayed.  Set the 
dialog as desired.

6. Select the statistic graph part.  Click the [Change the Setting of a Part 
Placed] icon.

[Modify Part] window

7. The [Modify Part] window for the statistic graph (bar) part is displayed.  Edit 
the part or change its size.

8. After editing the part, click the [Frame Auto Fit] icon.  The frame 
automatically fits the part.

9. Close the [Modify Part] window.

[Stat. Bar Graph Part Edit] window

10. The former edit window is displayed.  The modified statistic graph (bar) part 
appears in the window.

The dialog for each part cannot be set after the [Modify Part] window is opened.  
Set the dialog before opening or after closing the window.
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Statistic Graph (Pie) Editing Procedure
There is only one type of statistic graph (pie), [With Internal Circle, Complete 
Round].  Unlike pie graphs, there are no options such as the sector or other 
types for statistic graph (pie).

Trend Graph (Trend Sampling) Editing Procedure
The part registered in this section is used for trend graphs and also for display 
area parts for trend sampling mode.

[Trend Graph Part Edit] window

1. Check that the edit window indicating the selected registration number is 
opened.

2. Click the [New Part] icon.  A dotted box and a mover tool appear.

3. Click the mover tool in the desired position.  A new graph part is placed.

4. Double-click the part.  The [Trend Graph] dialog is displayed.  Set the dialog 
as desired.

5. Select the trend graph part.  Click the [Change the Setting of a Part Placed] 
icon.

Statistic graph (pie) part

Always equipped with internal circle

The procedure for editing statistic graph (pie) parts is the same as used for stat ist ic graph 
(bar) parts.  See the previous section, “Statistic Graph (Bar) Editing Procedure” (page 
APP3-23).

The statistic graph (pie) has a size limit.  The inner radius must be 10 dots or 
more.  The difference between the inner and outer radii must be 16 dots or 
more.

The dialog for each part cannot be set after the [Modify Part] window is opened.  
Set the dialog before opening or after closing the window.
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[Modify Part] window

6. The [Modify Part] window for the trend graph part is displayed.  Edit the part 
or change its size.

7. After editing the part, click the [Frame Auto Fit] icon.  The frame 
automatically fits the part.

8. Close the [Modify Part] window.

[Trend Graph Part Edit] window

9. The former edit window is displayed.  The modified trend bar graph part 
appears in the window.

Attach scales to 
the outside of the 
graph part.

The frame automatically fits 
the graph with scales in size.
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Closed Area Graph Editing Procedure
Procedure to edit and register a new part is explained below:

[Closed Area Graph Part Edit] window

1. The edit window indicating the selected registration number is opened.

2. Click the [New Part] icon.  A dotted box and a mover tool appear.

3. Click the mover tool in the desired position.  A new graph part is placed.

4. Double-click the part.  The [Closed Area Graph] dialog is displayed.  Set the 
dialog as desired.

Select the closed area graph part by clicking.  Click the [Change the Setting 
of a Part Placed] icon.

[New Part] icon

The dialog for each part cannot be set after the [Modify Part] window is opened.  
Set the dialog before opening or after closing the window.
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[Modify Part] window

5. The [Modify Part] window for the closed area graph part is displayed.  Edit 
the part or change its size.

• Editing Procedure

1) Draw a closed area graphic using [Line], [Box], or [Circle] in the 
[Draw] menu.  The max. size of a closed area graphic is W  ×  H = 
65,536 bytes.  (ZM-42/43: 32,768 bytes)

2) Set the graph area (basic part area) with a dotted box.  The graph 
area is recognized as a graph.  Move the graph area (dotted box) to 
the closed area graphic.  Adjust to the desired size by dragging a 
handle.  If you want to use the graphic as a graph area, right-click the 
mouse and choose [Fit Area with Graphic] from the pop-up menu.

3) Right-click the mouse, and select [Paint Position Setting].

Useful tools:
[Point Search] [Enlarge items including circles in the opposite angle] [ Item List]

Graph area (basic part area)

Fit Area with Graphic
The graph area snaps into the drawn graphic.

Graph area
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6. After editing the part, click the [Frame Auto Fit] icon.  The frame 
automatically fits the part.  (See the figures shown below.)

7. Close the [Modify Part] window.

[Closed Area Graph Part Edit] window

8. The former edit window is displayed.  The modified closed area graph part 
appears in the window.

[Paint Position Setting]
Determine the start position for paint ing a closed area graph.

Select [Paint Position Setting] from the right-clicking menu.  Move the cursor to the graph 
area and click it.   Drag the cursor and release the mouse in the target position.  (The 
paint start position “×” is moved along the horizontal line 1 dot above the graph lower 
limit.)

If painting is not performed correctly after the paint start position has been determined, 
raise the lower limit of the graph area by 1 dot and set the position again.  When 
confirming the paint start position, open the [Detail] tab window in the [Display 
Environment] dialog (from the [Display] menu) and uncheck [  Paint Dsp.].   Click [OK].   
The paint start position is indicated with “×.”

If a closed area graphic does not have a vertex in the vert ical direction from the paint start 
posit ion, the graphic cannot be painted correctly.  (See the figures shown below.)

Graph area

Graph upper limit

Graph lower limit
Point start  posit ion

Direction

There is not a vertex in this position.

This area 
cannot be 
painted.

Direct ion

Direction

Paint start position

Ex:
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Editing Display Area Parts for Data Sampling

Display area parts for data sampling are required for “data sampling” in the 
“sampling mode.”  A display area part for data sampling consists of a “basic part 
area,” “graphic data,” and “data display.”

This “data display” differs from “data display part.”  It exists only in a display area 
part for data sampling.  Data displays are located on the top line of the basic part 
area.  (The position can be changed horizontally.)

A maximum of 16 data displays can be placed in a part.  Whether or not to 
display data is determined in the [Sampling Display Area] dialog.

1234 1234 1234 1234 1234 1234 1234 1234

Data display

Basic part  area

Graphic data

Part  area

1234 1234 1234 1234 1234
It  can be moved horizontally.

To display data, 
check the box.
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Editing Procedure
The procedure to create a new display area part including four items of data for 
data sampling is explained below:

[Data Sampling Disp. Area Part Edit] window

1. The edit window indicating the selected registration number is opened.

2. Click the [New Part] icon.  A dotted box and a mover tool appear.

3. Click the mover tool in the desired position.  A new data sampling display 
area part is placed.

4. Double-click the part.  The [Sampling Display Area] dialog is displayed.  Set 
the dialog as desired.

5. Select the display area part.  Click the [Change the Setting of a Part Placed] 
icon.

[Modify Part] window

6. The [Modify Part] window for the data sampling display area part is 
displayed.  Edit the part or change its size.

1234 1234 1234 1234

The dialog for each part cannot be set after the [Modify Part] window is opened.  
Set the dialog before opening or after closing the window.

Changing the Position of Data
Data shown in the part (data sampling display area part) can only be moved horizontally.
1. Click the data sampling display area part .  Handles are shown around the part.
2. Click the desired data to select it.  Handles are shown around the data.
3. Drag the selected data to the desired position.

1234 1234 1234 1234 1234 1234 1234 1234
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7. After editing the part, click the [Frame Auto Fit] icon.  The frame 
automatically fits the part.

8. Close the [Modify Part] window.

[Data Sampling Disp. Area Part Edit] window

9. The former edit window is displayed.  The modified display area part appears 
in the window.

Editing Calendar Parts

A calendar part can consist of all calendar items (year, month, day, hour, minute, 
second, and day of the week).  It is also possible to create individual parts in 
order to use them separately.

Composition of Calendar Parts
The calendar part consists of several calendar items.  Each calendar item can 
be enlarged or moved separately within the part area.

Determine whether or not to display calendar items of year, month, day, hour, 
minute, second, and day of the week in the [Calendar] dialog.  When [  Display] 
is unchecked in the tab window of a calendar item, the item is not displayed.

02 - 06 - 15  17 - 20 - 15  Sunday

6 / 20 Sunday

17 : 20

This is one calendar part.

These are separate calendar parts.

YY      DD hh       ss

MM

mm
SUN

Any calendar item can be moved within 
the part area of the calendar part.

Calendar items can be moved only within the area of the calendar part.
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Editing Procedure
The procedure to edit and register a new calendar part consisting of “year,” 
“month,” and “day” is explained below:

[Calendar Part Edit] window

1. Click the [Screen List] icon.  In the screen list window, double-click the 
desired box for registration.

2. The [Calendar Part Edit] window indicating the selected registration number 
is opened.

3. Click the [New Part] icon.  A dotted box and a mover tool appear.

4. Click the mover tool in the desired position.  A new calendar part is placed.

5. Double-click the calendar part.   The [Calendar] dialog is displayed.  To 
delete unnecessary items from the part, open the [Hour], [Minute], [Second], 
and [Week] tab windows one by one and uncheck [  Display] in each 
window.  Clicking [OK] deletes [hh], [mm], [ss], and [SUN] from the calendar 
part.

6. Enlarge the calendar part if necessary.  Click the part and drag its handle 
until the part is enlarged as desired.

7. Select the calendar part.  Click the [Change the Setting of a Part Placed] 
icon.

YYMMDDhhmmssSUN

YYMMDD

The dialog for each part cannot be set after the [Modify Part] window is opened.  
Set the dialog before opening or after closing the window.
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[Modify Part] window

8. The [Modify Part] window for the calendar part is displayed.  Edit the part or 
change its size.

9. After editing the part, click the [Frame Auto Fit] icon.  The frame 
automatically fits the part.

10. Close the [Modify Part] window.

[Calendar Part Edit] window

11. The former edit window is displayed.  The modified calendar part appears in 
the window.

Editing Display Area Parts

The display area part is used in relay mode or in message mode to display 
messages, or in graphic mode to display graphics.

Editing Procedure

However, the frame setting is used for display area parts.  Unlike overlap parts, 
the “basic part area” and the “part area” of the display area part are independent.  
This makes it necessary to reset the frame in editing.

YY / MM / DD YY / MM / DD

Created text

The frame automatically 
fits the calendar part 
including the text.

The procedure for editing display area parts is almost the same as used for overlap parts.   
See the procedure explained on page APP3-7.

Basic part  area

Graphic data

Part area
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Printing the Part (Part File)

An explanation of how to print out the contents of the part file is provided below.

Printing Procedure

[Option Setting] Dialog
1. While a part edit window is opened, select [Printer Setting] from the [File] 

menu.

2. The [Option Setting] dialog is displayed.
[  Screen Output]

Part graphics are printed.

[  List Output]
Items set for parts are printed.

[  Table Print]
The table of parts is printed.  When this option is checked, the [Screen 
Output] and [List Output] options are not active

[  Reverse]
The parts are printed in reverse video.  Only the white and black portions 
are reversed.

[  Monochrome]
If the printed part is difficult to see, check this box.  Legibility may be 
improved.

[Page Setting]
Set the margins, and header and footer lines.

[Printer Setting]
Set the printer mode, paper size, and portrait or landscape mode.

After setting, click [OK].
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1. After specifying the above settings, execute printing.  Select [Print] from the 

[File] menu.

2. The [Part Print] dialog is displayed.  Check the necessary options for 
printing.  Specify the starting part number and ending part number for [Start] 
and [End] respectively.

3. Click [Print] at the bottom left of the dialog.  Printing starts.
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Part File Management

Parts from different part files can be copied into other files.  Close the current 
file.  Copying is performed by bringing up the copy source file and copy target 
file windows.

Part File Managing Procedure

1. Select [File Managing] from the [File] menu, and click [Parts File].

2. The [File Manage (Part)] dialog is displayed.  Specify the desired files for 
[Copy Source] and [Copy Target], and click [OK].

3. The item selection pull-down menu is displayed.  Choose [Switch], for 
example.  Click [OK].

4. The copy source and target file windows are displayed.  The source file 
window is placed above the target file window.

5. Drag the desired part from the copy source file window to the target file 
window.  Copying is executed.  Multiple parts are selected simultaneously by 
clicking the first part, and then while holding down the SHIFT key, clicking the 
last part.

Clicking [File Managing] brings up the menu.  The [File Copy], [File Delete], [File Divide], 
and [File Combine] commands are not active for part file management.
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6. If you want to copy different parts, select [Change Display] from the [Display] 
menu.  The item selection dialog is displayed.  Choose the desired part and 
click [OK].

7. In addition to copying by dragging as explained above, copying by 
designating part numbers is also possible.  Select [Copy by Specifying No.] 
from the [Edit] window.  The item selection dialog is displayed.  Choose the 
desired part and click [OK].  The [No. Designation] dialog is displayed.  
Specify the desired numbers for [Copy Source No.] and [Copy Target No.].

8. To save the copied parts, select [Copy Target Save] or [Copy Target Save 
As] from the [File] menu.

9. To quit, select [Quit File Managing] from the [File] menu.
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Part Editing Menu

Use the following commands to create new parts or to edit existing parts.

In a Part Edit Window

[File] Menu
• [New]

Choosing this command creates a new part file.

• [Open]
Choosing this command brings up an existing part file name list.

• [Save]
Choosing this command saves the most recent version of the opened part 
file and deletes its previous contents.

• [Save As]
Choosing this command saves the opened part file with a new file name, 
different from the original.

• [Printer Setting]
Choosing this command allows you to specify the settings for printing a part 
file.  For more information, see page APP3-34.

• [Print]
Choosing this command prints out the part files.  For more information, see 
page APP3-34.

• [CF Card Manager]
The CF card manager starts.  For more information, see the ZM-71SE 
Instruction Manual (Function).

• [File Managing]
Choosing this command allows you to copy parts between part files.  For 
more information, see page APP3-36.

• [Quit Part Edit]
Choosing this command closes the part edit window.

• [Quit Application]
Choosing this command quits the editor.

 [Edit] Menu
The [Edit] menu commands are almost the same as those for screen data files 
except for the [Place New Part] command.

• [Place New Part]
A new part is placed in the opened part edit window.  The [New Part] icon 
functions in the same manner.
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[Display] Menu
The [Display] menu commands are the same as those for screen data files, 
except for the [Display Environment] command.

• [Display Environment]
Open the [Menu Dsp.] tab window in the [Display Environment] dialog.  The 
[Background] option can be used to change the base color of a part edit 
window.

[Edit Part] Menu
• [Overlap]

Choosing this command allows you to edit overlap parts.

• [Switch]
Choosing this command allows you to edit switch parts.

• [Lamp]
Choosing this command allows you to edit lamp parts.

• [Num. Display]
Choosing this command allows you to edit numerical data display parts.

• [Char. Display]
Choosing this command allows you to edit character display parts.

• [Message Disp.]
Choosing this command allows you to edit message display parts.

• [Key Pad]
Choosing this command allows you to edit keypad parts.

• [Bar Graph]
Choosing this command allows you to edit bar graph parts.

• [Pie Graph]
Choosing this command allows you to edit pie graph parts.

• [Panel Meter]
Choosing this command allows you to edit panel meter parts.

• [Stat. Graph]
Choosing this command allows you to edit statistic graph (bar) parts.
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• [Stat. Pie Graph]
Choosing this command allows you to edit statistic graph (pie) parts.

• [Trend Graph]
Choosing this command allows you to edit trend graph parts.

• [Data Sampling Disp. Area]
Choosing this command allows you to edit display area parts for data 
sampling.

• [Calendar]
Choosing this command allows you to edit calendar parts.

• [Display Area]
Choosing this command allows you to edit display area parts.

• [Closed Area Graph]
Choosing this command allows you to edit closed area graph parts.

[Item] Menu
• [PLC Type]

Specify the PLC model for the screen data file when using a part file in the 
screen data file.

• [Edit Model Selection]
Specify the model of LCD Control Terminal for the screen data file when 
using a part file in the screen data file.

• [Use Gothic Font]
Select this option when creating a part using the Gothic font.
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[Tool] Menu
• [Open File for Reference]

This command is used when choosing [Pattern] or [Graphic Call] from the 
[Draw] menu in part editing.  Part files do not contain graphics or patterns.  
However, graphics or patterns exist in screen data files using part files.  
Therefore, it is possible to use graphics or patterns for creating parts.  
Graphics or patterns in a screen data file can be referred to and used in the 
part edit window using the [Open File for Reference] command.  Click [Open 
File for Reference], and choose the desired screen data file.  Graphics in the 
selected screen data file can be called up when [Graphic Call] or [Pattern] is 
selected from the [Draw] menu in part editing.

[Window] Menu
The [Window] menu commands are the same as those for screen data files.
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In a [Modify Part] Window

[File] Menu
• [Quit Part Modifying]

Clicking this command closes the [Modify Part] window and brings up the 
former part edit window.

[Edit] Menu
The [Edit] menu commands are the same as those for screen data files, except 
for the following commands.

• [Frame Auto Fitting]
When a graphic is too large to fit in the part area, click this icon to enlarge the 
frame so that it fits the whole part including the graphic.  The [Frame Auto Fit] 
icon functions in the same manner.  (This command is inactive for overlap 
parts because graphics cannot extend beyond the part areas.)

• [Frame Manual Fitting]
The frame of a part can be adjusted manually using the mouse.  For more 
information, see page APP3-12.

• [Switch Area Setting]
This command is used to reset the switch area (operating area).  For more 
information, see page APP3-11.

• [Move Start/End Angles Separately]
This command is used to adjust pie graph or panel meter part angles.  The 
[Move start/end angles separately.] icon functions in the same manner.  For 
more information, see page APP3-20.

• [Symmetry Pie Graph]
This command is used to symmetrically adjust pie graph or panel meter part 
angles. The [Symmetry] icon functions in the same manner.  For more 
information, see page APP3-21.

• [Same Start/End Angles]
This command is used to modify pie graph or panel meter part shape forming 
a complete circle.  The [Same Start/End Angles] icon functions in the same 
manner.  For more information, see page APP3-21.

• [With Internal Circle]
This command is used to add or delete an inner circle to or from a pie graph.  
[With Internal Circle] icon functions in the same manner.  For more 
information, see page APP3-21.

• [Paint Position Setting] [Fit Area with Graphic]
This command is valid only for the closed area graph part.  For more 
information, see page APP3-28.
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[Display] Menu
The [Display] menu commands are the same as those for part edit windows.

• [Item List]
When modifying a part including complicated graphics, the contents of the 
part are known from the [Item List] window.  The part and graphic data are 
indicated separately in the list.  This list is useful for changing only graphic 
properties, etc.

[Draw] Menu
The [Draw] menu commands are the same as those for screen data files.

[Window] Menu
The [Window] menu commands are the same as those for screen data files.

Open the [Item List]  window 
to edit  this switch parts. The items of the switch 

part  are listed.

Click the item whose property is to be changed, and click the [Detail/Prop. 
Change] icon.  The property can be changed with ease.
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